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About this manual 
 
 

This user manual describes the EEG analysis software BrainVision Analyzer. 

The user manual is part of the software product. It is essential to follow the instructions in the 
manual in order to use the software correctly and as intended. You should therefore read this 
user manual in its entirety. 

 

The user manual is aimed at medical research staff. 

 

The user manual contains specific information that you need in order to install and work with 
BrainVision Analyzer. The functions and settings of the software are described in detail. 

 

The Note symbol   draws your attention to additional information relating to a topic. 

 

Please notify us of any errors or faults you come across when reading the user manual or using 
the software. In such cases, please contact: 

Brain Products GmbH 
Zeppelinstraße 7 
D-82205 Gilching (Munich) 
Phone: +49 8105 73384 – 0 
Fax: +49 8105 73384 – 33 
Website: http://www.brainproducts.com 
Email: Analyzer2@brainproducts.com 
 

 

 

Target group 

Contents of the user 

manual 

Note symbol 

Notification of 

errors 
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1 Intended Use 
 
 

BrainVision Analyzer is intended for use with human beings. 

It is used to analyze ExG signals (including raw EEG data, spontaneous EEG analyses and 
evoked potentials) and sensor data on a PC. The ExG signals and sensor data are recorded 
using separate programs (BrainVision Recorder, for example) and stored in the user’s file 
system. The ExG signals are obtained and recorded exclusively through the recording program 
used, not through BrainVision Analyzer. 

The ExG signals and sensor data are analyzed exclusively for research purposes. The software 
must not be used for therapy, diagnosis, the monitoring of bodily functions or any other 
diagnostic or therapeutic purposes. 

The program may only be used by doctors or trained staff. 
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2 About the software 
 
 

2.1 Product identification 
 
 

Product name: BrainVision Analyzer 
  
Manufacturer: Brain Products GmbH 
 Zeppelinstraße 7 
 D-82205 Gilching (Munich) 
 Phone: +49 8105 73384 - 0  
 Fax: +49 8105 73384 - 33 
 Website: http://www.brainproducts.com 
 Email: Analyzer2@brainproducts.com 
  
Classification according to 
Directive 93/42 EEC (MDD), 
Annex IX, Rule 12: 

 
 
Class I 

  
DIN EN 62304 classification: Class A – “No injury or damage to health is 

possible” 

  
UMDNS code: 16-307, Analysis Software for EEGs and 

Evoked Potentials 

  
GMDN code: 35 163 

 

 

2.2 CE marking 
 
 

 

The CE marking confirms that the product conforms to the essential requirements of the 
Medical Devices Directive 93/42/EEC (MDD), Annex I. 

 

 

2.3 Application environment 
 
 

The Analyzer is not an applied part and is not part of the patient environment. 
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3 Introduction 
 
 

The first version of BrainVision Analyzer was released in 1997 for the analysis of EEG data. 
Since then, numerous modules and calculation methods have been added to the system. 
Given the continuous advances in both hardware and software technology, after ten years the 
time came to base the system on a new technology in order to give BrainVision Analyzer the 
benefit of these advances. The result is BrainVision Analyzer 2.0, which offers new 
functionality in addition to all the features of the previous version. These include the following: 

• The Analyzer is able to read and process the EEG data of numerous EEG 
amplifiers from well-known manufacturers. 

• History trees log every single operation applied to the EEG data. Templates can be 
created based on these operations, allowing further trees to be created 
automatically. The parameters of operations can be modified subsequently, and 
subsequent operations are adjusted automatically. 

• As a result of the implementation of OLE Automation and Microsoft .NET 
interfaces, the Analyzer can be controlled by other programs. 

• The various different parts of the Analyzer have a modular structure. These 
include reader, transformation, montage, export, display and add-in components. 
By adding new components it is possible to dynamically expand the Analyzer’s 
functionality. Brain Products works to develop new components on an ongoing 
basis. All interfaces are open, which gives expert users the opportunity to 
develop their own components. Alternatively, users can have such components 
developed for them. The integrated Basic interpreter and the fact that transforms 
and add-ins can be written in any .NET language make it possible to program 
these applications quickly and with great flexibility. 

• A new view concept based on the XML description language also offers flexibility, 
allowing user interfaces to be customized. These user interfaces can also used in 
users’ own modules. 

• A direct interface to MATLAB® ensures efficient, problem-free data interchange 
between the Analyzer and MATLAB®/EEGLab. MATLAB® scripts can be used in 
history trees and added to templates. (A valid MATLAB® license is required on 
the computer for this function, which is not part of the Analyzer.) 

• The LORETA module is used for source localization. It offers a graphical display 
and allows virtual channels to be calculated based on what are known as 
“regions of interest” and further processed using the methods offered by the 
Analyzer. 
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4 Installation 
 
 

BrainVision Analyzer generally does not conflict in any way with programs that are already 
installed. However, Brain Products GmbH will only guarantee perfect interaction in cases where 
the compatibility of the relevant programs has been tested. This applies both to the 
BrainVision Analyzer software and the Microsoft Windows® XP/Vista operating systems, 
provided no changes have been made to the supplied configuration of the operating system 
(including official service packs and updates). 

The system has the following hardware and software requirements: 

• Windows® XP Service Pack 2 or Windows® Vista 

• Minimum configuration: Intel Pentium IV or higher, 512 MB of RAM, 8 GB hard 
disk, graphics card with 64 MB of RAM 

• A monitor with a screen size of at least 21 inches (53 cm) when measured 
diagonally from corner to corner 

• At least 256 MB of free RAM, possibly more, depending on the volume of data 
processed 

 

To install BrainVision Analyzer, proceed as follows: 

• Start Windows®. 

• Insert the CD-ROM provided into one of your CD-ROM drives. 

• If your computer is set up to autostart a CD-ROM, the menu that guides you 
through the installation will appear after a short time. Follow the instructions 
displayed. 

 

If your computer is not set up to autostart a CD-ROM, proceed as follows when using 
Windows® XP: 

• From the taskbar, choose Start > Run. 

• Click the Browse button. 

• In the Browse dialog box, select your CD-ROM drive and double-click the 
setup.exe file to open it. Follow the instructions displayed. 

 

If your computer is not set up to autostart a CD-ROM, proceed as follows when using 
Windows® Vista: 

• Click the Start button on the taskbar, and then choose All Programs > 
Accessories > Run. 

• In the Browse dialog box, select your CD-ROM drive and double-click the 
setup.exe file to open it. Follow the instructions displayed.  

System requirements 

Installation steps 

Windows® XP 

Windows® Vista 
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The wizard takes you through the installation: 

 

 

Figure 4—1 Installation wizard (a) 

 

The wizard requires you to select the destination folder for the program: 

 

 

Figure 4—1 Installation wizard (B) 

 

Before you start the Analyzer, insert the hardlock key provided into one of your computer’s USB 
ports.   

Installation wizard 
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If you have a network license, you will find the instructions in Appendix E, “Installing a network 
license (USB)”. 

Start the Analyzer by double-clicking the Analyzer icon . This appears on your desktop on 
completion of successful installation. 

Alternatively, you can start the Analyzer by choosing Start > Vision Analyzer from the taskbar 
(Windows® XP, Vista). 
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5 Getting started and working with the Analyzer 
 
 

5.1 The new user interface of the Analyzer 
 
 

There are numerous new tools that make it easier to work with Analyzer 2.0. 

The Analyzer 2.0 user interface has a new structure, incorporating a Ribbon. The functions on 
the toolbars and menus have been rearranged on the Ribbon. The Ribbon is subdivided into 
tabs. The tabs (figure 5—1) contain groups (figure 5—2), and a group contains a number of 
command buttons (figures 5—3 and 5—4). 

 

 

Figure 5—1 Tab 

 

 

Figure 5—2 Group 

 

 

Figure 5—3 Command buttons  

Ribbon 
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Figure 5—4 Command buttons 

 

You can hide or show the Ribbon by double-clicking a tab. 

 

 

Figure 5—5 Ribbon hidden 

 

 

The Analyzer title bar contains the name of the EEG data set displayed. 

 

 

Figure 5—6 Title bar  

Title bar 
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Docking allows you to arrange windows and bars dynamically and customize the user 
interface. You will find detailed information on the docking options available in section 7.2.2, 
“Docking”. 

 

Figure 5—7 Arranging docking elements dynamically 

 

 

The Analyzer button, which is located in the upper left corner of the application window, 
contains the application’s main menu. 

 

 Figure 5—8 Analyzer button 

 

 

Next to the Analyzer button there is a control that displays the Quick Access Toolbar. 

You add a control to this toolbar by right-clicking the control on the Ribbon and then choosing 
the Add to Quick Access Toolbar command from the context menu that appears. You delete 
controls you have added by right-clicking the control and then choosing the Remove from 
Quick Access Toolbar command from the context menu. 

If you prefer, you can display the Quick Access Toolbar below the Ribbon by choosing the 
Show Quick Access Toolbar Below the Ribbon command from the context menu.   

Docking 

Analyzer button 

Quick Access Toolbar 
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Figure 5—9 Displaying the Quick Access Toolbar, added controls 

 

 

Figure 5—10 Adding controls to the Quick Access Toolbar 

 

 

When you move the mouse pointer over a control, a small box appears, containing a brief 
description of the control. 

 

 

Figure 5—11 Tooltip 

 

 

The menu bar, which is located along the top of the application window, contains the tabs. 

 

Figure 5—12 Menu bar with tabs  

Tooltip 

Menu bar 
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The toolbar, which is located along the top of the application window just below the menu bar, 
allows you, for example, to increase or decrease the interval displayed or the number of 
channels displayed simultaneously. 

 

Figure 5—13 Part of the toolbar 

 

The toolbar contains the following buttons (see the table of keyboard shortcuts in Appendix D): 

•  Copy: Copies the current view to a clipboard. 

•  Overlay Data Set: Overlays different data sets. 

•  Increase Interval: Increases the interval displayed. 

•  Decrease Interval: Decreases the interval displayed. 

•  Set Displayed Interval: Sets the time scale; 

 

In the Range [s] text box, you specify the scaling range in ms. When you click 
Apply, your entry is applied to the data. 

You can use the slider to change the scaling, or you can click one of the buttons 

(e.g. ) to apply the scaling associated with that button. 

•  Reset Interval resets the interval displayed to the default value. 

•  Fit Segment: Displays a single segment. This button is only available for 
segments that are small enough. 

•  Decrease Channels: Decreases the number of channels displayed. 

•  Increase Channels: Increases the number of channels displayed.  

Toolbar 

Buttons on the 

toolbar 
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•  Next Group: Switches to the next channel group. This function is only 
available when the number of channels has been reduced. 

•  Previous Group: Switches to the previous channel group. This function is 
only available when the number of channels has been reduced. 

•  Scale Up: Increases the scaling (sensitivity). 

•  Scale Down: Decreases the scaling (sensitivity). 

•  De/Activate the Baseline Correction: Switches the baseline on and off. 

•  Set Scaling Range: Allows you to scale the voltage. 

 

In the Range [μV] text box, you specify the scaling range in volts. When you click 
Apply, your entry is applied to the data. 

If you select the Scale All radio button, your entry applies to all channels; if you 
select Scale EEG, it applies only to the EEG channels. If you select Scale EXG, it 
applies only to non-EEG channels. You distinguish between EEG channels and 
non-EEG channels by checking whether they have coordinates. 

You can use the slider to change the scaling, and you can click one of the buttons 

(e.g. ) to apply the scaling associated with that button. 

•  Reset Scaling Range: Resets the scaling to the original value. 

•  Marker Edit Mode: The marker button displays the interactive marker 
editor. 

•  Bookmark Menu: This button allows you to set a bookmark in the EEG and 
remove it again. 

•  Zoom To Selection enlarges the selected range. 

•  Zoom from Selection undoes the last zoom operation on a selected range.  
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•  The Windows button gives you the flexibility to display and arrange 
the various windows and other items in the application in a variety of ways. If 
there is a check mark next to an item’s name, this item will be displayed. 

 

Close All closes all the windows. 

Reset Panel Layout returns the windows to their original layout. 

All the built-in docking windows are listed after this. If you click one of these 
commands, you show or hide the corresponding window, depending on whether 
it is currently hidden or shown. 

The section at the bottom of the menu lists all the open nodes. The active node 
has a check mark against it. 

•  The Use Tabbed MDI button allows you to specify whether the data is to be 
displayed on tabs or in windows. If you opt for display in windows, you can use 
the following three buttons to arrange the windows: 

•  Cascade Windows cascades all the open windows one behind the other. 

•  Tile Horizontal arranges them horizontally one above the other. 

•  Tile Vertical arranges them vertically next to each other.  
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The status bar contains a number of sections that provide information about the montage, the 
interval displayed, the mouse position and the current workspace. 

 

 

Figure 5—14 Part of the status bar 

 

You can use the status bar’s context menu to choose which information is to be displayed. 

 

 

Figure 5—15 Selecting the status information 

 

You can display the following status information: 

•  The Montage section indicates the montage type that is 
currently set. You will find more information on montages in chapter 8, 
“Montages”. 

•  The Real-Time Of First Visible Point section indicates the real time 
of the beginning of the EEG interval displayed. 

•  The EEG-Time of First Visible Point section indicates the time 
position of the interval displayed in the EEG. 

•  The Segment section indicates the current segment number at the 
beginning of the EEG interval displayed. You will find more information on 
segments in chapter 6, “Segmentation”. 

•  The Channel section displays the name of the channel on which the 
mouse is positioned. 

•  The Voltage section indicates the voltage applied at this point. 

  

Status bar 
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•  The Position relative to Visible Area section indicates the time 
position on which the mouse is positioned, relative to the beginning of the EEG 
interval displayed or relative to a time zero marker, if one has been set. You will 
find detailed information on editing markers in section 12.7.2, “Edit Markers”. 

•  The Workspace section indicates the name of the active workspace. 

•  The Real Time section indicates the real time on which the mouse 
pointer is positioned. 

•  The Data Point section indicates the data point on which the mouse 
pointer is positioned. 

•  The EEG Time section indicates the time position on which the 
mouse pointer is positioned, relative to the whole EEG. 

 

 

The navigation bar along the bottom allows you to navigate in the EEG. 

 

 

Figure 5—16 Part of the navigation bar, with navigation buttons, marker bar and slider bar 

 

There are four buttons on the left-hand side of the navigation bar that allow you to move 
through the EEG on the time axis. 

The buttons  and  take you one second forward or back, unless a section is ≤ 1s, in 
which case they take you 100 ms forward or back. 

The buttons  and  allow you to go forward or back by the interval displayed minus 
one second. That is because the successive intervals displayed overlap by one second. 

The marker bar to the right of the buttons displays all the markers set in the EEG. Markers are 
time-related indicators such as stimuli, responses, comments, segment boundaries, DC 
corrections, etc. 

The slider bar is located below the marker bar. The width of the slider in the bar represents the 
currently displayed section of the EEG, and the slider bar represents the entire EEG. 

You can use the mouse to change the position of the slider. A different section of the EEG is 
then displayed based on the new position of the slider. 

If you click any point on the marker or slider bar, the corresponding section of the EEG is 
displayed.  

Navigation bar 
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If you right-click the marker bar, a context menu appears. By choosing the commands on this 
menu to set and remove the check marks, you can either hide the entire marker bar (by 
removing the check mark against Show Markers) or select which types of marker you want to 
be shown. 

 

 

Figure 5—17 Context menu for showing and hiding markers 

 
 

The various EEG views are displayed by default in the form of tabs arranged above the EEG. 

 

 

Figure 5—18 EEG views on tabs 

 

To close a view tab, click the cross on the right of the tab bar. You can use the arrows to switch 
between the different tabs. 

 

 

Figure 5—19 EEG views on tabs   

View tabs 
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The History Explorer displays your history files. It is located on the left-hand side of the 
application window. 

The History Explorer contains the primary and secondary history data and a list of all the open 
history nodes. 

 

 

Figure 5—20 History Explorer with primary and secondary data and the History Node List 

 

Each history file is assigned a book icon. 

If the book icon does not appear, this is either because the specified raw data folder is empty 
or because the Analyzer is not (yet) able to read the format of the EEGs stored in this location. 
If the latter is true, contact Brain Products GmbH and ask about the latest EEG readers. 

 

 

Figure 5—21 Open nodes in the History Explorer  

History Explorer 
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To open a history file, click the icon  to the left of the book icon. If you double-click the icon, 
the corresponding EEG is displayed. 

You close the history file by clicking the icon . This also closes all the data set windows 
associated with the file. 

If you want to transfer the transforms you have run to a history file, open this history file. 
Ensure that the file contains the same channel names as the source file. Our example (figure 
22 onward) concerns odd_phob_1 and odd_phob_2. Position the mouse pointer on the icon 
of the transform to be transferred, and then press the left mouse button. Hold down the mouse 
button to drag the icon to the Raw Data icon of the second history file, and then release the 
mouse button to drop it there. The Analyzer automatically creates the corresponding history 
tree. 

 

 

Figure 5—22 Dragging and dropping to generate a history tree (A) 

 

 

Figure 5—23 Dragging and dropping to generate a history tree (B) 

 

In addition to transferring history information to other history files, you can also save history 
information in history templates. You will find more information on this in chapter 10, 
“Automation using history templates”. 

The various data sets that make up a history file are known as history nodes. You can delete 
and/or rename these data sets.  
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If you right-click a book icon, the following context menu appears: 

 

 

Figure 5—24 Context menu of a history data set 

 

• Open /Close opens or closes the data set. 

• Expand All expands the entire history tree. 

• Reload Raw File… removes all the nodes and reloads the raw data set. 

• Compress History File compresses the history file. When you delete larger data 
sets (e.g. FFT), the history file may remain the same size. The Analyzer does not 
delete the data from the history file immediately for performance reasons. 

• Purge All Deleted Nodes permanently removes all deleted nodes of the entire 
data set (to restore deleted history nodes, choose Undelete a Child… from the 
context menu of the corresponding raw data set or node). 

• Append File… appends a raw EEG to the data set. When you acknowledge the 
warning that the transforms in the relevant history file are going to be lost, the 
Append Files dialog box appears. In this dialog box you select the raw data EEG 
to be appended. If you click OK, the first history file is modified and the second 
one is removed. The icon changes from a book into a stack of books. 

• List Appended File(s)… contains a list of the raw EEGs appended to the data set. 

• Subject Infos displays information about the subject (patient) that was obtained 
during recording.  

Context menus in the 

History Explorer 
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If you right-click Raw Data, the following context menu appears: 

 

 

Figure 5—25 Context menu of a raw data set 

 

• Open/Close opens or closes the corresponding window or tab. 

• Expand All From Here expands the data set from this point. 

• Collapse All From Here collapses the data set from this point. 

• Undelete a Child… restores the most recently deleted node. You can repeat this 
operation as often as you like. 

• To permanently remove (purge) all deleted nodes, choose Purge Deleted Nodes. 

• Reset View Settings deletes all node-specific view settings. 

• Properties… displays a window containing an overview of the data properties, 
such as the length of the data set and the sampling interval. 

• Markers… displays a window containing an overview of the markers in the data 
set together with their properties. 

• Comment adds a comment that can then be displayed using this function. 

• Recording Infos… displays the information captured in the data set during the 
recording of the EEG.  
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If you right-click a node, the following context menu appears: 

 

 

Figure 5—26 Context menu of a node 

 

• Open/Close opens or closes the node as a window or tab. 

• Expand All From Here expands the data set from this point. 

• Collapse All From Here collapses the data set from this point. 

• Comment adds a comment that can then be displayed using this function. 

• Rename allows you to rename a node. Alternatively, you can click the node to 
select it and then press the <F2> key on your keyboard or click the history node 
text a second time after a few seconds. You can then edit the text. This function is 
the same as the one in Windows® Explorer. 

• Delete deletes the node. Alternatively, you can press the <Delete> key on your PC 
keyboard. 

• Undelete a Child… restores the most recently deleted node. You can repeat this 
operation as often as you like. 

• To permanently remove (purge) all deleted nodes, choose Purge Deleted Nodes. 

• Reset View Settings deletes all node-specific view settings. 

• Operation Infos… displays the parameters with which the relevant transform 
was executed. 

• Properties… displays a window containing an overview of the data properties, 
such as the length of the data set and the sampling interval. 

• Markers… displays a window containing an overview of the markers in the data 
set together with their properties.  
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• Edit Parameters / Reprocess allows you to modify parameters of the associated 
transform. The original node is removed and replaced. 

• Edit Parameters / Copy allows you to modify parameters. The original node is 
retained. 

If you choose the Edit Parameters / Reprocess or Edit Parameters / Copy 
command, the parameters dialog box for the relevant node appears, containing 
the node’s existing parameters. 

On the parameters selected, it may not be possible to restore all child nodes. In 
such cases, what happens is similar to what happens in the case of a history 
template that cannot be executed any further for a similar reason. 

If the parent node uses a semiautomatic view for parameter editing, its child 
nodes are saved hidden and not restored until the transform is completed. This 
also happens when the semiautomatic view is interrupted with Suspend (a 
corresponding message appears). 

 

 

The History Node List contains all the open history nodes and allows the nodes to be sorted. 
The history nodes in the list are marked in the same color as the corresponding transform. Raw 
data is marked white. 

 

 

Figure 5—27 History Node List  

 

 

History Node List 
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The History Node List has the following selection and display functions: 

• If you double-click an item in the list, the corresponding node is activated. 

• The cross button  to the right of each item closes the corresponding node. 

• The button  minimizes the node or hides it temporarily. 

• The button  maximizes the node or displays it again. 

• <Shift> plus a mouse click allows you to select either a range of items or all of 
them. 

• <Ctrl> plus a mouse click allows you to select multiple items. 

• If you right-click one or more selected items, a context menu appears that allows 
you to close the selected nodes (Close Selected Nodes), hide them (Hide 
Selected Nodes) or display them (Show Selected Nodes). 

 

When a large number of nodes are open, the following functions allow you to arrange them and 
maintain the best possible overview: 

• The Group drop-down list box allows you to group the nodes in four different 
ways: 

None means that the nodes are not grouped. 

File groups them by file name. 

Status groups them based on whether the node is open (i.e. it has the status 
Displayed) or closed (it has the status Hidden). 

Type groups them by transform type. 

• The Sort drop-down list box allows you to sort the nodes based on three criteria: 

Natural sorts the nodes in the sequence in which they were opened. 

Depth sorts the nodes by node depth. For the grouping criterion “Type”, for 
example, FFT nodes of the same depth appear one after the other. 

Recursive sorts the nodes by path components (i.e. by the components 
separated by a forward slash). The file is ignored, and the paths are compared 
component by component from left to right until there is a difference or the end of 
the path is reached. In this case, the shorter of the paths is listed first. 
Consequently, the parent node is listed first within a file, followed by its child 
nodes.  
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The History Node List also offers a search and filter function: 

• The search function allows you to find a specific node quickly. To use it, you click 
Search. A text box appears, in which you can enter a search string. The filter is 
incremental (the function progressively finds a match for the filter as you enter 
each character). When you press the <Return> key, all the search results are 
displayed. 

• The filter function allows you to preselect nodes in order to limit the nodes 
displayed. Click Filter. A text box appears, in which you can enter the filter you 
want to apply. The filter is incremental (the function progressively finds a match 
for the filter as you enter each character). When you press the <Return> key, all the 
search results are displayed. The <Backspace> key broadens the selection again. 

You can, for example, filter out all nodes that contain segmentation, select them 
and then close them all. 

 

 

The View Toolbox window provides you with a number of different tools. You use them by 
dragging them onto the EEG using the mouse and dropping them there by releasing the mouse 
button. 

 

 

Figure 5—28 View Toolbox window 

 

You can make settings for each view tool by choosing Settings… from the context menu that 

appears when you click the drop-down button  on the tool’s right-hand border. 

The Close Tool command closes the tool.   

View Toolbox 
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The Channel Selection tool adds highlighting to a selected part of a channel. The tool is used 
purely for the purpose of highlighting. 

You change the width of the highlighting by moving the mouse pointer over it. Two blue arrows 
appear on its edges. Click one of these arrows, and drag it in the required direction. 

 

  

Figure 5—29 Channel Selection tool in the View Toolbox window 

 

The context menu contains the following commands: 

 

 
Figure 5—30 Area Settings dialog box 

 

• Lock Tool to Channel locks the tool onto the channel. 

• Selected Area Settings… opens the Area Settings dialog box, in which you can 
make the following settings: 

If you select the Mouse Sizing Allowed check box, you allow the tool to be 
resized using the mouse. 

If you select the Always Draw as Range radio button, a range is highlighted. 

If you select the Automatically switch to Single Point Mode radio button, a 
single point is highlighted. 

In the text boxes in the lower part of the dialog box, you can change the position 
(Location, End) and length (Length) of the highlighting. Note that the times you 
specify are rounded to the nearest data point.  

Channel Selection 

tool 
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The Delta Tool is for indicating differences in voltage and time values. 

When you drag the Delta Tool to a graph and release the mouse button there, the tool is fixed 
in that position. The tool remains tied to the mouse pointer. You can then set the position of 
the second point by moving the mouse pointer over the channels (not holding down the mouse 
button). The first point remains in its fixed position. You set the second fixed point with 
another click. 

Note that both of the tool’s points must always be on the same channel. 

 

 

Figure 5—31 Delta Tool in the View Toolbox window 

 

You can reposition the left- and right-hand points of the tool by moving the mouse pointer over 
them. When the point turns green, click it and drag the tool to the required position. 

Under Settings…, you can make the following settings: 

 

 

Figure 5—32 Text Box Settings dialog box (Delta Tool) 

 

You can change the appearance of the tool’s text box and edit the text displayed in the text 
box. You can specify any text and placeholders. 

• $x = difference in the x-axis direction 

• $y = difference in the y-axis direction 

• $ux = unit in the x-axis direction 

• $uy = unit in the y-axis direction  

Delta Tool 
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You can append single-digit numbers to the placeholders $x and $y that specify the decimal 
point to which the output is rounded (e.g. $y3). 

The Transparent check box makes the text box transparent. If you select the Auto Size check 
box, the size of the text box changes automatically to fit the length of the text. Otherwise, you 
can change its size as required. Font… opens a dialog box in which you can select the font to 
be used. In the Tool Text text box, you enter the text you want. 

 

 

The Magnifier magnifies an EEG channel. 

 

 

Figure 5—33 Magnifier in the View Toolbox window 

 

You resize the tool by clicking it, grabbing one of its 8 small handles (rectangles) and dragging 
it until the tool is the right size. 

The gray arrows in the lower left corner of the tool are for changing the vertical scaling. You can 
choose Settings… to display the settings of the view displayed in the Magnifier. 

 

 

The Map Legend tool is used together with the Mapping tool to display the color scale of the 
maps. 

This tool supports the same settings as the Mapping tool. As with the Mapping tool, the data 
range for automatic scaling extends across the entire EEG section displayed. 

 

 

Figure 5—34 Map Legend tool in the View Toolbox window  

Magnifier 

Map Legend 
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The Mapping tool allows you to display maps in any position. The tool always displays a range 
across all channels. 

To resize the tool, click it. A total of 8 small handles (rectangles) appear around it. You resize 
the tool by dragging these. 

You can choose Settings… to display the settings of the view displayed in the Magnifier. The 
view settings are the same as those of the map (see section 7.3.2, “Category-related view 
settings”), except that the number of maps is always “1”. 

If you use the Automatic Scaling function, the entire EEG section displayed underlies the 
scale. As a result, all map tools use the same scale with uniform scaling settings regardless of 
their positioning. 

 

 

Figure 5—35 Mapping tool in the View Toolbox window 

 

 

The Scaling Bar indicates the voltage values. The bar is always based on a specified point. 

You resize the tool by clicking it, grabbing one of its small handles (rectangles) and dragging it 
until the tool is the right size. 

 

 

Figure 5—36 Scaling Bar in the View Toolbox window  

Mapping tool 

Scaling Bar 
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You can choose Settings… to display the Bar Settings dialog box: 

 

 

Figure 5—37 Bar Settings dialog box 

 

Under Direction, you specify the orientation of the Scaling Bar (horizontal or vertical). 

Under Style, you choose between a simple bar (Simple Bar) or a bar that displays the values of 
the channel on which it is located (Scaling Bar). 

If you select the Lock Data Values check box, the Scaling Bar is scaled as well. If you clear the 
check box, the bar retains its original size during scaling. If you select the Automatic 
Granularity check box, the intervals between two divisions on the scale are set automatically. 
If you clear the check box, you can enter a user-specific value in the Granularity text box. 

 

 

The Text Box tool allows you to enter comments. You resize a text box by clicking it, grabbing 
one of its small handles (rectangles) and dragging it until the box is the right size. 

 

 

Figure 5—38 Text Box tool in the View Toolbox window  

Text Box tool 
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Under Settings…, you can make the following settings: 

 

 

Figure 5—39 Text Box Settings dialog box (Text Box tool) 

 

The Transparent check box makes the text box transparent. If you select the Auto Size check 
box, the size of the text box changes automatically to fit the length of the text. Otherwise, you 
can change its size as required. Font… opens a dialog box in which you can select the font to 
be used. In the Tool Text text box, you enter the text you want. 

 

 

The Value Graphics tool allows you to add simple drawing objects to the graph. When you 
drag the tool onto the graph, a context menu appears that allows you to select an ellipse 
(Ellipse Tool), a rectangle (Rectangle Tool), a line (Line Tool) or a curve (Curve Tool). 

You resize the object by clicking it, grabbing one of its small handles (rectangles) and dragging 
it until the object is the right size. 

The curve is a Bézier curve with four points. 

 

 

Figure 5—40 Ellipse object of the Value Graphics tool in the View Toolbox window  

Value Graphics tool 
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You can choose Settings… to open the Value Graphics Settings dialog box. 

 

 

Figure 5—41 Value Graphics Settings dialog box, first tab 

 

 

Figure 5—42 Value Graphics Settings dialog box, second tab 

 

The Lock Data Values check box on the Data Values tab allows you to control the scaling of 
the drawing object. If you select it, the drawing object is including in scaling. If you clear the 
check box, the object retains its original size during scaling. 

The Colors and Lines tab allows you to set colors and line widths. 
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5.2 Creating and editing a workspace 
 
 

Start the Analyzer. 

To create a workspace, click the Analyzer button and then New. Alternatively, click New in the 
Workspace group on the File tab. 

The workspace allows you to enter the storage location for your history data. 

 

 

Figure 5—43 Analyzer button, creating a new workspace 

 

 

Figure 5—44 Part of the File tab, creating a new workspace 

  

New workspace 
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The Edit Workspace dialog box appears. This allows you to specify the following folders, 
which you can either enter manually or select by using the Browse… button. 

• Raw Files: This is the folder for the raw data. The files containing the recorded 
EEG data are referred to as the raw data. 

• History Files: This is the folder for the history data. The history files contain all the 
processing steps (transforms) performed on the raw data. These files are 
displayed graphically in the History Explorer. 

• Export Files: This folder contains the files you may want to export as the result of 
the analyses performed. Exported files are intended for further processing in 
other programs. 

 

 
Figure 5—45 Dialog box for creating a new workspace 

 

Once you have made your settings, press the <Enter> key or click the OK button. 

The Save As dialog box appears, which allows you to save the workspace file. Give the file a 
meaningful name, and then press the <Enter> key or click the Save button. 

 

To open an existing workspace, click the File tab, then Open. A dialog box containing all the 
workspaces appears. 

The Refresh button on the File tab opens files that have just been added to the workspace 
without closing the existing files. This means that if you copy new data and/or history files to 
the folders of the workspace and then click Refresh, you can work with these files without 
having to interrupt your work with existing files. 

 

To make changes to the storage locations for history data, click Edit. The Edit Workspace 
dialog box appears. You can then make the required changes to the folders.  

Open and Refresh 

buttons 

Editing a workspace 
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Once you have finished configuring the folders for your data, the raw data is analyzed, and a 
history file is created for each raw data file. 

 

 

Figure 5—46 History Explorer with book icons 

 

Once you have successfully read in one or more EEG files, you can open a history file. 

 

Figure 5—47 Vision Analyzer with an EEG loaded 

 

You can then navigate around the EEG and show and hide markers (see also section 5.1). 
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5.3 Applying a transform 
 
 

You will find detailed explanations of the various transforms in chapter 12. You can undo all 
the transforms easily. Note also that the Analyzer never makes changes to the original EEGs. 

To perform a simple operation by way of example, click the Transformations tab and choose 
Data Filtering > IIR Filters from the Artifact Rejection/Reduction group. The Filters dialog 
box appears, in which you can make various filter settings. Click the OK button in the dialog 
box. 

 

 

Figure 5—48 Choosing the IIR Filters command 

 

Figure 5—49 Filter settings dialog box  
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A new window containing the resulting data set appears. An icon with the name Filters is 
added to the History Explorer. 

 

 

Figure 5—50 Branched history tree (A) 

 

Then choose: Transformations tab > Data Preprocessing group > RMS/GFP command. A 
dialog box containing two list boxes appears. The list box on the left contains the available 
channels, and the one on the right contains the selected channels. To add a channel to the list 
box on the right, you double-click it in the list box on the left. 

 

 

Figure 5—51 Choosing the RMS/GFP command  
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Figure 5—52 RMS/GFP dialog box 

 

Click the OK button. A new data window containing the result of the operation appears. In the 
History Explorer, an RMS icon is attached to the Filters icon. 

 

 

Figure 5—53 Branched history tree (B) 

 

When you perform further operations, the corresponding icons are added to the history file. 

You can create multiple branches from a data set. The analyses can be branched at any point.  
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If you want to perform analyses on your raw data that do not require filtering beforehand, 
display the raw data window by double-clicking the corresponding icon in the History Explorer. 
Choose the Transformations > RMS/GFP command. Select some channels, and then click OK. 
A new RMS icon appears under the Filters icon. The history list has branched.  

 

 

Figure 5—54 Branched history tree (C) 
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5.4 Explanation of terms: primary and secondary history data 
 
 

There are two types of history data: primary and secondary data. The primary history data is 
located on the Primary tab on the left-hand side of the application window. It consists of a 
specific set of raw EEG data and the processing steps carried out on it (i.e. transforms applied 
to it). 

 

 

Figure 5—55 Tab for the primary history data 

 

The secondary history files, which are located on the Secondary tab, generally represent 
operations performed across multiple nodes of different primary history files. Consequently, 
secondary history files no longer have a unique link to a specific set of raw EEG data. One 
example of secondary history data is the Grand Average transform. (You will find detailed 
information on performing this operation in section 12.4.4.)   
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Figure 5—56 Tab for secondary history data 

 

You can rename or delete history files in the same way as history nodes. Note, however, that 
unlike secondary history files, you cannot rename or delete primary history files in the 
Analyzer. 
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6 Segmentation 
 
 

The term “segmentation” is explained here because it comes up constantly in subsequent 
chapters. 

Segmentation is the subdivision of the EEG into different segments. Segmentation can be 
based on a number of different criteria. 

This manual uses the term segmentation in the following cases: 

• As a preliminary stage in the analysis of evoked potential. Epochs of the same 
length are generated relative to a reference marker (a stimulus, for example). This 
results in a data set consisting of connected segments or epochs. Thanks to the 
extensive segmentation options offered by the Analyzer, it is also possible to 
calculate averages based on complex stimulus conditions (behavior-dependent 
conditions, for example). 

• To prepare separate processing steps for different sections of an EEG, for 
example for the analysis of different stages before and after medication. In this 
case, sections are selected either manually or based on a fixed time scale and 
converted to new data sets in the history file. These can then be analyzed 
separately. 

Depending on whether you are looking at a data set before or after segmentation, you can 
specify initial settings for montages and views (EEG display modes or views) when new data 
windows are opened. 

 

You will find a detailed description of montages and views in chapter 8, “Montages”, and 
chapter 9, “Views”. You will find more information on segmentation in section 12.4.5, 
“Segmentation”. 
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7 User-specific preferences 
 
 

7.1 Configuring preferences 
 
 

To configure preferences for the user interface, click the Analyzer button and then 
Preferences. Alternatively, click the File tab then Preferences in the Configuration group. 

 

 

Figure 7—1 Analyzer button, Preferences command 

 

 

Figure 7—2 Configuration group, Preferences command 

 

The Preferences dialog box appears. This contains the tabs Views (EEG views), Scaling, 
Transformation Colors (for assigning colors to the transforms), Graphics Export/Output, 
Electrodes and General.  
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Figure 7—3 Preferences dialog box, Views tab 

 

The Views tab draws a distinction between unsegmented and segmented data (and offers the 
Unsegmented Data and Segmented Data group boxes). 

For both groups of data there is a drop-down list that allows you to set the standard view and 
standard montage (Default View and Default Montage). 

In addition, in the Default Displayed Channels text box you can display the number of 
channels to be displayed by default. 

For the unsegmented data, you can also display the default display time in seconds (in the 
Default Display Time [s] text box) and the overlap of the intervals in seconds (in the Overlap 
Intervals [s] text box). 

The value in the Relative to Window Width [%] text box specifies the width of a transient view 
when it is opened. The value specifies the portion of the view occupied by the transient view. 

 

The Scaling tab allows you to configure the initial parameters of the EEG views. It contains the 
Time Domain Scaling and Frequency Domain Scaling group boxes. 

On this tab you can specify the time domain scaling and frequency domain scaling before and 
after averaging for newly opened view windows.   

Views tab 

Scaling tab 
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Figure 7—4 Preferences dialog box, Scaling tab 

 

In the Before Averaging [μV] and After Averaging [μV] text boxes, you specify different 
scaling for before and after averaging. 

For the time domain, the Polarity Positive Down function sets the polarity of the signal in the 
display. If you select the check box, the axis for positive measured values points down. 

If you select the Start with Display Baseline On check box, the baseline correction function in 
the EEG view is activated by default. 

The Set Individual Scaling Factors function allows you to specify the channels that are to be 
displayed attenuated. This is desirable for ECG channels, for example, since otherwise they 
encroach badly on the curves of the EEG channels. You enter the channel names and the 
associated scaling factors for the attenuation of the signals in the table below. The attenuation 
only affects the display of the data; it does not affect the data itself. 

 

 

Figure 7—5 Scaling of individual channels  
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If you select the Time Labels are Relative to Display Interval check box, the times in views 
(in the labels of head maps, for example) are displayed relative to the EEG interval displayed. If 
the check box is not selected, these times are displayed relative to the beginning of the whole 
EEG. If the EEG has its own time scale defined by time zero markers, this time specification is 
ignored and the time scale is used. 

 

The Transformation Colors tab allows you to assign colors to the individual transforms. These 
are used for the corresponding icon in the History Explorer, the commands on the Ribbon and 
in the frame of the EEG views. 

You can assign colors in the table in the figure below. 

 

 

Figure 7—6 Table for assigning colors to transforms 

 

If you repeatedly click a color strip in the Color column, a drop-down list containing the color 
selection dialog box appears. 

The Custom tab contains the basic colors, and the Web tab contains predefined Web colors.  

Transformation 

Colors tab 
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Figure 7—7 Edit Colors dialog box (A), basic colors 

 

You can choose between basic (standard) colors and custom colors. You enter the latter by 
right-clicking a free box on the Custom tab. The Edit Colors dialog box opens. On the right-
hand side of the Edit Colors dialog box, there is a color spectrum from which you can select 
the color you want. When you click the Add to Custom Colors button, the selected color is 
added to the Custom colors list. Click the OK button to close the dialog box. 

 

 

Figure 7—8 Edit Colors dialog box (B), custom colors  
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In the Frame-Width text box, you specify the width of the color frame around the EEG data 
window. This must be a value between 0 and 99. 

If you click the Set to Default button, the color of the corresponding transform is set to the 
color value selected under <Default>. If you change the value <Default>, all transforms 
containing this value are changed. 

If you click the Reset all Transformations to <Default> button, the value <Default> is applied 
to all transforms. 

 

 

The Graphics Export/Output tab is described in chapter 17, “Printout” and in chapter 18, 
“Graphical export”. 

 

 

On the Electrodes tab, you can specify a file containing electrode coordinate definitions. These 
coordinates are used if EEG data does not have coordinate specifications for its channels. 

By default, numerous electrode positions are predefined in the Analyzer. By specifying a 
separate electrode file, you can add to or replace these electrode positions. The format of this 
file is described in Appendix H. Note that a file containing the specification “Defaults = False” 
entirely replaces the Analyzer’s default coordinates. If a file does not contain this specification, 
the coordinates in the file are added to the default coordinates. 

 

 

Figure 7—9 Preferences dialog box, Electrodes tab  

Graphics 

Export/Output tab 

Electrodes tab 
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On the General tab, you can specify the intervals at which the deleted nodes of a history file 
are to be purged. This is the same function you get when you choose the Purge Deleted Nodes 
command from the context menu of the history file. It prevents deleted nodes from 
accumulating over time and taking up storage space. 

The entry in Purge Nodes every xxx days specifies that the nodes are purged after this time 
elapses, at the earliest. In normal usage, the nodes are often there for a little longer because 
the automatic purging of the nodes is subject to additional checks. 

The automatic purging of nodes is only carried out when you close the history file. This means 
that deleted nodes in history files that you never open are not automatically purged. 

The setting you make for Draw Background for Progress Bar specifies whether the Analyzer 
window is displayed when a progress bar is active. This is part of the system in Windows® 
Vista. The setting Auto takes this into account and suppresses emulation by the Analyzer on 
Vista machines. 

 

 

Figure 7—10 Preferences dialog box, General tab 

 

General tab 
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7.2 Customizing the graphical user interface 
 
 

7.2.1 Skins 
 
 

To make changes to the graphical user interface of the Analyzer, click the Display tab and go to 
the Skins group. 

You select a skin by clicking one of the skin buttons in the group. Alternatively, you can click 

the button  in the lower right corner of the group to get a detailed view. 

 

 

Figure 7—11 Display tab, Skins group 

 

 

Figure 7—12 Display tab, Skins group, detailed view 
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7.2.2 Docking 
 
 

The docking feature allows you to display the docking or tool windows and data to be analyzed 
clearly and arrange them flexibly. The docking windows can be fixed in position at any point in 
the application window and shown or hidden dynamically. 

 

 

Figure 7—13 Maximum data view 

 

Figure 7—14 Maximum productivity  
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The docking window has a title bar containing its name and, depending on the settings 
specified, the following buttons, which allow you to hide, resize and close the window: 

•  Anchors the docking window in a fixed position. 

•  Shows or hides the docking window temporarily. 

•  Maximizes the docking window. 

•  Minimizes the docking window. 

•  Closes the docking window. 

 

The docking windows can be displayed in the modes “docked” or “undocked” (also known as 
“floating”). The docked mode also has the display modes “pinned” and “unpinned”. 

 

In undocked or floating mode, the window is essentially left floating. It can be docked onto the 
outer or inner borders of the existing windows. 

You can resize the floating window by dragging its borders. 

In undocked mode, you can also move the windows outside the main window. This also allows 
you to work with more than one monitor. 

 

Figure 7—15 Floating docking window  

Modes of the 

docking windows 
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In docked mode, each docking window has a pin button on the title bar. When you click the 
pin, it changes from horizontal (unpinned) to vertical (pinned) or vice versa. 

 

 

Figure 7—16 Title bar of a docking window 

 

 Horizontal pin: The docking window is unpinned and is hidden when you move the 
mouse pointer outside it. In addition, a bar containing a button for each open window appears 
with the docked window. You display the hidden window again by positioning the mouse on 
the corresponding button on this bar. When you display the unpinned window again, it covers 
the data window behind it (figure 7—18). 

 

 

Figure 7—17 Unpinned docking window (hidden)   

Docked mode 

Pinned 



 
Docking 7.2.2 

 
 
 

 
BrainVision Analyzer  7.2.2—- 4 - 

 

Figure 7—18 Unpinned docking window (shown) 

 

The position of an unpinned window cannot be changed. In other words, it is not possible to 
move the window using the mouse. In addition, the scope for resizing the docking window is 
limited because it is fixed to a window border. 

Because of their horizontal orientation, the toolbar and navigation bar can only be docked onto 
the upper or lower border. 

 

 

 Vertical pin: The docking window is pinned and remains open. You can move the 
unpinned docking window by clicking the title bar and holding down the left mouse button.   

 

 

Unpinned 



 
Docking 7.2.2 
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Several windows can be grouped together in a container. They either appear along the lower 
border of the container as tabs or arranged horizontally or vertically as subdivisions of the 
container. The container has the same modes as a docking window. 

 

 

Figure 7—19 Tab container with three tabs 

 

With horizontally arranged docking windows, you can, for example, arrange the primary and 
secondary history data in the same way as in Version 1.0 of the Analyzer: 

 

 

Figure 7—20 Split container with horizontally arranged docking windows  

Tab container and 

split container 
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When the Analyzer is started up for the first time, the docking windows are positioned as 
follows: The Primary Data, Secondary Data and Node List windows are docked onto the left-
hand border of the application window, the View Toolbar window is docked onto the right-
hand border, and the navigation bar to the lower border. 

To open or close the different windows, click the Window button on the toolbar and select or 
clear the relevant check box. 

 

 

Figure 7—21 Context menu for opening and closing the docking windows 

 

To close the windows, you can also click the cross button on the right-hand side of the 
window’s title bar. 

 

You can choose Windows > Reset Panel Layout to reset the docking windows to their original 
layout. 

 

 

You can position the docking window relative to the outer or inner borders of the available 
windows by using landing zones. 

 

Note that a docked window can only be moved when it is in unpinned mode (i.e. with a vertical 

pin button: ). 

You can move the unpinned docking window by clicking its title bar. By holding down the left 
mouse button, you can move the window around freely. If you position the mouse pointer on a 
landing zone, the position that the window can take up is highlighted in blue:   

Opening and closing 

the docking windows 

Resetting the window 

positions 

Positioning by means 

of landing zones 
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Figure 7—22 Blue highlighting of the landing zones  
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The figures below show examples of the positioning of docking windows before and after 
docking: 

 

Figure 7—23 Before docking (upper border) 

 

Figure 7—24 After docking (upper border) 
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Figure 7—25 Before docking (insertion of the window as a new tab) 

 

Figure 7—26 After docking (insertion of the window as a new tab) 
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7.3 Configuring the EEG view settings 
 
 

7.3.1 View settings: Introduction 
 
 

The EEG views offer a variety of ways of displaying EEG data on the screen. You can configure 
them using the view settings in order to display the EEG data how you want it. Views that 
display the data in a similar way are subdivided into view categories to make configuration 
easier. Thus, the grid views for time and frequency data belong to the same view category. All 
the views in a category can be assigned the same settings. 

Distinctions are drawn between the factory settings of the view settings, the category-related 
view settings (default view settings) and the node-specific view settings. 

The factory settings cannot be altered. They differ from one view category to the next. User-
defined settings can easily be reset to the factory settings. 

You can change the category-related view settings. They apply, in each case, to a single 
category of EEG views. Examples of categories are the standard view, grid view and map view. 
The node-specific view settings apply exclusively to the history node currently being 
processed. 

The category-related view settings, which can be changed by the user, apply to all nodes 
displayed with views of a particular category – all standard views or all grid views, for example. 
You can display the category-related view settings by choosing File > Configuration > View 
Settings. 

The node-specific view settings apply exclusively to the history node currently being 
processed. The settings are saved in the node and become available whenever you open the 
node. You display the node-specific settings by right-clicking any point in the current view and 
choosing the Settings… command from the context menu that appears. 

Note that changes to the category-related view settings are also applied to open windows as 
soon as you close the dialog box by clicking OK. 

 

You will find a detailed description of the EEG views in chapter 9, “Views”. 
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7.3.2 Category-related view settings 
 
 

Click the Analyzer button, and then choose View Settings. Alternatively, click the File tab, 
then View Settings in the Configuration group. 

 

 

Figure 7—27 Analyzer button, View Settings command 

 

 

Figure 7—28 Configuration group, View Settings button 

 

The Default View Settings dialog box appears. All EEG view categories are listed 
alphabetically. 

Click an item in the list. Seven tabs, which are identical regardless of which category you 
choose, appear in the dialog box. These allow you to make settings for the views. 

Views that display nodes with different data types in the same way – the frequency grid view 
and time grid view, for example – are grouped together in the same view category. 
Consequently, all the tabs are always displayed, even if you want to make settings for the time 
grid view, for example.   
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Figure 7—29 Default View Settings dialog box 

 

 

Figure 7—30 Default View Settings dialog box with tabs 

 

The Reset All Settings from Selected View button resets the view settings of the currently 
selected view category to the factory settings for this category.  



 
Category-related view settings 7.3.2 
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The Display tab contains the group boxes Style, Marker and Horizontal Level Lines. 

 

 

Figure 7—31 Default View Settings dialog box, Display tab 

 

In the Style group box, you can make the following settings: 

• If you select the Show Baseline check box, the baseline is displayed. 

• If you select the Show Border check box, the EEG graphs are truncated at the 
borders of the grid cells or channel ranges. An additional border appears around 
the cell in grid or head views. 

• The Show Label check box allows you to show or hide the channel names. 

• If you select the Label on Left Side check box, the channel names are displayed 
to the left of each channel. 

 

The Show Horizontal Level Lines check box allows you to show or hide the horizontal level 
lines. In the Distance between Level Lines [μV] text box, you can enter the spacing between 
the horizontal level lines in μV. 

 

 

Figure 7—32 Horizontal level lines displayed  

Display tab 

Style group box 

Horizontal Level 

Lines group box 
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In the Marker group box, you can make the following settings: 

• If you select the Show Markers check box, the markers set in the EEG are 
displayed. If the check box is selected, you can: 

• Select the Show Global Markers check box to display the markers that are 
common to all channels (i.e. not limited to a particular channel) 

 
Figure 7—33 Global markers displayed 

 

• Select the Show Global Markers in Channels check box to display the global 
markers at the level of the individual channels: 

Figure 7—34 Markers displayed in each channel 

 

• Select the Markers on Channel Graph check box to display the markers of a 
channel on the graph of this channel: 

 
Figure 7—35 Channel maker displayed on the graph  

Marker group box 
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The Display (FFT) tab contains parameters that are relevant to data in the frequency range. 

 

 

Figure 7—36 Default View Settings dialog box, Display (FFT) tab 

 

In the Drawing group box, you can make the following settings: 

• The Draw Data as Block and Draw Data as Graph radio buttons allow you to 
specify whether the points are to be drawn as discrete blocks or a graph. 

• If you select the Draw Fill Colors check box, the area under the graph is filled 
with colors. The frequency bands set on the Bands tab are highlighted in color. 

• If you select the Show Legend check box, the color legend is displayed. 

 

In the Scaling group box, you can make the following settings: 

• If you select the Logarithmic Scaling check box, logarithmic scaling is applied to 
the y-axis. 

• If you select the Show Scaling Bars check box, the scaling bar is displayed. 

 

In the Display Range group box, you specify the frequency range displayed in hertz. 

  

Display (FFT) tab 

Drawing group box 

Scaling group box 

Display Range group 

box 
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The Time-Frequency tab is used for views that display data in the time-frequency domain. It 
contains the group boxes Colors, Scaling and Satellite Graphs. 

 

 

Figure 7—37 Default View Settings dialog box, Time-Frequency tab 

 

In the Colors group box, you can make the following settings: 

• Interpolate Data: The data is interpolated in the time/frequency domain, 
resulting in continuous data display. 

• Standard Colors: The standard color scale (blue-green-red) is used. 

• Grayscaling: Converts the color display to grayscales. 

• Discrete Colors: Displays discrete colors. 

• The Set Details… button displays the Discrete Color Settings dialog box. In this 
dialog box you can specify the colors values for positive and negative values (in 
the Color for Positive Values and Color for Negative Values list boxes). In the 
Color Steps text box, you specify the number of steps in the color scale. 

• If you select the Symmetrical Map Color check box, the minimum and maximum 
voltage values both appear in the same color, while zero values are assigned the 
other color. 

• If you select the Zero is Darkest Color check box, all zero values appear in black. 
If you clear it, they appear in white. 

• If you select the Draw Contour Lines check box, each color step gets a contour 
line.   

Time-Frequency tab 

Colors group box 
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Figure 7—38 Discrete Color Settings dialog box (accessed from the Time-Frequency tab) 

 

In the Scaling group box, you can make the following settings: 

• If you select the Logarithmic Scaling check box, logarithmic scaling is applied to 
the y-axis. 

• If you select the Automatic Scaling radio button, the optimum scaling is 
calculated automatically. If you also select the Symmetric Scaling check box, 
scaling limits are selected that ensure the value “0” is always in the middle of the 
color legend. 

• If you select the Manual Scaling radio button, you can specify scaling manually 
by entering in the Maximum and Minimum text boxes the voltage interval 
covered by the color spectrum shown. 

 

The radio buttons here allow you to specify whether the satellite graphs are always displayed 
(Show Always), never displayed (Show Never) or only displayed when there is enough space 
for them (Show, if Size is Sufficient). 

  

Scaling group box 

Satellite Graphs 

group box 
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The Axes tab allows you to configure the x- and y-axes. 

 

 

Figure 7—39 Default View Settings dialog box, Axes tab 

 

You can make the following settings separately for the x- and y-axes: 

The Show Never, Show, if Size is Sufficient and Show Always radio buttons allow you to 
specify whether the axis is not to be displayed, only to be displayed if there is enough space or 
always displayed. 

• In the Position group box, you can specify the position of the axis: The x-axis can 
be positioned on the baseline (Baseline radio button) or along the lower border 
of the EEG (Bottom radio button). The y-axis can be positioned on the left (Left 
radio button) or at the zero point (Time 0 radio button). 

• Under Tickmarks, you set the intervals for the subdivisions of the axis. You can 
either have the intervals calculated automatically (Set Automatic) or set them 
manually (Set Manual). For the x-axis, you specify the interval in ms; for the y-
axis, you specify it in μV. Under Alignment, you specify the alignment of the 
scaling marks: For the x-axis, you can specify alignment with the top (Top radio 
button) or bottom (Bottom radio button), and, for the y-axis, you can specify left 
alignment (Left radio button) or right alignment (Right radio button). 

• Under Tickmark Labels, you use the Show Labels check box to specify whether 
and, if so, at what intervals the subdivisions of the axis are to be labeled. For the 
x-axis, you specify the interval in ms, and for the y-axis in μV.  

Axes tab 

X Axis and Y Axis 

group boxes 
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On the Bands tab, you can set the frequency bands. 

In the table, you can specify the color of a band, its name and where it starts and ends (in 
which columns from left to right) in hertz. You change the color of the band by repeatedly 
clicking a color strip in the Color column and displaying the color selection dialog by means of 
a drop-down list. 

The asterisk allows you to insert a new row. You can delete rows from the table by pressing the 
<Delete> key. 

All frequency ranges that are not defined in the table are displayed in black. 

The Apply to all Views button applies the current settings for frequency bands to all other view 
categories. The histogram view (MR Correction transform) is an exception to this because it 
does not use the usual frequency bands. 

 

 

Figure 7—40 Default View Settings dialog box, Bands tab  

Bands tab 
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On the Overlay tab, you can specify settings for overlaid EEG curves. The settings affect how 
the curves are displayed and labeled. They are made in a separate table for each curve. 

 

 

Figure 7—41 Default View Settings dialog box, Overlay tab, colors of the frequency bands 

 

 

Figure 7—42 Overlay tab, display of the frequency bands using monochrome lines 

 

The following options are available to you: 

• You can choose between displaying the EEG curves in a single color using 
different line types (Dash-Pattern column) and displaying them in different 
colors (Color column). To do this, you select either the Monochrome or Color 
radio button. 

• In the Line Width column, you specify the line width of the curves. 

• In the Reference Node and Overlays text boxes, you enter the names of the 
reference channel and the overlaid channels. The entries in these text boxes only 
take effect if the data sets are overlaid (see section 9.3, “Overlaying of different 
data sets”).   

Overlay tab 
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• You can also use placeholders to name the channels (see under Placeholders). 
These are replaced with current values when the curves are displayed (i.e. with 
the name of the relevant data set). The following table lists the available 
placeholders: 

 

• The Apply to all Views button applies the current settings for overlays to all other 
view categories. The butterfly view and standard deviation view are exceptions to 
this because they use special overlay settings. 

 

The Maps tab allows you to configure the topographic map display. It contains the group boxes 
Interpolation, Scaling and Display. 

 

 

Figure 7—43 Default View Settings dialog box, Maps tab  

Placeholder Meaning
$c Channel name
$h Name of the history file
$n Name of the associated data set
$o Ordinal number of the curve
$p Full history path including all the intermediate steps from the 

raw EEG to the current data set

Maps tab 
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In the Interpolation group box, you can make the following settings: 

• In the Number of Maps text box, you specify the number of maps to be displayed 
simultaneously. 

• In the Interval between Maps text box, you specify the interval between two 
maps. For time data you specify this in milliseconds and for frequency data in 
hertz. 

• Fix Number of Maps check box: There are two ways to specify the number of 
maps: 

Directly, by entering a value in the Number of Maps text box and selecting the 
Fix Number of Maps check box 

Indirectly, by entering a value in the Interval between Maps text box and 
clearing the Fix Number of Maps check box 

• Select the Fix Number of Maps check box if you want to manually change the 
width of the total interval to be displayed in a mapping view. When you select the 
check box, the number of maps displayed is kept constant during scaling and the 
interval between them is adjusted accordingly. If you do not select the check box, 
the interval between the maps is kept constant and the number of maps is 
adjusted accordingly. 

• If you select the Use Average Value of Interval check box, the average value of 
the selected interval is used to calculate the maps. If you leave the check box 
cleared, only the first point of the interval is used. 

• If you select the Use Preview check box, a preview is created before the map is 
actually calculated. This can give a very quick impression of the map’s color 
distribution. This option is useful when the map image has to be navigated 
quickly. You should clear this check box if you want to programmatically record 
an animation consisting of map screenshots. 

The following radio buttons allow you to select algorithms for calculating the data: 

• Triangulation and Linear Interpolation: You will find detailed information on 
this algorithm in section 12.7.4, “Topographic interpolation”. 

• Interpolation by Spherical Splines: You will find detailed information on this 
algorithm in section 12.7.4, “Topographic interpolation”. 

• If you opt for interpolation with splines, you enter the spline order in the Order of 
Splines text box and the maximum degree of the Legendre polynomial in the 
Max. Degree of Legendre Polynomials text box. 

• If you select the Default Lambda check box, the default value of 10-5 (1e-5) is 
automatically accepted. If you clear the check box, you can enter a different value 
in the Other Lambda text box. You will find detailed information on this in 
section 12.7.4, “Topographic interpolation”.  

Interpolation group 

box 



 
Category-related view settings 7.3.2 

 
 
 

 
BrainVision Analyzer  7.3.2—- 13 - 

In the Scaling group box, you can make the following settings: 

• If you select the Automatic Scaling radio button, the optimum scaling is 
calculated automatically. If you also select the Symmetric Scaling check box, 
scaling limits are selected that ensure the value “0” is always in the middle of the 
color legend. 

• If you select the Manual Scaling radio button, you can specify scaling manually 
by entering in the Maximum and Minimum text boxes the voltage interval 
covered by the color spectrum shown. 

 

In the Direction group box, you can select one or more different views of the map: Top (viewed 
from the top), Front (viewed from the front), Back (viewed from the rear), Right (viewed from 
the right) and Left (viewed from the left). You can define the view of the map by selecting the 
All in One Map check box and then specifying a maximum angle of view (in the Max Angle 
[degrees] text box). 

 

The Display group box offers you the following options: 

• Standard Colors: The standard color scale (blue-green-red) is used. 

• Grayscaling: Converts the color display to grayscales. 

• Discrete Colors: Displays discrete colors. 

• The Set Details… button displays the Discrete Color Settings dialog box. In this 
dialog box, you can specify the color values for positive and negative values (in 
the Color for Positive Values and Color for Negative Values list boxes). In the 
Color Steps text box, you specify the number of steps in the color scale. 

• If you select the Symmetrical Map Color check box, the minimum and maximum 
voltage values both appear in the same color, while zero values are assigned the 
other color. 

• If you select the Zero is Darkest Color check box, all zero values appear in black. 
If you clear it, they appear in white. 

• If you select the Draw Contour Lines check box, each color step gets a contour 
line. 

• In Quick Graphics mode, not every pixel in the map is calculated. Instead, only 
the values of the points of a rectangular grid with a specific resolution are 
calculated. Then each rectangle in the grid gets the calculated color. This results 
in a map that has a lower resolution but can be calculated much more quickly. 

• If you select the Show Electrodes check box, the electrodes appear as small 
circles on the map.  

Scaling group box 

Direction group box 

Display group box 
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The settings for the 3D map only appear for the “3D Head View” category. They allow you to 
configure the display of the 3D head. The dialog box contains the group boxes Interpolation, 
Scaling, Display and Head. 

 

Figure 7—44 Settings for the 3D map 

 

The group boxes Interpolation, Scaling and Display contain identical options to those on the 
Maps tab. The Direction group box on that tab does not appear here because the head can be 
rotated freely. 

 

From the Head File drop-down list box, you choose the head to be displayed from the available 
head definitions. 

The Vertical Angle and Horizontal Angle text boxes allow you to specify the angle of view for 
the head. 

 

3D map settings 

Head group box 
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7.3.3 Node-specific view settings 
 
 

You display the node-specific settings by right-clicking any point in the current view and 
choosing the Settings… command from the context menu that appears. Our example concerns 
the history node odd_phob_2/Raw Data. 

 

 

Figure 7—45 Node-specific context menu, Settings command 

 

The View Settings dialog box appears, which contains the node-specific settings for the view 
on the corresponding tabs. In our example of a standard view with time data, it contains the 
Display and Overlay tabs. 

 

 

Figure 7—46 Node-specific View Settings dialog box  
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When you create a new node, it initially takes the category-related view settings (default view 
settings). The changes you subsequently make to the node’s view settings always take priority 
over changes to the category-related view settings. If you make no changes at node level, the 
category-related view settings are used. 

The node-specific settings are saved in the node and become available whenever you open the 
node. The node-specific settings apply only to the active view. You can thus display different 
views of the node using different settings each time. 

By right-clicking and choosing the Reset Settings command from the context menu, you can 
delete from the node all the settings made at node level that apply to the currently selected 
view. 

 

 

Figure 7—47 Node-specific context menu, Reset Settings to Defaults command 
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7.4 Configuring administrator rights (Administration command) 
 
 

Click the Analyzer button, and then choose Administration. Alternatively, click the File tab, 
then Administration in the Configuration group. 

 

 

Figure 7—48 Analyzer button, Administration command 

 

 

Figure 7—49 Configuration group, View Settings button 

 

The Analyzer Administration dialog box appears. This contains the tabs Application Paths, 
Profiles and Component Search Paths.  
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The Application Paths tab allows you to set search paths. 

 

 

Figure 7—50 Analyzer Administration dialog box, Application Paths tab 

 

In the Installation Base Path text box, you specify the folder containing the application. In the 
Solutions Path text box, you specify the folder containing the solutions. In the Workfiles Path 
text box, you specify the folders for workspace files, macros and history templates. 

The associated Browse… buttons allow you to select a folder. 

 

 

The Profiles tab allows you to manage user profiles. 

 

Figure 7—51 Analyzer Administration dialog box, Profiles tab  

Application Paths tab 

Profiles tab 
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The user profiles determine where the settings made using File > Configuration > Preferences 
and File > Configuration > View Settings are stored. The settings can either be stored 
separately for each user or in a shared, system-wide file for all users. 

If the Only the Administrator May Change These Settings check box is selected, the rest of 
the tab is not accessible to those who are not administrators. 

 

If you select the Configuration Changes are Written to System Configuration File check box, 
when changes are made to the settings they are written to a system-wide file. 

In the System Configuration File text box, you can specify the name of this system-wide file. If 
you do not specify a name, a default name is used. If you specify only a file name, the file is 
stored in a location determined by the system. If you specify a full path, the file is stored in the 
location indicated by this path. Note that you must have read and write access to this path in 
order to use the file. 

 

If you select the Use Individual Profiles check box, when changes are made to the settings 
they are written to a user-specific file. 

In the User Configuration File Template text box, you can specify a name for the template of 
the user-specific file. If you do not specify a name, a default name is used. In the specified file 
name the placeholder $u is replaced with the user name. 

If you specify only a file name, the user-specific files are stored in a location determined by the 
system. If you specify a full path, the files are stored in the location indicated by this path. Note 
that all users must have read and write access to this path in order to use the file. 

 

If the Configuration Changes are Written to System Configuration File check box is not 
selected, the Use Individual Profiles check box is selected and cannot be cleared. 

If you select settings files on the Profiles tab that do not yet exist, the files are created. Default 
values are used for the settings. If user profiles are selected although there is a system-wide 
file, users use the system-wide settings unless they have made personal settings that are 
different from those. In this way, the system-wide configuration file can be used, for example, 
to determine the settings for a user starting the Analyzer for the first time.  

System-Wide 

Configuration 

Settings group box 

User Configuration 

Settings group box 
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The Component Search Paths tab allows additional, modified components or components 
created by the user to be added to the Analyzer subsequently. 

 

 

Figure 7—52 Analyzer Administration dialog box, Component Search Paths tab 

 

If the Only the Administrator May Change Search Paths check box is selected, only the 
administrator has the right to change the path settings. 

The table contains a list of the search paths taken into account by the Analyzer when searching 
for components. The Analyzer searches through all the DLL or VAEM files on these paths. It also 
always searches through its installation folder. 

The asterisk (*) functions as a placeholder in the same way as it does in files. In our example of 
“c:\Development\*\bin\Debug”, the folders “c:\Development\Project_1\bin\Debug” and 
“c:\Development\Project_2\bin\Debug” would be found. 

The Browse… button allows you to select the folders. 

The Up and Down buttons allow you to change the order of the rows in the table. The order in 
which the entries occur in the table is the order in which they are searched. If a component 
occurs more than once, the component listed first in the table is always used. 

Note that the Analyzer installation folder is always searched after the entries in the table. 

 

Component Search 

Paths tab 
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8 Montages 
 
 

Montages enable channels to be reconnected on a software basis. In other words, new voltage 
reference points are assigned to the channels. 

Montages also optimize the display of data by, for example, allowing frontal electrodes to be 
grouped together in one montage and occipital electrodes in another. When one of these 
montages is selected, only those channels that have been assigned to it are displayed. The 
order in which the channels occur can also be changed in a montage. Thus, channels that were 
originally apart can be shown next to each other. A channel can also appear more than once in 
a montage. 

Another important characteristic of montages is that certain display parameters, such as the 
position and size of a channel, can be assigned to them in a head view. (A head view is a view 
in which the channels can be freely positioned in the window. Its size can be adjusted to suit 
requirements. To find out what can be done in the head view, refer to section 9.2.3.) 

A montage is used for visualization purposes only. In other words, the new data only exists 
temporarily and does not change the original data. 

 

To create a montage, you choose Create Montage from the Display tab. 

 

 

Abb. 8—1 Display tab, Montages group 

 

The Create New Montage dialog box appears. 

 

 

Abb. 8—2 Dialog box for creating and editing montages   

Summary 

 

Creating a montage 
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In the Choose Reference group box, you choose the reference type to be used in the new 
montage. The following radio buttons are available for this: 

• Original: No new reference is calculated. This type of montage is only used to 
group channels together or optimize their presentation, as described above. 

• Average: The average reference is calculated. In other words, the average of all 
the selected channels is used as the reference. 

• Laplacian: Source derivation, as described by Hjorth, is carried out. This is a 
method derived from the Laplace transform in which the reference is calculated 
from multiple neighboring electrodes of a channel. 

In order to work out which are the neighboring electrodes, the program requires 
information about the position of the electrodes. If you used electrode names on 
the 10/10 or 10/20 principle when recording the EEG, the program should have 
this information. However, if you used other channel names, you can use the Edit 
Channels transform to enter the correct coordinates. You will find detailed 
information on this in section 12.1.6, “Edit Channels”. 

You can also specify a separate file containing default coordinates. You do this 
on the Electrodes tab, which you display by choosing File > Configuration > 
Preferences (see section 7.1, “Configuring preferences”). 

• Bipolar: Differences between channels are formed. 

 

We advise you to select the simplest reference type (the original reference) initially. 

Once you have selected the reference type, click OK. The montage editor (the Edit Original 
Referenced Montage dialog box) appears. The montage editor offers the same basic functions 
for all four reference types. Some additional controls are displayed for the Laplacian and 
bipolar reference types.  
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The montage editor contains the Head View and List View tabs. The tabs allow you to select 
the channels contained in the montage. The head view gives you an overview of the 
arrangement of the channels on the head. The list view allows you to enter new channels not 
displayed in the head view. You can also activate a grid view of the montage. This view is 
explained in the subsection entitled “Montage grid”. 

 

The Head View tab shows the channels in their position on the head. Channels whose position 
is not known are displayed to the left of the head. If you click the name of a channel, it is 
added to the montage. If you click it again, it is removed from the montage. 

Channels added to the montage are highlighted in black. 

The Insert current channels button allows you to add all the existing channels to the 
montage. Remove All removes all channels from the montage. 

If you click a point on the head where there is no channel and then drag the mouse, you can 
select multiple channels. 

 

 

Figure 8—3 Montage editor, Head View tab  

Head View tab 
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The List View tab displays the list of channels in the order in which they appear in the 
montage. You can select multiple rows in the list and delete them. In the last row, you add new 
channels by choosing them from the drop-down list or entering them directly. 

Channels that you enter manually are added to the drop-down lists in the rows. 

 

 

Figure 8—4 Montage editor, List View tab  

List View tab 
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A distinction is drawn between montages with and without grid information. Montages with 
grid information specify how the channels are displayed when a grid view is used (size of the 
grid in rows and columns, free cells). Montages without grid information are automatically 
arranged in a grid view with no cells free. 

You specify whether a montage has grid information by means of the Use Grid check box. If 
you select the check box, an additional section containing a grid appears in the montage 
editor: 

 

Figure 8—5 Montage editor with grid on the right 

 

In the grid, you can use the mouse to add channels and drag them to a different cell. If you 
drag a channel to a cell occupied by another channel, the channels swap places. 

The order in which the channels appear in the list view is always the same as the order in 
which they occur in the grid on the right. Read from left to right and top to bottom. If you 
change the position of a channel in the grid on the right, the list is adjusted accordingly. 

Even if a montage is not to use any grid information, it can be a good idea to display the grid on 
the right temporarily to allow you to change the order of the channels slightly. 

 
In the Grid Size group box, you specify the size of the grid in rows (in the Rows text box) and 
columns (in the Columns text box). The Apply button applies your entries to the grid. If the grid 
is reduced in size, channels already contained in the grid are rearranged in the new grid, 
reflecting the original layout as far as possible. 

The Set grid size to channel numbers button creates an approximately square grid containing 
the channels of the montage. If you add new channels on the Head View or List View tab, they 
are added in free cells. If necessary, the grid is extended.  

Montage grid 

 

Tip 
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If the mouse pointer is positioned over a cell in the grid, the corresponding channel is 
highlighted in color on the Head View tab and vice versa. 

In addition, you can also drag channels directly from the Head View tab to a grid cell. 

 

Figure 8—6 Color highlighting of channels 

 

 

You can use the Channels in Montage are Based on drop-down list to select the set of 
channels on which the head view is based. In the list view, you use the channel drop-down 
lists. The following options are available for selection: 

• Standard 10/20 Electrodes: The standard set of 10/20 electrodes is used. 

• -NONE-: With the exception of any existing montage channels, there are no 
channels available. 

• Data Node Electrodes: The channels of the open data node are used. 

Regardless of the underlying channel set, you can, of course, continue to enter channel names 
of your choice in the List View. 

 
The Load button allows you to load a separate electrode configuration file in the BrainVision 
electrode file format. This XML-based format is explained in Appendix H. 

If you select the Make commonly used channels available in section lists check box, a 
selection of frequently used channel names is added to the channel drop-down lists in the list 
view. If you choose one of these channels from a drop-down list, it appears in the head view 
with standard coordinates if it is not contained in the selected channel set.  

 

Base Channel Set 

group box 
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If you select the Laplacian reference type, the Number of Reference Electrodes text box 
appears in the montage editor, thus allowing you to specify the number of reference 
electrodes. 

 

 

Figure 8—7 Part of the montage editor for the Laplacian reference type 

 

 

If you select the bipolar reference type, the list view contains two columns: Channel and 
Reference Channel. 

The cells in the grid indicate the difference between the channel and reference channel in each 
case. 

On the Head View tab, the channel and reference channel are shown connected by arrows. You 
can use the mouse to add a channel and drag it to its reference channel. 

 

Figure 8—8 Montage editor for the bipolar reference type, List View tab with grid on the 

right   

Peculiarity of the 

Laplacian reference 

type 

Peculiarities of the 

bipolar reference 

type 
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Figure 8—9 Montage editor for the bipolar reference type, Head View tab 

 

 

The Save and Save As… buttons are available for saving the montage. 

 

 

To modify an existing montage, select the Edit Montage radio button in the dialog box. A 
dialog box appears that allows you to open an existing montage file. 

After you have edited the montage, you are again asked for the name under which you want to 
save the montage. You can enter a new name in order to obtain a new montage from an 
existing one. 

Note that the reference type of an existing montage cannot be changed.  

Saving the montage 

Editing a montage 
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The Display Montage menu command allows you to display all your montages easily. 

 

Figure 8—10 Displaying montages 

 

To allow you to switch quickly between different montages, you can assign them keyboard 
shortcuts. These keyboard shortcuts activate the associated montages. To assign these 
keyboard shortcuts, you choose Display > Montages > Options. The montages are assigned to 
the keyboard shortcuts <Ctrl-1> to <Ctrl-0>. <Ctrl-1> is reserved for the default montage. You can 
assign the other keyboard shortcuts to whichever montages you choose. 

 

 

Figure 8—11 Selecting keyboard shortcuts for montages   

Displaying the 

montages 

Keyboard shortcuts 
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You can also select a montage to be activated when a new data window is opened. To do this, 
choose Configuration > Preferences and then click the Views tab. From the Default Montage 
drop-down list boxes for unsegmented and segmented data sets, you can select the initial 
(default) montage. 

 

 
Figure 8—12 Selecting the initial montage (default montage) 
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9 Views (EEG display modes) 
 
 

9.1 Views: Introduction 
 
 

Views are ways of displaying the EEG. A view determines how the channels are arranged in the 
window, for example. 

Note that the data displayed was originally digitized. Consequently, the accuracy of the display 
depends on the digitization rate. Ultimately, there are always limits to the accuracy. 

The views available to you include the standard, grid, head and map view. These views display 
data in both the time and frequency domains. In addition, the Analyzer has numerous 
specialized views for displaying particular kinds of EEGs. 

 

EEG views are used when you open an EEG data set. Multiple views of an EEG can be displayed 
simultaneously (see the description of the “Additional View” function). 

The toolbar and navigation bar are used with all views. The open views are displayed in tabs 
above the EEG. This allows you to switch easily between open view windows (see section 5.1, 
“The new user interface of the Analyzer”). 

Multiple views of an EEG can be displayed simultaneously in an existing window (see the 
description of the “Switch View” function). 

Views can be linked to each other in different ways. For example, in views based on data of the 
same type, the EEG graphs can be overlaid (see section 9.3, “Overlaying of different data 
sets”). 

In addition, you can also select montage connections of the channels in the EEG for each view 
(see chapter 8, “Montages”). 

You can make general settings for the views, such as the scaling or the area visible when the 
view or montage is first opened (see section 7.1, “Configuring preferences”). 

You can also make detailed settings for the display of each view category (see section 7.3, 
“Configuring the EEG view settings”). These settings can be saved in individual EEG nodes.  

 

View functions 
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A fundamental function of EEG views is to display EEG channels in the form of a graph. 
Generally, the views used are handled in a similar way when it comes to channel and range 
selection, for example. This applies, in particular, to the following frequently used view 
categories: 

• Standard view: The standard view corresponds to the EEG on paper. The curves or 
EEG channels are shown one after (below) another. The standard view is typically 
used for spontaneous EEG analyses. 

• Grid view: The grid view is usually used for the display of segmented data. The 
data appears in a rectangular grid. 

• Head view: The head view displays the EEG channels in topographic head 
positions. 

 

When you move the mouse pointer over the EEG graph in these views, a red cross appears at 
the nearest point on the graph, and the corresponding details of its position are displayed on 
the status bar. 

 

 

Figure 9—1 Red cross 

 

You select a channel by clicking the corresponding channel name. The selected channel is 
highlighted in blue. 

 

 

Figure 9—2 Selected channel with blue highlighting  

Interaction options 

Channel highlighting 

and selection 
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By double-clicking a channel name you can display the corresponding channel separately. If 
you double-click the channel name again, the display returns to how it was before. 

To display a selection of channels, select these channels in the desired sequence by means of 
a mouse click. If you double-click the channel name selected last, the selected channels are 
displayed separately. If you double-click the channel name again, the display returns to how it 
was before. 

You deselect a selected channel by clicking the channel name again. To prevent the second 
mouse click from being interpreted as a double-click, wait about a second before clicking for a 
second time. 

 

To select a data point or data range, proceed as follows: 

Click a channel to highlight a single point. This is a semitransparent blue band with a black 
line in the middle indicating the exact position of the point. 

 

 

Figure 9—3 Single-point highlighting 

 

Click the EEG, hold the mouse button down, and drag the mouse pointer to the left or right to 
mark a range of the EEG. This is a semi-transparent blue band.   

Selection of data 

ranges 
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Figure 9—4 Arrows for changing the size of a highlighted range 

 

To move it, click inside the highlighting, hold the mouse button down, and drag the mouse 
pointer in the desired direction. 

Alternatively, you can use your computer’s <left arrow> and <right arrow> keys to move the 
highlighting. 

 
In the case of the grid view and the head view, the highlighting is only ever displayed for one 
channel. You can move highlighting across channels to a different channel by clicking it, 
holding down the mouse button and moving the mouse pointer to the desired channel. 

 

Note that the context menu for selecting transient views appears when you click the EEG and 
release the mouse button. Click Cancel to close the context menu. (You will find detailed 
information on transient transforms in chapter 14.) 

 

 

Figure 9—5 Single-point highlighting including the context menu for transient transforms 
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You change the width of the highlighting by moving the mouse pointer over it. Two blue arrows 
appear on its edges. Grab an arrow, and drag the mouse pointer in the required direction. 

When you drag the arrows of a single-point highlighting band, it turns into a range highlighting 
band. 

To delete highlighting, items from the View Toolbox or similar items from the EEG, press your 
computer’s <Escape> key. Note that this deletes the currently active item. 

You can drag items from the View Toolbox to the EEG graph by clicking the desired tool, 
holding down the left mouse button and dragging it to a channel of the EEG. The current target 
channel is highlighted in orange in the view. You will find detailed information on working with 
the View Toolbox in section 5.1, “The new user interface of the Analyzer”. 

If you have dragged a tool onto the graph, it is connected to the graph by means of an 
interactive element. In the case of the mapping tool, for example, this is a small highlighted 
range. When this highlighting is active, it can be moved and resized in the same way as the 
semi-transparent bright blue highlighting described above. 

 

 

Figure 9—6 EEG graph with delta tool and mapping tool (including range highlighting) 

 

The context menu of the transient transforms also contains the Selected Area Settings… 
command, which allows you to make the following settings: 

 

 

Figure 9—7 Area Settings dialog box  
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You can make the following settings: 

• If you select the Mouse Sizing Allowed check box, you allow the highlighting to 
be resized using the mouse. 

• If you select the Always Draw as Range radio button, a range is highlighted. 

• If you select the Automatically switch to Single Point Mode radio button, a 
single point is highlighted. 

• In the text boxes in the lower part of the dialog box, you can change the position 
(Location, End) and length (Length) of the highlighting. Note that the times you 
specify are rounded to the nearest data point. 
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9.2 The EEG views in detail 
 
 

9.2.1 The butterfly view 
 
 

The butterfly view displays all the EEG channels overlaid over each other. The view allows you, 
for example, to estimate peaks after data averaging: In this case, the view lets you very easily 
detect the points in the EEG at which there is activity (figure 9—8). 

 

Figure 9—8 Butterfly view, averaged EEG 

 

The channel names are listed in the upper part of the view. 

If you move the mouse pointer over a channel graph, it is highlighted in orange. At the same 
time, a small box appears around the channel name at the top of the view to indicate which 
channel is currently under the mouse pointer. Boxes and orange highlighting also appear when 
you move the mouse pointer over a channel name in the list. 

If you click a channel name, the corresponding channel is deactivated or activated again. 
Alternatively, you can deactivate the channel currently highlighted by pressing the <Shift> key 
and the left mouse button. The channel name of a deactivated channel is struck through. 

Range highlighting works as described in section 9.1.   
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Figure 9—9 Butterfly view, channel selection and highlighting 

 

You will find a detailed description of the configuration options for the butterfly view in section 
7.3.2, “Category-related view settings”. 
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9.2.2 The grid view 
 
 

The grid view arranges the channels in a grid. 

 

Figure 9—10 Grid view 

 

The display of the EEG in the grid view depends on the montage selected. In the case of the 
standard montage, the channels of the data set are distributed automatically to the rows and 
columns of the grid. In user-specific montages it is possible to specify which channels are to 
appear in which grid cells or which grid cells are to remain free. 

The grid view also allows overlays to be displayed (overlaying of different channels). To do this, 
you use the mouse to drag a channel to another channel. When a red frame appears, you 
release the mouse button. You will see two overlaid channels. The moved channel continues to 
remain in its original position. You can repeat this procedure as often as you like with different 
channels. 

Note that you can get hold of the channels by clicking the channel name or a point in the 
corresponding grid cell that is sufficiently far away from the graph. The mouse pointer takes the 
form of a hand or an arrow. 

If there are one or more overlays, the Clear Overlays button is added to the view. You can use 
this button to remove the overlays again. 

You will find detailed information on the overlaying of data sets in section 9.3, “Overlaying of 
different data sets”.   



 
The grid view 9.2.2 
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Figure 9—11 Overlaying of two channels by means of drag and drop 

 

 

Figure 9—12 Overlaying of channels Fp1 and AF1 

 

You will find a detailed description of the configuration options for the grid view in section 
7.3.2, “Category-related view settings”. 

 

 



 
The head view 9.2.3 
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9.2.3 The head view 
 
 

The head view displays the channels in separate windows arranged in the shape of a head. The 
windows are positioned at the coordinate position of the associated channel. 

Channels that do not have any valid head coordinates, or have coordinates that are not visible 
on the head, are displayed along the left-hand border of the view. If you used electrode names 
on the 10/10 or 10/20 principle when recording the EEG, the program should have this 
information. However, if you used other channel names, you can use the Edit Channels 
transform to enter the correct coordinates. You will find detailed information on this in section 
12.1.6, “Edit Channels”. 

You can change the head’s direction of view in the Default View Settings dialog box. You do 
this in the Direction group box on the Maps tab (see section 7.3.2, “Category-related view 
settings”). 

If you click the channel name or a point in the window that is far enough away from the graph, 
the desired window is activated. You can move the window by holding down the mouse button. 

An active window has a total of 8 handles (small rectangles) on its borders that you can use to 
resize the window. If you hold down the <Shift> key while you resize a window, the resizing is 
also applied to the other windows when you release the mouse button. 

 

Figure 9—13 Head view  
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Figure 9—14 Changing the position of an active window 

 

If you have changed the position of a number of channels and then want to return them to their 
original positions, right-click any point in the view and choose the Reset all Channel 
Positions command from the context menu that appears. The Reset Position of Active 
Channel command returns only the active channel to its original position. 

 

 

Figure 9—15 Context menu for resetting the channel positions 

 

If you have resized the channel windows, the windows will no longer be centered exactly over 
the associated electrodes. You can also use the Reset All Channel Positions command to 
correct this. 

 
If you select one or more channels by clicking their names followed by a double-click, these 
channels are displayed in a grid. 

You can create an overlay by dragging one channel to another channel and then releasing the 
mouse button. The channel you moved becomes transparent and its frame turns red until you 
release the mouse button.   

Tip 
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Figure 9—16 Overlaying of channels Fp1 and AF3 

 

You will find a detailed description of the configuration options for the head view in section 
7.3.2, “Category-related view settings”. 
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9.2.4 The mapping view 
 
 

The mapping view creates topographic maps that display the voltage distribution on the head 
in the time or frequency domain. The maps are displayed in windows arranged next to each 
other. 

Along the lower border of the view there is a scale that applies to all maps. In addition, the 
time domain is indicated for each map. For a time domain you can display the head in different 
directions simultaneously. 

 

Figure 9—17 Mapping view 

 

In order to generate the map, the program requires information about the position of the 
electrodes. If you used electrode names on the 10/10 or 10/20 principle when recording the 
EEG, the program should have this information. However, if you used other channel names, you 
can use the Edit Channels transform to enter the correct coordinates. You will find detailed 
information on this in section 12.1.6. You will find information on the coordinate system used 
in Appendix B. 

 

You will find a detailed description of the configuration options for the mapping view in section 
7.3.2, “Category-related view settings”. 

You will find detailed information on the methods and algorithms used for mapping in section 
12.7.4, “Topographic Interpolation”. 
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9.2.5 The standard view 
 
 

The standard view offers you all the standard display options. These include the highlighting 
and selection of channels, the display of separate channels or a selection of channels, the 
selection of data ranges (single-point selection and range selection), the resizing and 
repositioning of highlighting and the use of the tools from the View Toolbox. 

You will find a more detailed description of these functions in section 9.1. 

 

Figure 9—18 Standard-View 

 

You will find a detailed description of the configuration options for the standard view in section 
7.3.2, “Category-related view settings”. 
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9.2.6 The time-frequency view 
 
 

The time-frequency view is for displaying data in which a value – typically μV – belongs to a 
point in time and frequency. This view is available in the form of standard, grid and head 
views. 

 

The time is on the x-axis, and the frequency on the y-axis. Every point is assigned a color that 
corresponds to its voltage value, for example. 

At the bottom of the view there is a color scale for displaying the voltage values, for example. 

If you select only a few channels to be displayed, line charts appear along the borders of the 
channel window. The line charts display the values along cross-sections that run parallel to the 
x- or y-axis. The chart to the right of the channel window displays volts over hertz, for example, 
while the chart under the channel window displays volts over milliseconds, for example. 

The green cross in the channel window indicates the location of the cross-section in the line 
charts. If you click a point in the window, the cross jumps to the point you click. 

If you hold the mouse button down and drag the mouse pointer across the window, the line 
charts are redrawn accordingly. 

The Scale Up  and Scale Down  buttons change the scaling of the two line charts. The 
color scale remains unaffected by this. You specify the settings for the color scale in the 
standard view settings. You will find detailed information on this in section 7.3.2, “Category-
related view settings”. 

 

Figure 9—19 Time-frequency standard view  
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The display and functions of the time-frequency head view are the same as for the head view. 

 

Figure 9—20 Time-frequency head view 

 

The display and functions of the time-frequency grid view are the same as for the grid view. 

 

Figure 9—21 Time-frequency grid view 
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9.2.7 The 3D view 
 
 

You can use the 3D map view instead of the two-dimensional map. The 3D view projects the 
map onto a head. 

The settings are the same as for the 2D map view. In addition, you can rotate the head 
displayed and select an alternative head definition file. To do this, move the mouse over the 
head, hold down the left mouse button, and move the mouse pointer. The head rotates. 

 

 

Abb. 9—22 3D view 

 

In the view settings of the 3D view, you can also select the head displayed from several head 
definitions. 

You will find a detailed description of the configuration options for the 3D view in section 7.3.2, 
“Category-related view settings”. 
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9.3 Overlaying of different data sets 
 
 

To overlay multiple complete data sets, click the  Overlay Data Set button on the toolbar. 
The Overlay dialog box appears. 

Note that this function is only accessible for data sets that have the same sampling rate and 
duration. The number of channels, on the other hand, does not necessarily have to be 
identical. The view checks the channel names and only overlays channels with the same name. 

 

 

Figure 9—23 Overlay dialog box 

 

This dialog box allows you to select one or more data sets from the entire workspace. The 
selection is made on the basis of the following four criteria: 

• Parent displays the data set from which the current data set was calculated. If 
the current data set represents the raw data EEG, this option is not accessible. 

• From Same History File displays all the data sets in the current history file. 

• With Same Name lists all the data sets in the workspace that have the same 
name as the current data set. 

• From All Data Sets lists all the data sets in the current workspace. 

If you select one or more data sets with the same length and sampling rate as the current data 
set, the channels of the selected data sets are displayed overlaid. If there are one or more 
overlays, the Clear Overlays button is added to the upper-left part of the view. You can use 
this button to remove the overlays again. 

You can also overlay data sets by dragging and dropping them. To do this, use the mouse to 
select from the History Explorer the required data set, hold down the left mouse button, and 
drag the data set to the view. Then release the left mouse button. The conditions described in 
the previous paragraph again have to be met in order to implement the overlay. 
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9.4 Additional view functions 
 
 

The Views group on the File tab contains the following functions: 

 

 

Figure 9—24 Views group on the File tab 

 

The Additional View drop-down list allows you to display additional views for the active 
history node. The newly selected view appears in an additional window. The same node is thus 
displayed in multiple view windows. 

The Client View drop-down list works in the same way as the Additional View drop-down list, 
except that, in this case, navigation of the newly selected view is linked to that of the original 
view, and navigation is only possible in the original view. In figure 9—25, the mouse pointer is 
in the newly selected butterfly view. You can see that the toolbar and navigation bar are grayed 
out (inactive). 

 

Figure 9—25 Client view  

Views group, File tab 
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To display the view context menu, right-click any point in the view. 

 

 

Figure 9—26 View context menu 

 

Das Kontextmenü enthält die folgenden Einträge: 

• Settings… displays the node-specific view settings. You will find detailed 
information on configuring the view settings in section 7.3, “Configuring the EEG 
view settings”. 

• Save as File saves the view as a file. The graphics formats EMF, BMP, PNG and 
JPEG are available to you. 

• Print opens the dialog box for printing the open view. 

• Save View Tools… saves all the view tools in the view in a file. 

• Load View Tools… loads saved view tools from a file and displays them. 

• Switch View allows you to switch between different views. Unlike the Additional 
View function, this function opens no additional windows. Instead, the new view 
replaces the currently open view. 

 

As already mentioned in section 7.3, “Configuring the EEG view settings”, a distinction is drawn 
between the view settings that apply to the view categories and the settings that apply to the 
current history node. The former are category-related view settings, while the latter are node-
specific view settings. 

There are different view categories, such as the standard view, grid view and head view. To 
display history nodes with different data types, different views are required. However, in most 
cases these have uniform design features. 

The Switch View function switches between view categories. In other words, you use this 
function to select a view category, and the view that suits the current file type is always 
displayed.  

View context menu 

Switching between 

view categories 
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The Switch View menu command opens a context menu from which you can select different 
views. These include the standard view, grid view and head view. The menu groups together 
views that display nodes with different data types in the same way – the frequency grid view 
and time grid view, for example – in the same view category. These view categories are also 
used for category-related configuration (see section 7.3.2, “Category-related view settings”). 

If you select a view category under Switch View, the program automatically determines the 
appropriate view in the category for the data type of the node. 

For example, the Switch View > Head View command in the standard view for time data (figure 
A1) displays the head view for time data in figure A2. 

 

Figure 9—27 A1 

 

Figure 9—28 A2  
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The Switch View > Head View command in the standard view for frequency data (figure B1) 
displays the head view for frequency data in figure B2. 

 

Figure 9—29 B1 

 

Figure 9—30 B2 
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View categories that do not have a view for the current data type are grayed out on the 
submenu of the Switch View context menu command. This applies, for example, to the 
butterfly view and frequency data because this view category is available exclusively for data in 
the time domain (see figure 9—31). 

 

 

Figure 9—31 The butterfly view is not available for frequency data 
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10 Automation using history templates 
 
 

As mentioned in section 5.1, you can transfer an existing processing history from one history 
file to another. You can also save the processing history in a separate file – known as the 
history template – and use this template to transfer the processing history automatically to one 
or more history files. 

 

To create a new history template, choose New from the History Template group. The 
Template Editor tab appears. This contains the Root icon. Open a history file in which you 
have already executed one or more operations (in our example odd_kont_1). 

Use the mouse to drag a data set from the history file to the root node of the history template. 
This data set and the data sets derived from it are added to the history template. However, it is 
actually the operation instructions that are transferred to the history template rather than the 
data itself. 

 

 

Figure 10—1 Template Editor with the Root icon and the command buttons in the History 

Template group  

Creating a history 

template 
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Figure 10—2 Transfer of the data by means of drag and drop 

 

 

Figure 10—3 Example of a history template 

 

The history structure of the template can be edited in the same way as that of a history file: You 
can rename or delete nodes, and when a template is open you can use the mouse to drag 
individual history nodes to history files, thus triggering the corresponding operations. 

The Copy from History File function copies all the completed nodes of a history file to the 
template without the need for the history file to be open. 

To transfer the history template to an entire set of history files, save the current template as a 
file by choosing Save. Then choose Apply to History File(s). A dialog box appears.   
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Figure 10—4 Dialog box for transferring history templates 

 

Select a history template under Select History Template. If you have not yet closed the 
window for history templates, the name of the current history template appears in this text box. 
You can also choose the Browse button to select a history template. 

 

In the Starting Position in History Files group box, you specify: 

• Whether the template is to be applied to the initial data set of the history files 
(Root (“Raw Data”) radio button)  

• Or to a subsequent data set (Choose Data Set (History Node) radio button). 

• If you select the Choose Data Set (History Node) radio button, you specify the 
name of the data set to which the template is to be transferred in the Data Set 
text box. Note that if there are several data sets with the same name in a history 
file, only the first one found is taken into account. 

 

If you select the Use Logfile check box, all the messages usually output in a dialog are written 
to a log file. All yes/no questions are automatically answered with “yes” to prevent automatic 
processing from being interrupted and the program from waiting for input. The log file is 
displayed on completion of processing.  

Select History 

Template group box 

Starting Position in 

History Files group 

box 

Message Logfile 

group box 
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At this point, you select the history files to which the history template is to be transferred. 

• Select the Primary History Files Only check box to limit the selection to primary 
history files. 

• Select the Use Whole Workspace radio button to include all the files contained 
in the workspace. If you select the Select Individual History Files radio button, 
on the other hand, you can select specific files. 

• In the Selection Filter text box, you can then specify a filter. This filters 
selectable files on the basis of name criteria. An asterisk (*) stands for one or 
more characters, and a period (.) stands for a single character. If the workspace 
contains the files “Test1H2”, “Test2G” and “Hest5”, for example, the string 
“Test*” filters out the files “Test1H” and “Test2G” (i.e. makes them available). 
The filter “.est*” accepts all three files. Once you have set the filter, click the 
Refresh button to refresh the selection of available files. 

• All the available files are listed in the Available Files text box. 

• The Selected Files text box contains all the selected files. 

• To select one or more files or remove them from the list of selected files, you 
select them and then click the Add or Remove button. The Add All and Remove 
All buttons do the same for all files. 

Click OK to apply the specified operations to the selected history files. If a history file has 
already been processed using this template, it is ignored. 

Choose History Template > History Template > Open… to open an existing history template. 
To save the history template, choose Save or Save As…. 

 

Select History File(s) 

group box 



  
Macros 11 

 
 

 

 

BrainVision Analyzer  11—- 1 - 

11 Macros 
 
 

You can use the Basic interpreter integrated in the Analyzer to create anything from simple 
automation macros to complex applications. The Basic interpreter accesses the Analyzer via 
the OLE automation interface. 

This interface provides access both to a large number of methods and properties of the 
Analyzer and to each data point in each data set (history node) of each history file. 

To create a new macro, choose New… from the Macros group on the Macros tab. 

 

 

Figure 11—1 Macros tab with command buttons 

 

The following editing window appears: 

 

 

Figure 11—2 Editing window for macros  
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The editing window contains the following two lines: 

Sub Main 

End Sub 

You insert the code of the macro between these two lines. 

 

The following small macro opens all the history files and outputs a message before it closes 
the files again: 

Sub Main 
 For Each hf In HistoryFiles 
  hf.Open 
 Next 
 MsgBox "All history files are open" 
 For Each hf In HistoryFiles 
  hf.Close 
 Next 
End Sub 
 

 

Enter the code, and then click the Start/Resume button . You will get the following 
intermediate result including the message “All history files are open”: 

 

Figure 11—3 Intermediate result of the macro example  

Example of a macro 
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Click the Save button  to save the macro and close the editing window. 

To open existing macros, choose Macros > Macros > Open…. 

Macros > Macros > Run… allows you to run an existing macro when you are not in the macro 
editing window. You can then select the macro you want to run. 

Alternatively, you can add command buttons for macros to the Ribbon. To do this, choose 
Macros > Macros > Options…. The following dialog box appears: 

 

 

Figure 11—4 Macro-Manager dialog box 

 

In the table on the left (Name of Macro Group), specify the name of the macro group. Then 
choose a macro from the drop-down menu in the table on the right (Macro) to be assigned to 
the group. Once you have done this, you will find the selected macros on the Macros tab on 
the Ribbon (figure 11—5). To delete all the assignments, click Clear All Assignments. 

 

 

Figure 11—5 Macro added to the Ribbon   
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You can then also call the macros by means of keyboard shortcuts (Alt-M, 1, 2, 3, etc.). 

You will find more information on creating macros in the document entitled Vision Analyzer 
Macro Cookbook and in the Vision Analyzer OLE Automation Reference Manual. You can also 
get information on the integrated version of Basic by choosing Sax Basic Help from the Help 
tab on the toolbar of the editing window. 

 

After changes are made to the OLE components in the Analyzer macro environment, it may be 
necessary to run the Analyzer once as the administrator so that the system registry can be 
updated. To do this in Microsoft® Vista, you have to right-click the Analyzer’s program icon 
and choose Run as administrator from the context menu. 
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12 Transforms 
 
 

There are essentially three types of transform: primary, secondary and transient transforms. 

Primary transforms create a history node in a primary history file. Secondary transforms – of 
which there are only two: the Grand Average transform and the PCA transform – generate 
secondary history files. Because they only create nodes that cannot be appended to other 
history nodes, secondary transforms cannot be added to history templates. Transient 
transforms are for data visualization; their results are only available temporarily. 

Chapter 12 describes all the primary and secondary transforms implemented in the Analyzer. 
The transient transforms are described in chapter 14. 

You will find the primary and secondary transforms on the Transformations tab. 

The structure of this chapter is based on that of the Ribbon: All the transforms in the groups on 
the Transformations tab are described one after the other (going from left to right). Any drop-
down lists in a group do not get their own section. 

 

Figure 12—1 Transform groups 
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12.1 Transforms in the Dataset Preprocessing group 
 
 

12.1.1 New Reference 
 
 

The New Reference transform uses the average of selected channels as a new reference. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Channel Preprocessing > New Reference. 

 

 

Figure 12—2 New Reference dialog, first page 

 

On the first page of this dialog, you select from the Available Channels list box the channels 
you want to be included in the calculation of the reference. These are transferred to the 
Selected Channels list box. 

To select one or more channels or remove them from the list of selected channels, select them 
and then click the Select or Remove button. 

If you select the Include Implicit Reference into Calculation of the New Reference check 
box, the original reference channel is included in the calculation.  

Summary 

Procedure 



 
New Reference 12.1.1 
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On the second page of the dialog, you select the channels to be referenced (those in the 
Selected Channels list box). In addition, by selecting the Keep Remaining Channels check 
box you can specify that the non-referenced channels are retained. 

 

 

Figure 12—3 New Reference dialog, second page 

 
On the third page of the dialog, you specify the name of the new reference channel in the 
Name of New Reference Channel text box (e.g. “Ears” for A1/A2 reference or “Avg” for 
averaged reference). 

 

 

Figure 12—4 New Reference dialog, third page  
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If you select the Reuse Old Reference Channel (Negated New Reference) check box, the old 
reference channel is reused as a normal data channel. An example of this would be a CZ 
reference converted to an A1/A2 reference. In this case, the CZ channel can be used for further 
calculations. 

When you click Finish, a new view appears, containing the changed channels. 
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12.1.2 Pooling 
 
 

The Pooling transform allows you to create new channels by pooling existing channels. The 
new channels are calculated for each point in time from the average values of the selected 
channels at this point in time. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Channel Preprocessing > Pooling. 

 

Figure 12—5 Pooling dialog box 

 

You can make the following settings: 

• If you select the Keep Old Channels check box, the old channels are also 
included in the new data set; that makes the new channels additional channels. 
If you do not select the check box, the resulting data set only contains the new 
channels. 

• In the Number of Pools text box, you enter the desired number of new channels. 

• The Refresh button updates the channel matrix. 

When you click a cell in the table, its color changes between green and white. Green channels 
are included in the calculation of the new channel; white channels are not included in the 
pooling for the new channel. 

 

Summary 

Procedure 
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12.1.3 RMS/GFP (Root Mean Square/Global Field Power) 
 
 

The RMS/GFP transform allows you to determine the overall activity of certain channels. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Data Preprocessing > RMS/GFP. 

 

 

Figure 12—6 RMS/GFP dialog box 

 

You can select the channels for which you want to carry out the calculation (Enabled 
Channels). These channels and the new RMS channel then appear in the new data set. 

You can choose between two methods of calculation: 

• RMS – Root Mean Square (referenced): For each point in time, the root is 
calculated from the average of the squares of the individual values. The result is 
contained in an additional channel with the name RMS. 

• GFP – Global Field Power (reference free): In addition, before the values are 
squared, the average of all channels at a fixed time is subtracted (average 
reference). The result is contained in an additional channel with the name GFP. 

 

Summary 

Procedure 
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12.1.4 CSD (Current Source Density) interpolation 
 
 

The CSD (Current Source Density) transform replaces the voltage values at electrodes that have 
valid head coordinates with the current source density at these points. Their unit is μV/m². The 
curves created in this way no longer have reference electrodes. The curves can be further 
processed by means of other transforms. 

The current source density is calculated by applying the spherical Laplace operator to the 
voltage distribution on the surface of the head at a fixed point in time. Because the voltage 
distribution is only known at the electrodes, the spherical spline interpolation method is used 
to calculate the entire voltage distribution. You will find a detailed mathematical description of 
this method in [Per90]. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Data Preprocessing > CSD Interpolation. 

 

 

Figure 12—7 Dialog CSD 

 

The following three parameters are required in order to calculate the spherical splines: 

• The order of the splines (Order of Splines text box), labeled “m” in the above 
specialist article 

• The maximum degree of the Legendre polynomial (Maximum Degree of 
Legendre Polynomials) to be included in the calculation 

• The Lambda approximation parameter (Default Lambda)  

Summary 

Procedure 
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Depending on the values you enter for the order, the interpolation curve displayed will be 
smoother or wavier: the higher the spline order, the smoother the curve. Basically, the higher 
the electrode density is, the lower should be the value you specify for the order. Because the 
calculation of the spherical splines involves an infinite series of polynomials, so this series has 
to be discontinued at a certain degree. The following rule applies: the higher the spline order, 
the lower the degree of the polynomial at which the calculation is discontinued. 

The Lambda approximation parameter determines the accuracy with which the spherical 
splines are approximated to the data to be interpolated. A value that is either too high or too 
low will, for different mathematical reasons, result in an inaccurate representation. Unless you 
are using unusual methods that require a different value, you should use the default value of 
“1e-5”. 

 
Regardless of the above rules, you should not accept the results of the transform without 
checking them. In the CSD method, different parameters can lead to satisfactory or 
unsatisfactory results for different data sets as a result of approximations and rounding 
inaccuracies. 

We therefore advise you to use the transform as follows: 

 

 

Figure 12—8 View Settings dialog box for the map view 

 

• Before the CSD calculation is carried out, check the parameters of the spherical 
splines using the map view of the current data set. To do this, create a map view 
for the data set, select the Interpolation by Spherical Splines radio button, and 
enter the values you want to use for the CSD calculation in the Order of Splines, 
Max. Degree of Legendre Polynomials and Lambda text boxes. (You will find 
more information on the settings for the map view in section 9.2.4, “The map 
view”, and section 7.3.2, “Category-related view settings”.) 
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• Check whether the spherical splines approximate the voltage distribution on the 
head surface. You could do this by carrying out a comparison with interpolation 
by triangulation (Triangulation and Linear Interpolation). If the splines do not 
approximate the voltage distribution, change the parameters until they do. 

• Carry out the CSD calculation with these parameters, and then use the map view 
to make sure the result is correct. 

 

 

[Per90] F. Perrin et al., Spherical splines for scalp potential and current density mapping. 
Electroencephalography and clinical Neurophysiology, 72 (1990), 184-187, together with the 
correction in Electroencephalography and clinical Neurophysiology, 76 (1990), 565. 

 

References 
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12.1.5 Rectify 
 
 

The Rectify transform rectifies EEG data. In other words, positive values remain the same, while 
negative values are converted to positive. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Data Preprocessing > Rectify. 

 

 

Figure 12—9 Rectify dialog box 

 

You can make the following settings: 

• You can select the channels to be rectified (Enabled Channels). 

• If you select the Keep Remaining Channels check box, the remaining channels 
are retained. If you clear the check box, the remaining channels are removed from 
the data set. 

 

Summary 

Procedure 
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12.1.6 Edit Channels 
 
 

The Edit Channels transform allows you to edit EEG channel information. You can: 

• Hide channels 

• Change channel and reference channel names 

• Change position specifications 

• Change the unit of measurement for a channel 

• Change user-defined channel properties 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Edit Channels. 

 

Figure 12—10 Dialog box for editing channel information  

Summary 

Procedure 
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The table contains the following cells for each channel: 

• # (channel number): The channel number is not editable. 

• Orig. Label (original name of the channel): This is not editable. 

• Enabled (displayed/hidden): To hide a channel, clear its check box. 

• Chn (+) (channel name): You can edit this as required. 

• Chn (-) (reference channel name): You can also edit this as required. Changing 
the name does not change the referencing. The reference channel name is 
provided for information purposes only. 

• Radius, Theta, Phi (position specifications): The Radius cell must always contain 
either a positive number or 0, the Theta cell a value in the range from -180 to 180 
and the Phi cell a value in the range from -360 to 360. See also Appendix B, 
“Electrode coordinate system”. 

• Data Unit: The default unit is μV, which you can change by choosing a unit from 
the drop-drown list. 

• Color: If you click a cell, a color selection dialog box appears, in which you can 
assign the channel a basic or custom color. 

• User Properties (user-defined channel properties): If you click the associated 
button, the following dialog box appears: 

 

Figure 12—11 User Properties tab of the Edit Channels dialog box 

 
In the Property Name cell, enter the name of the property. You can make any 
entry here. The Value cell contains the associated value. This value is assigned a 
programming data type that you choose from the drop-down list in the Datatype 
column. 

The Show Original User Properties and Show Changed User Properties radio 
buttons allow you to specify whether the original user properties or the user 
properties you have edited are to be displayed.  
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You can delete existing user properties by selecting the row in the grid in the view 
of the changed user properties and pressing the <Delete> key to delete it. The row 
turns red, and the data type NULL appears in the Datatype column. Alternatively, 
you can specify the data type by choosing NULL from the drop-down list. To undo 
this deletion, you can set one of the other data types for the row at any time. 

If you have made changes in a cell, this is indicated by a pencil in the left-hand border of the 
table. As soon as you exit the cell, your entry is validated. If validation is unsuccessful, an error 
message appears. 

The function and label of the Select All/Deselect All button change when it is clicked. You can 
use it to select or deselect all channels. 

To invert the channel selection you have made, click the Invert Selection button. 

The Reset Position button resets the channel positions to the values they had when the dialog 
box was opened. 

You will also find the Default Position button on the bottom of the dialog box. Once you 
confirm that you want to proceed, this button sets all the electrode coordinates to the default 
positions, depending on the channel names. You will find more information on the default 
positions for electrodes in section 7.1. All unrecognized channels are set to the position 0,0,0 
(invalid). 
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12.1.7 Level Trigger 
 
 

The Level Trigger transform allows you to set threshold markers on one or more channels if 
voltage limits are violated. These markers can be used as a basis for segmentation. 

One possible application of the transform would be for muscle activities to be used as a 
reference for averaging. 

Another application would be for when an analog channel is used as a storage location for 
stimuli in recording systems that do not have digital inputs. Here, different stimuli can be 
coded as different voltage levels. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Level Trigger. 

 

 

Figure 12—12 Level Trigger dialog box  

Summary 

Procedure 
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You can make the following settings: 

You can specify the following in the table: 

• In the Name column, you specify a name for the threshold to be searched for. 

• In the Threshold column, you specify the threshold in μV. 

• In the Direction column, you choose from the drop-down list the direction of the 
voltage characteristic that sets the marker when the threshold is reached. 
Positive means that the marker is set when the voltage is rising and the threshold 
is reached. Negative sets the marker when the voltage is falling and the threshold 
is reached. 

• In the Channel column, you choose from the drop-down list the channel on which 
the threshold is to be searched for. 

• In the Reset Value column, you specify the value in μV at which the trigger is to 
be reset. This value is usually identical to the threshold, but you can set another 
value for certain purposes. If the direction is positive, the value obtained must be 
below this one before a new trigger of this kind is found. If the direction is 
negative, the value obtained must be above this one. 

As soon as you make an entry in a field, a new row is added to the table. To delete a row, you 
select it by clicking its left-hand border and then press the <Delete> key on your keyboard. Note 
that you must not be in edit mode when you do this. 

In the Time Tolerance [ms] text box, you can specify an interval within which no distinction is 
drawn between triggers of the same direction on the same channel. If several thresholds are 
exceeded within this interval, only the maximum threshold is detected and only one marker is 
set. The same applies analogously when values fall below several thresholds within the 
tolerance. You should adjust the size of the interval to the steepness of the edges of the trigger 
channels. 

If you select the Set Marker on Trigger Channel check box, the markers are assigned to the 
channel and displayed. If you do not select the check box, the markers are interpreted as 
global markers and set independently of the channels. 

You can also specify the point at which markers are to be set in relation to the threshold: 

• Set Marker at Threshold sets a marker at the point at which the threshold is 
exceeded. 

• Set Marker at Peak sets a marker at the maximum or minimum value of the 
channel between the time at which the threshold is exceeded and the time of the 
reset. 

• Set Marker at Reset sets a marker at the point at which the trigger is reset. 
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12.1.8 Linear Derivation 
 
 

The Linear Derivation transform allows you to create new channels from linear combinations of 
existing channels. The new channels are calculated from coefficients that are assigned to 
existing channels based on the following formula: 

New channel = coeff1 * channel1 + coeff2 * channel2 + ...  

You can enter these coefficients in a matrix and also save and/or load them. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Linear Derivation. 

 

 

Figure 12—13 Linear Derivation dialog box 

 

You can make the following settings: 

• If you select the Keep Old Channels check box, the old channels are included in 
the new data set; that makes the new channels additional channels. If you do not 
select the check box, the new data set only contains the new channels. 

• If you select the New Channels on Top check box, the new channels are listed 
first. 

• In the Number of New Channels text box, you specify the number of new 
channels. The Refresh button updates the coefficient matrix or the number of 
rows in the table in accordance with the value entered in the Number of New 
Channels text box. 

  

Summary 

Procedure 
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• The Load from File... button allows you to load a coefficient matrix from a text 
file. 

• Click the Save to File… button to save a coefficient matrix you have entered. 

If you want to read in a matrix text file you have generated, you must ensure it has the following 
structure: 

 Channel1   Channel2   Channel3 ... 
New1 Coeff.     Coeff.   Coeff. 
New2  Coeff.     Coeff.   Coeff. 
 

The decimal points of the coefficients must be points rather than commas. 
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12.1.9 Formula Evaluator 
 
 

The Formula Evaluator transform allows you to calculate new channels as functions of existing 
channels. A wide range of mathematical options are available to you for this. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Formula Evaluator. 

 

Figure 12—14 Formula Evaluator dialog box 

 

The formulas are entered in a table. 

• In the column on the left (Name), you enter the name of the new channel that 
contains the data for the calculation. 

• In the middle column (Formula), you enter the formula used to calculate the data. 
No distinction is drawn between uppercase and lowercase. 

• In the column on the right (Unit), you enter the unit for the new channel. 

The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table and 
delete them again either individually or all together. 

The Save to File... button allows you to save formulas to ASCII files, while the Load from File… 
button lets you add ASCII files containing formulas to the table.  

Summary 

Procedure 
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If you want to create the ASCII files using an editor or another program, ensure that each line in 
the file takes the format “name = formula”. 

If you select the Keep Old Channels check box, you can accept unchanged all the channels 
from the previous data set that have not been redefined. 

The New Channels On Top check box allows you to specify whether new channels are added 
at the beginning or end of the table. This setting is only relevant if you have selected the Keep 
Old Channels check box. 

 
The following can be used and combined in the formulas: 

• The operators +, –, *, and / plus parentheses. Mathematical rules of precedence 
are observed. 

• Channel names. These are interpreted point by point. 

• The constants e, pi and i (imaginary unit) as well as numeric entries. 

• The mathematical functions sqrt (square root), abs, ln (natural logarithm), log 
(logarithm to base 10), sin, cos, tan, atan, sinh, cosh, tanh, real (real part), imag 
(imaginary part), arg (argument of a complex number). 

• The shift function 

 
The Formula Evaluator transform processes both real and complex data. Note that the format of 
the output data must be identical to the format of the input data. Real numbers are 
automatically converted to complex numbers, if necessary. The mathematical functions are 
currently available for real arguments only. 

Numeric constants are interpreted as a fixed number across the entire time or frequency 
domain. Channel names are interpreted point by point. The shift function can be applied to 
channel names. It takes the form “shift(channel, shift index)”. 

The shift index can be positive or negative. The function is regarded as a left shift. That means, 
for example, that shift(Fp1, 1) shifts Fp1 in such a way that the data point that has the index 2 
becomes the data point with the index 1. In the same way, shift(Fp1, -2) shifts Fp1 so that the 
data point with the index 1 becomes the data point with the index 3. 

 

Most of the functions of existing transforms can be calculated using the Formula Evaluator: 

• Linear derivation can be calculated using a formula of the following type: 

channel = a*channel 1 + b*channel 2 + ...  

• RMS (Root Mean Square) of Fp1, Fp2 and Fz can be calculated using the following 
formula: 

RMS = sqrt((Fp1*Fp1 + Fp2*Fp2 + Fz*Fz) / 3) 

  

Examples 



 
Formula Evaluator 12.1.9 
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Other measures can also be defined here in a similar way: 

• Rectify can be defined by means of: 

channel = abs(channel) 

It is also possible to use the shift function to implement simple filters such as sliding averages: 

• Fp1 = (shift(Fp1, -1) + Fp1 + shift(Fp1, 1)) / 3 

or 

• Fp1 = shift(Fp1, -1) * 0.25 + Fp1 * 0.5 + shift(Fp1, 1) * 0.25 

If you use numeric channel names, enclose them in quotes in the formula. For example: 

• 1 = (shift(“1”, -1) + "1" + shift(“1”, 1)) / 3. 

 



  
Change Sampling Rate 12.1.10 
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12.1.10 Change Sampling Rate 
 
 

This transform allows you to change the sampling rate of a data set. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Dataset 
Preprocessing > Change Sampling Rate. 

 

 

Figure 12—15 Change Sampling Rate dialog box 

 

The dialog box displays the current sampling rate (Current Rate [Hz]). In the New Rate [Hz] 
text box, you enter a new rate. 

You can also specify whether data conversion is to be carried out by means of cubic spline 
interpolation (by selecting Use Spline Interpolation) or sinc interpolation (by selecting Use 
Sinc Interpolation). 

 

The data is converted by means of cubic spline interpolation (third-degree polynomial). Note 
that in cubic spline interpolation (third-degree polynomial) the length of the EEG is generally 
reduced by a number of milliseconds because the polynomial cannot be calculated right up to 
the limits of the original data set. You should therefore carry out the conversion in the raw EEG. 

 

Summary 

Procedure 

Additional 

information 
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12.2 Transforms in the Artifact Rejection/Reduction group 
 
 

12.2.1 Complex Demodulation 
 
 

The Complex Demodulation transform works on the principle of complex demodulation. The 
EEG signal is continuously transformed by means of mathematical methods in such a way that 
the resulting signal consists only of frequencies that lie in the defined range. 

Unlike the Fast Fourier transform, only a specific frequency band can be extracted. The 
advantage of this transform is that it also works at high speed on non-segmented EEGs and 
that the output of each channel is also a continuous channel. 

The transform should not be confused with bandpass filtering. The resulting signal is not the 
filtered input signal; it describes the power or phase of the selected frequency range at each 
point in time. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Artifact 
Rejection/Reduction > Data Filtering > Complex Demodulation. 

 

 

Figure 12—16 Frequency Extraction dialog box 

 

You can make the following settings: 

• Under Output, you specify whether the power (Power) or phase (Phase) is to be 
output. 

• Under Frequency Range, you specify the beginning (Begin [Hz]) and end (End 
[Hz]) of the frequency band to be extracted. 

  

Summary 

Procedure 



 
Complex Demodulation 12.2.1 
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If you specify that the power is to be output, the average power in the specified frequency band 
is calculated for each data point. 

If you specify that the phase is to be output, the phase of the signal in the specified frequency 
band is calculated. This number is only unambiguous for multiples of 2π. When different 
intervals are selected, the output values can therefore differ by multiples of this value. On the 
basis of the phase, you can obtain the dominant frequency in the calculated frequency range. 
A rising phase indicates that the dominant frequency lies under the middle of the selected 
interval, while a falling phase indicates that it lies above the middle of the interval. 

 



  
IIR Filters 12.2.2 
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12.2.2 IIR Filters 
 
 

The IIR Filters transform allows you to filter the EEG data by means of three different types of 
filter: 

• High-pass filtering with a selectable cutoff frequency or time constant 

• Low-pass filtering with a selectable cutoff frequency 

• Band-rejection filtering for 50 Hz or 60 Hz (notch filter) to eliminate interference 
from the electricity network. The notch filter has a bandwidth of 5 Hz, which is 
symmetrical around the set notch frequency (i.e. 50 Hz +/- 2.5 Hz or 60 Hz +/- 2.5 
Hz). The edge rise is always 24 dB/octave. 

The cutoff frequency or time constant specifies the frequency at which the signal is 3 dB lower 
than the input signal (i.e. the input signal is reduced by approx. 70%). The filters are 
implemented as phase shift-free Butterworth filters. It is also possible to choose the slope of 
the filter for high- and low-pass filters. It can be 12 dB/octave, 24 dB/octave or 48 dB/octave. 

 

We recommend that you use the filter before segmentation in order to minimize as far as 
possible the effect of discontinuities on the filter and transient phenomena. 

 

To display the dialog box for the transform, you choose Transformations > Artifact 
Rejection/Reduction > Data Filtering > IIR Filters. 

 

Figure 12—17 Filters dialog box  
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IIR Filters 12.2.2 
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You can make the following settings in the Low Cutoff (for high-pass filtering) and High Cutoff 
(for low-pass filtering) group boxes: 

• The Enable check box allows you to switch the associated filter on/off. 

• In the Frequency [Hz] text box, you specify the cutoff frequency of the associated 
filter. 

• For the high-pass filter, you can specify the time constant in the Time Constant 
[s] text box instead of the cutoff frequency. 

• The Slope [dB/oct] drop-down list allows you to specify the slope of the filter. 

 

In the Notch group box (for band-rejection filtering), you can make the following settings: 

• The Enable check box allows you to switch the filter on/off. 

• The Frequency [Hz] drop-down list allows you to specify the stop (rejection) 
frequency. You can choose between 50 and 60 Hertz. 

 
If you select the Enable Individual Channel Filters check box, you can make separate filter 
settings for each channel in the table. 

 
If you click the Fill Table with Values From Above button, the values entered in the upper part 
of the dialog box are applied to the table. You can then change the channels to be filtered 
based on different criteria. 

 

Low Cutoff and High 

Cutoff group boxes 

Notch group box 
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12.2.3 Band-Rejection Filters 
 
 

Band-rejection filters are used to filter interference signals of a constant frequency. 

Interference signals like this can come from the electricity network or from poorly shielded 
monitors. Whereas these sources of interference can be eliminated by improved shielding, 
other sources of interference when EEGs are recorded are unavoidable. These include 
interference signals that come from magnetic-field changes when an EEG is recorded during an 
MRI scan in an MRI scanner. 

Such interference signals have typical frequencies, and consequently they can be largely 
eliminated by means of a combination of low-pass and band-rejection filters. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box required for the transform, you choose Transformations > Artifact 
Rejection/Reduction > Data Filtering > Band Rejection. 

 

 

Figure 12—18 Dialog for band-rejection filters, first page 

 

In the table, you can specify as many band-rejection filters as you like to be applied to the EEG. 
The filter is determined by frequency (in the Frequency column), bandwidth (in the Bandwidth 
column) and order (in the Order column).  

Summary 

Procedure 



 
Band-Rejection Filters 12.2.3 
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The signal is reduced to half of its amplitude at the limiting frequencies (frequency ± 
bandwidth / 2). The order determines the slope of the filter. You can choose between an order 
of 2 or 4 from a drop-down list. A higher order results in stronger filtering in the interval 
between the two limiting frequencies. 

The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table and 
delete them again either individually or all together. 

When you have finished making your entries, you click Next to go to the second page of the 
dialog. 

 

 

Figure 12—19 Dialog for band-rejection filters, second page 

 

On the second page of the dialog, you select the channels to which the filters are to be applied 
(those in the Enabled Channels list box). In this way, you can exclude from filtering those 
channels, such as control signal channels, that are not affected by interference signals (in the 
Disabled Channels list box). 

You can use this transform several times to apply different band-rejection filters to different 
channels. 

 



  
Artifact Rejection 12.2.4 
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12.2.4 Artifact Rejection 
 
 

The Artifact Rejection transform allows you to search the data set for physical artifacts 
following segmentation and to remove or mark segments with artifacts. 

To mark artifacts before segmentation, you use the Data Inspector transform. You will find 
detailed information on this  in section 12.2.5,”Data Inspector”. 

 

The Artifact Rejection transform is typically used after: 

• Segmentation 

 

To display the dialog box for the transform, you choose Transformations > Artifact 
Rejection/Reduction > Artifact Rejection. 

 

On the Inspection Method tab, you can choose between the following three segment selection 
methods: 

• Manual (Manual Segment Selection radio button) 

• Semiautomatic (Semiautomatic Segment Selection radio button) 

• Automatic (Automatic Segment Selection radio button) 

 

 

Figure 12—20 Inspection Method tab in the Artifact Rejection dialog box  
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Artifact Rejection 12.2.4 
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If you select the Individual Channel Mode check box, you activate individual channel mode, 
which allows bad intervals to be taken into account channel by channel. The Average transform 
can then be used in a subsequent step to search for as many segments as possible separately 
for each channel. 

You will find detailed information on the Average transform in section 12.4.6. 

If you select the Mark bad segments instead of removing them check box, segments with 
artifacts are merely marked rather than removed. If you do not select the check box, the new 
data set only contains the remaining segments. 

 

The three segment selection methods are explained in detail below: 

 

If you select the Manual Segment Selection radio button and click the OK button, a 
temporary semiautomatic view dialog box appears on the right. 

You can use the mouse to mark intervals found in the various channels as artifacts. 

To delete a marker, press the <Shift> key and click the marker. If you have not activated 
individual channel mode, you can use this temporary semiautomatic view dialog box to remove 
individual segments containing artifacts. 

 

 

Figure 12—21 Artifact rejection with manual segment selection after the “Mark bad 

segments...” check box is cleared  

Manual segment 
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Artifact Rejection 12.2.4 
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The temporary semiautomatic view dialog box contains the following information and 
functions: 

• The current segment number is displayed (Segment 1 of 544 in figure 12—21). 

• The group below this contains one of the following headings: Remove or Keep. 

• The heading indicates whether the current segment is to be removed or kept. 

• The Keep button removes the current segment from the list of channels to be 
removed and switches to the next segment. 

• The Remove button adds the current segment to the list of segments to be 
removed and switches to the next segment. 

• The buttons  and  take you to the previous and next segment, 
respectively. 

• The Goto Segment… button allows you to select a segment you want to go to. 

• If you select the Step Only to Kept Segments check box, when you click the 
button  you are taken to the nearest previous segment that is not listed in 
the table of segments to be removed. A similar principle applies to subsequent 
segments when you click the button . 

• If you select the Step Only to Removed Segments check box, when you click the 
button  you are taken to the nearest previous segment that is listed in the 
table of segments to be removed. A similar principle applies to subsequent 
segments when you click the button . 

• The Change Criteria button allows you to change parameters and channels 
subsequently in semiautomatic mode. 

• The table below this contains all the artifacts to be removed, together with the 
channel and segment affected in each case. If you double-click an entry, the 
program jumps directly to the corresponding artifact. 

The Undo and Redo buttons allow you to undo and redo changes, respectively. 

If you want to interrupt what you are doing and resume later, click the Suspend button. The 
Artifact Rejection transform is highlighted in red in the list of history nodes, and all the 
processing steps carried out continue to apply. 

You click the OK button to conclude your entries.  



 
Artifact Rejection 12.2.4 
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If you have selected the Mark bad segments instead of removing them check box, the 
temporary semiautomatic view dialog box marks any bad segments. 

In addition, you can use the mouse to mark intervals found in the various channels as artifacts. 

To delete a marker, press the <Shift> key and click the marker. 

 

 

Figure 12—22 Artifact rejection with manual segment selection after the “Mark bad 

segments...” check box is selected 

 
The temporary semiautomatic view dialog box contains the following information and 
functions: 

• The current segment number is displayed (Segment 1 of 544 in figure 12—22). 

• The group below this contains one of the following headings: Segment with 
Artifacts or No Artifact. 

• This heading indicates whether an artifact has been marked at any point in the 
current segment. 

• The Mark all Channels button highlights in color all channels, indicating that 
they contain artifacts, and switches to the next segment. The Clear all Channels 
button clears all “bad channel” markers for the current segment and switches to 
the next segment. 

• The buttons  and  take you to the next and previous segment, 
respectively. 

• The Goto Segment… button allows you to select a segment you want to go to.   

Manual segment 

selection with 

individual channel 

mode 
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• If you select the Step Only to Clean Segments check box, when you click the 
button  you are taken to the nearest previous segment that does not contain 
an artifact and is therefore not listed in the table of segments to be removed. A 
similar principle applies to subsequent segments when you click the button . 

• If you select the Step Only to Segments with Artifacts check box, when you 
click the button  you are taken to the nearest previous segment that contains 
artifacts and is therefore listed in the table of segments to be removed. A similar 
principle applies to subsequent segments when you click the button . 

• The Change Criteria button allows you to change parameters and channels 
subsequently in semiautomatic mode. 

• The table below this contains all the marked artifacts, together with the channel 
and segment affected in each case. If you double-click an entry, the program 
jumps directly to the corresponding artifact. 

The Undo and Redo buttons allow you to undo and redo changes, respectively. If you want to 
interrupt what you are doing and resume later, click the Suspend button. The Artifact Rejection 
transform is highlighted in red in the list of history nodes, and all the processing steps carried 
out continue to apply. You click the OK button to conclude your entries. 

 

 

Select the Semiautomatic Segment Selection radio button, and then make the settings you 
require on the Channels and Criteria tabs. 

 

On the Channels tab, you can select the channels to be searched for artifacts (Enabled 
Channels) and exclude channels from the search for artifacts (Disabled Channels). 

 

 

Figure 12—23 Channels tab in the Artifact Rejection dialog box  
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On the Criteria tab, you specify the criteria for marking channels (individual channel mode 
enabled) or for excluding segments (individual channel mode disabled). 

To do this, you make settings on the following tabs: Gradient, Max-Min, Amplitude and Low 
Activity. Each tab contains the settings for an artifact criterion. 

 

When the gradient criterion is applied, the absolute difference between two neighboring 
sampling points must not exceed a specific value. 

On the Gradient tab, you can make the following settings: 

• If you select the Check Gradient check box, the gradient criterion is applied. 

• In the Maximal allowed voltage step text box, you specify the maximum 
permissible difference between two data points. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact. 

 

 

Figure 12—24 Gradient tab on the Criteria tab in the Artifact Rejection dialog box 

 

When the max-min criterion is applied, the difference between the maximum and minimum in a 
segment must not exceed a specific value. 

On the Max-Min tab, you can make the following settings: 

• If you select the Check maximum difference of values in the segment check 
box, the max-min criterion is applied. 

• In the Maximal Allowed Absolute Difference text box, you specify the maximum 
difference in voltage. 

• In the Interval Length text box, you specify the length of the interval in ms or the 
period within which the difference in voltage must not exceed the specified value. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact.   

Criteria tab 

Gradient criterion 

Max-min criterion 
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Figure 12—25 Max-Min tab on the Criteria tab in the Artifact Rejection dialog box 

 

When the amplitude criterion is applied, the amplitude must not violate specified maximum 
and minimum values. 

On the Amplitude tab, you can make the following settings: 

• If you select the Check maximal and minimal amplitude check box, the 
amplitude criterion is applied. 

• In the Minimal allowed amplitude text box, you specify the minimum 
permissible value for the voltage. 

• In the Maximal allowed amplitude text box, you specify the maximum 
permissible value for the voltage. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact. 

 

 

Figure 12—26 Amplitude tab on the Criteria tab in the Artifact Rejection dialog box  
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When the low activity criterion is applied, the difference between the maximum and minimum 
in an interval of a selectable length must not exceed a specific value. 

On the Low Activity tab, you can make the following settings: 

• If you select the Check low activity in intervals check box, the criterion for low 
activity is applied. 

• In the Lowest allowed activity (Max-Min) text box, you specify the minimum 
level of activity. 

• In the Interval Length text box, you specify the length of the interval within which 
the specified minimum level of activity cannot be violated. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact. 

 

 

Figure 12—27 Low Activity tab on the Criteria tab in the Artifact Rejection dialog box 

 

You can combine the different criteria. As an aid to clarity, the title of each tab indicates 

whether the criterion is currently applied.  (parentheses with a cross) indicate that the 

criterion is currently applied.  (parentheses without a cross) indicate that the criterion is 
not currently applied. 

The Test Criteria button allows you to test the criteria. 

Once you have completed all your settings, click the OK button on one of the tabs. A temporary 
dialog box appears on the right of the window. This temporary dialog box contains a table of 
the marked artifacts. You can adjust the results of your settings subsequently in the same way 
as for manual segment selection.   

Low activity criterion 
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Figure 12—28 Artifact rejection, semiautomatic segment selection, temporary dialog box 

 

 

In automatic segment selection you make all your settings in the same way as for 
semiautomatic segment selection. The only difference is that you are not able to make 
corrections interactively as you can in the semiautomatic view. 

 

Automatic segment 

selection 
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12.2.5 Data Inspector 
 
 

The Data Inspector transform allows you to check the raw EEG data set for physical artifacts. 
The inspection can be carried out manually, semiautomatically or automatically. In a 
semiautomatic or automatic inspection, you can specify criteria for the artifacts and ranges 
before and after the artifact that are to be marked as bad. In a manual or semiautomatic 
inspection, you can change or delete the intervals subsequently. You can also add new 
intervals. 

To remove artifacts after segmentation, you use the Artifact Rejection transform. You will find 
detailed information on this in section 12.2.4. 

 

No previous processing steps are required before the transform is used. To display the dialog 
box for the transform, you choose Transformations > Artifact Rejection/Reduction > Data 
Inspector. 

 

On the Inspection Method tab, you can choose between the following three inspection 
methods: 

• Manual (Manual Inspection radio button) 

• Semiautomatic (Semiautomatic Inspection radio button) 

• Automatic (Automatic Inspection radio button) 

 

 

Figure 12—29 Inspection Method tab in the Raw Data Inspection dialog box  
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If you select the Individual Channel Mode check box, you activate individual channel mode, 
which allows you to identify the marked channels as bad individually even after completion of 
the inspection. The Average transform can then be used in a subsequent step to search for as 
many segments as possible separately for each channel. If you do not select the check box, on 
completion of the inspection the entire interval in which one or more channels has been 
marked is declared as a bad interval. 

You will find detailed information on the Average transform in section 12.4.6. 

The three inspection methods are explained in detail below: 

 

 

If you select the Manual Inspection radio button and click the OK button, a temporary 
semiautomatic view dialog box appears on the right. 

You can use the mouse to mark intervals found in the various channels as artifacts. 

To delete a marker, press the <Shift>key and click the marker.  

 

 

Figure 12—30 RDI, manual inspection, temporary semiautomatic view dialog box 
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The temporary semiautomatic view dialog box contains the following information and 
functions: 

• The minimum interval length set during manual artifact detection is displayed 
(Default Interval [s]). 

• The Show Statistics button displays the Artifact Statistics dialog box, which lists 
the artifacts by type and channel. 

• The Go to Next Artifact >> and << Go to Previous Artifact buttons take you to the 
next and previous artifacts, respectively. 

• The Change Criteria button allows you to change parameters and channels 
subsequently in semiautomatic mode. 

• The table below this contains all the artifacts found, together with their channel 
and position. If you double-click an entry, the program jumps directly to the 
corresponding artifact. 

The Undo and Redo buttons allow you to undo and redo changes, respectively. If you want to 
interrupt what you are doing and resume later, click the Suspend button. The Artifact Rejection 
transform is highlighted in red in the list of history nodes, and all the processing steps carried 
out continue to apply. You click the OK button to conclude your entries. 

 

 

Select the Semiautomatic Inspection radio button, and then make the settings you require on 
the Channels and Criteria tabs. 

 

On the Channels tab, you can select the channels to be included in the search for artifacts 
(Enabled Channels) and exclude channels from the search (Disabled Channels). 

 

 

Figure 12—31 Channels tab in the Raw Data Inspection dialog box  
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On the Criteria tab, you specify the criteria for marking channels (individual channel mode 
enabled) or excluding segments (individual channel mode disabled). 

To do this, you make settings on the following tabs: Gradient, Max-Min, Amplitude and Low 
Activity. Each tab contains the settings for an artifact criterion. 

 

When the gradient criterion is applied, the absolute difference between two neighboring 
sampling points must not exceed a specific value. 

On the Gradient tab, you can make the following settings: 

• If you select the Check Gradient check box, the gradient criterion is applied. 

• In the Maximal allowed voltage step text box, you specify the maximum 
permissible difference in voltage between two data points. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact. 

 

 

Figure 12—32 Gradient tab on the Criteria tab in the Raw Data Inspection dialog box 

 

When the max-min criterion is applied, the difference between the maximum and minimum in a 
segment must not exceed a specific value. 

On the Max-Min tab, you can make the following settings: 

• If you select the Check maximal difference of values in intervals check box, the 
max-min criterion is applied. 

• In the Maximal Allowed Absolute Difference text box, you specify the maximum 
difference in voltage. 

• In the Interval Length text box, you specify the length of the interval in ms or the 
period within which the difference in voltage must not exceed the specified value. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact.  
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Figure 12—33 Max-Min tab on the Criteria tab in the Raw Data Inspection dialog box 

 

When the amplitude criterion is applied, the amplitude must not violate specified maximum 
and minimum values. 

On the Amplitude tab, you can make the following settings: 

• If you select the Check maximal and minimal amplitude check box, the 
amplitude criterion is applied. 

• In the Minimal allowed amplitude text box, you specify the minimum 
permissible value for the voltage. 

• In the Maximal allowed amplitude text box, you specify the maximum 
permissible value for the voltage. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact. 

 

 

Figure 12—34 Amplitude tab on the Criteria tab in the Raw Data Inspection dialog box  
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When the low activity criterion is applied, the difference between the maximum and minimum 
in an interval of a selectable length must not exceed a specific value. 

On the Low Activity tab, you can make the following settings: 

• If you select the Check low activity in intervals check box, the criterion for low 
activity is applied. 

• In the Lowest allowed activity (Max-Min) text box, you specify the minimum 
level of activity. 

• In the Interval Length text box, you specify the length of the interval within which 
the specified minimum level of activity cannot be violated. 

• In the Mark as bad before event and Mark as bad after event text boxes, you 
specify the period before and after the actual occurrence of the criterion that is to 
be marked as an artifact. 

 

 

Figure 12—35 Low Activity tab on the Criteria tab in the Raw Data Inspection dialog box 

 

You can combine the different criteria. As an aid to clarity, the title of each tab indicates 

whether the criterion is currently applied.  (parentheses with a cross) indicate that the 

criterion is currently applied.  (parentheses without a cross) indicate that the criterion is 
not currently applied. 

The Test Criteria button allows you to test the criteria. 

Once you have completed all your settings, click the OK button on one of the tabs. A temporary 
semiautomatic view dialog box appears on the right of the window. This contains a table of the 
marked artifacts. You can adjust the results of your settings subsequently in the same way as 
for manual segment selection. Click the OK button when the inspection of the EEG is 
completed.  

Low activity criterion 
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Figure 12—36 RDI, semiautomatic inspection, temporary semiautomatic view dialog box 

 

 

The automatic inspection method is the same as the semiautomatic inspection method except 
that it is not possible to make corrections manually. 

 

Automatic inspection 
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12.2.6 Ocular Correction ICA 
 
 

The Ocular Correction ICA transform allows ocular artifacts in the EEG to be corrected. This is an 
ICA-based correction process using a simplified version of ICA. Ocular artifacts could also be 
corrected using the ICA transform in semiautomatic mode. Compared with ICA, however, the 
Ocular Correction transform has the advantage that it offers more comprehensive methods of 
detecting artifact-related ICA components. 

 

Since this is an ICA-based correction process, we recommend that you do not work with data 
containing noise. This is because, in most cases, ocular correction significantly increases 
noise. We therefore advise you to apply the transform to filtered data. 

 

To display the dialog box for the transform, you choose Transformations > Artifact 
Rejection/Reduction > Ocular Correction ICA. 

 

 

Figure 12—37 Ocular Correction ICA dialog, page 1  

Summary 

Prerequisite for use 

Procedure 
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On the first page of the dialog, you specify how blinks are to be detected. 

• If you select the Using Markers radio button, blinks that are already marked are 
used in blink detection. 

• If you select the By Algorithm radio button, on the other hand, the blinks are 
detected by means of an algorithm. 

If you select the Write Only Markers check box, markers are set, but no correction is carried 
out. 

If you select the Write Pairs of Start and End Markers check box, the blinks are marked by 
pairs of markers: one at the start of the blink and one at the end. This check box is 
independent of the Write Only Markers check box. 

If you select the Semiautomatic Mode check box, semiautomatic mode is activated. This 
allows you to correct the data set subsequently. If you select the Write Only Markers check 
box and use semiautomatic mode, markers are edited, but no correction is carried out. 

The parameters that appear on the second page of the dialog depend on whether you select By 
Algorithm or Using Markers: 

 

In the Detection Algorithm group box, you select the algorithm to be used to detect blinks. 

 

 

Figure 12—38 Ocular Correction ICA dialog, second page if you select “By Algorithm”  

Second page of the 

dialog: “By 

Algorithm” 
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You can select one of the following radio buttons: 

• Meaned Slope Algorithm: This algorithm is the same as the one in BrainVision 
Analyzer 1.0. No further settings are required. Those sections of the selected 
VEOG channel with strong variations in gradient are detected. Experience shows 
that these are the blinks. 

or 

• Value Trigger Algorithm: Blinks are detected on the basis of their absolute 
values. The definitive blinks are ascertained by means of a correlation method. 

If you select the Value Trigger Algorithm radio button, the Advanced: Parameters for the 
Value Trigger Algorithm group box is activated, thus allowing you to make settings in it. 

The value in the Blink Value Trigger [%] text box specifies the threshold above which blinks 
are recognized as being blinks. The Polarity drop-down list box allows you to specify the 
polarity of the VEOG recording (positive or negative). If you choose Automatic, the polarity is 
determined automatically. 

In the Correlation Trigger [%] text box, you enter the minimum correlation required. The 
possible blinks are correlated with a blink sample, and only when their correlation is higher 
than the value in this text box are they recognized definitively as blinks. 

 

On this page, you select the markers to be used in blink detection. 

 

 

Figure 12—39 Ocular Correction ICA dialog, second page if you select “Using Markers”  

Second page of the 

dialog: “Using 

Markers” 
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To use an interval marker, you select the Interval Markers radio button and choose a marker 
name from the associated drop-down list box. 

To use start and end markers, you select the Start-markers and End-markers radio button 
and choose the markers you want to use from the drop-down list boxes. 

 

  

Figure 12—40 Ocular Correction ICA, start and end markers 

 

  

Figure 12—41 Ocular Correction ICA dialog, interval markers  
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If you do not select the Write Only Markers check box, the Next button takes you to the next 
page. 

 

 

Figure 12—42 Ocular Correction ICA dialog, third page if you do not select “Write Only 

Markers” 

 

On this page, you specify the channels in which the eye activity occurs. You also select the 
criteria for determining the relevant ICA components for the eye activity. Finally, you specify the 
percentage of the energy of the ICA components to be removed from the EEG. Energy in this 
case means global field power or VEOG or HEOG variance. 

 

The following description applies to the components of vertical eye movements. 

Select the VEOG Channel check box to set the VEOG channel, and then choose a channel from 
the associated drop-down list box. 

If vertical eye activity was measured with only one electrode during the recording of the EEG, or 
if it was measured with two electrodes and the difference between the measured values 
already exists in a separate channel, select the Use Common Reference radio button. 

On the other hand, if vertical eye activity was measured with two electrodes and the measured 
values are in two different channels, select the Use Reference Channel radio button and then 
choose the reference channel from the associated drop-down list box.  

Vertical Activity 

group box 
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To find the relevant ICA components for the vertical eye movements, you can choose between 
two criteria: global field power and relative VEOG variance. 

If you select the Use the Global Field Power radio button, the components are found by 
means of global field power. The components with the highest values for global field power, 
the sum of which exceeds the percentage specified in the Global Field Power to Delete [%] 
text box, are deleted from the EEG. 

If you select the Use Relative VEOG Variance radio button, the components are found by 
means of relative VEOG variance. The components with the highest values for relative VEOG 
variance, the sum of which exceeds the percentage specified in the VEOG Variance to Delete 
[%] text box, are deleted from the EEG. 

 

The following description applies to the components of horizontal eye movements. 

Select the HEOG Channel check box to set the HEOG channel, and then choose a channel from 
the associated drop-down list box. 

You select the common reference or the reference channel as described above for the Vertical 
Activity group box. 

 

The search for the ICA components relevant to the horizontal eye activity takes place 
exclusively on the basis of the criterion of the relative HEOG variance in the interval. The 
components with the highest values for relative HEOG variance, the sum of which exceeds the 
percentage specified in the HEOG Variance to Delete [%] text box, are deleted from the EEG. 

  

Find VEOG 

Components group 

box 

Horizontal Activity 

group box 

Find HEOG 

Components group 

box 
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Click Next to proceed to the fourth page of the dialog, where you make the ICA settings. 

 

 

Figure 12—43 Ocular Correction ICA dialog, page 4 

 

If you select the Whole Data radio button, the entire data set is included in the calculation of 
the ICA matrix. Note that calculating the matrix is very time-consuming when you use the 
Whole Data option. An alternative is to select a large interval (e.g. 2 minutes). 

If you select the Around Blinks radio button, only intervals defined around blinks are included 
in the ICA calculation. The middle of each of these intervals is the beginning of a blink, and the 
interval is twice as long as the blink. 

If you want to define an interval to be included in the calculation, select the Interval radio 
button and enter the beginning and length of the interval in the Start (s) and Length (s) text 
boxes. 

If you select the Bound Number of Blinks check box, you can enter in the associated text box 
the maximum number of blinks to be included in the calculation. If you do not select the check 
box, all blinks are included in the ICA calculation. This function is always accessible, 
regardless of what you select under ICA Domain. If you use the ICA Domain > Whole Data or 
ICA Domain > Interval function and limit the number of blinks, this only affects blinks used to 
obtain the relevant VEOG components.   

ICA Domain group 

box 
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For example, if you select the Interval radio button and enter a value of 60 in the Bound 
Number of Blinks text box, the first 60 blinks that occur in this interval are used to obtain the 
relevant VEOG components. The same applies if you select the Whole Data radio button, 
although in this case the interval is the entire data set. 

 
The radio buttons in the ICA group box allow you to choose between the four available ICA 
methods: Restricted Infomax, Extended Infomax, Restricted Fast ICA and Extended Fast 
ICA. 

If you select an infomax method, the Biased Infomax check box is available to you. If you 
select this check box, at each ICA calculation step an additional method [MBJGS97] is used in 
order to improve the quality of the ICA separation by highlighting particular characteristics of 
individual components. 

In the Number of Steps text box, you specify the maximum number of steps to be taken in 
order to get to the separating matrix (the matrix calculated for component separation). The 
default value for fast ICA methods is 150. The default value for infomax methods is 512. You 
can change these default values. 

 
The Next button takes you to the fifth page of the dialog. 

 

 

Figure 12—44 Ocular Correction ICA dialog, page 5 

 

On the fifth page of the dialog, you select the channels to be included in the ICA calculation 
and ocular artifact correction.  
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The Next button takes you to the sixth page of the dialog. 

 

 

Figure 12—45 Ocular Correction ICA dialog, page 6 

 

On this page of the dialog, you specify the LDR-compatible files in which the ICA matrix and the 
inverse of the matrix are to be saved. The matrix and its inverse in the LDR files can then be 
used by the linear derivation transform. 

If you select the Write LDR-File for ICA Matrix check box, the calculated ICA matrix is written 
to an LDR file. In the File Name text box, you enter the name of the associated file. The 
placeholders $h (for the name of the history file) and $n (for the name of the current data set) 
are available to you. The Resulting File Name text box displays the full name of the file. 

If you select the Write LDR-File for Inverse ICA Matrix check box, the inverse of the ICA matrix 
is written to an LDR file. The File Name and Resulting File Name text boxes are available to 
you again in the same way as those above for the ICA matrix.  
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There are also three options available to you for exporting the LDR files: 

• Write to Export Directory: The LDR files are written to the export folder. 

• Write to Raw Data Directory: The LDR files are written to the raw data folder. 

• Write to Following Directory: The LDR files are written to the folder you select by 
clicking the Browse button. 

 

If you selected the Write Only Markers check box on the first page of the dialog, the following 
dialog box is the second – and last – page of the dialog to appear: 

 

 

Figure 12—46 Ocular Correction ICA dialog, third page if you select “Write Only Markers” 

 

In this case, you simply set the VEOG channel by selecting the VEOG Channel check box and 
then choosing a channel from the associated drop-down list box. 

The Common Reference and Use Reference Channel radio buttons are used as described 
above (“Vertical Activity” group box without having selected the “Write Only Markers” check 
box).  
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If you selected the Semiautomatic Mode check box on the first page of the dialog, a 
semiautomatic view opens after you enter the parameters: 

 

 

Figure 12—47 Ocular Correction dialog, semiautomatic mode, ICA Components tab 

 

The semiautomatic view contains mobile blink markers. These can be edited in the same way 
as in semiautomatic mode when using the Edit Markers transform.  



 
Ocular Correction ICA 12.2.6 

 
 
 

 
BrainVision Analyzer  12.2.6—- 12 - 

The drop-down list box in the temporary semiautomatic view under the map view contains the 
following four items: ICA-Components, Correction, Subtracted and Topographies: 

• If you choose ICA Components, the components are displayed first, followed by 
the unselected channels. 

• If you choose Correction, the corrected data set is displayed without the 
components highlighted in red. 

• If you choose Subtracted, the sum of the excluded components (those 
highlighted in red) is displayed. 

• If you choose Topographies, the associated map view is displayed next to the 
components. 

 
If you select the Show Normed Mappings check box, the maps and topographies are replaced 
with standardized maps and topographies. 

If you select the Overlay with Original Data check box, the current data is overlaid with the 
original data. This option is important, above all, when you have chosen Correction or 
Subtracted from the drop-down list box. 

 
If you want to view unselected channels and calculated ICA components simultaneously, it is 
difficult to find a scaling factor that suits them both. To increase the size of the ICA 
components independently of the channels, choose from the ICA Scaling drop-down list box 
the scaling factor or coefficient by which the ICA components are to be multiplied to optimize 
the display. 

You can select one of the four values provided or enter a user-specific value. Note that the ICA 
Scaling list box is only available if you choose ICA Components from the drop-down list box 
above it. 

 
The Recalculate button allows you to modify all the settings made. A wizard appears in which 
you can make your changes. Except for its first page, the wizard is the same as the original 
dialog. 

 

In the upper part of the temporary semiautomatic view, there are two tabs that allow you to 
switch between ICA components and blinks. 

 

The table contains the energy values of all the ICA components, depending on the criterion 
selected on the second page of the dialog (global field power, VEOG variance, HEOG variance). 

The column on the left has either a green or red background. Green means that the 
corresponding component has been selected; red means it has not. If you double-click the row, 
the color switches from green to red. 

If you click a row, it turns blue, and the map view (under the table) displays the head 
topography of the highlighted row (i.e. the selected component).  

ICA Components tab 



 
Ocular Correction ICA 12.2.6 

 
 
 

 
BrainVision Analyzer  12.2.6—- 13 - 

On this tab, you can carry out a blink inspection. You can accept or reject blinks. 

 

 

Figure 12—48 Ocular Correction ICA dialog, semiautomatic mode, Blinks tab 

 

The Start Inspection button activates inspection mode. The first blink in the data set appears 
in yellow, and the system navigates automatically to this blink. 

Color legend (blink statuses): 

• Blue: possible blink 

• Yellow: currently selected blink 

• Green: accepted blink 

• Red: rejected blink 

  

Blinks tab 
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Figure 12—49 Ocular Correction ICA dialog, blinks in different colors 

 

The status of the currently selected blink appears in the text box under the Start Inspection 
button. 

You can use the Reject as Blink and Accept as Blink buttons to reject and accept blinks. 
When you click one of these buttons, the focus switches to the next blink. 

 

The Navigation group box allows you to navigate around the data set. The buttons --> and <-- 
take you to the next and previous blinks that meet one of the criteria Step to Next (next 
marker), Step to Next Accepted (next accepted marker) or Step to Next Rejected (next 
rejected marker). 

The To Use Keys group box explains how to use the keys on the PC keyboard to navigate: 

• You press the “R” key to reject the blink. 

• You press the “A” key to accept the blink. 

• You press the “P” key to navigate to the right. 

• You press the “Q” key to navigate to the left.  
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Note that you can only use these keys when the semiautomatic view is active. 

The End Inspection button terminates inspection mode. 

If you interrupt the inspection by clicking Recalculate or terminate it with Finish, only red 
markers are rejected. All other markers (blue, yellow and green) are accepted. 

If you select the Write Only Markers check box, the temporary semiautomatic view contains 
only the control elements for the blink inspection. 

 

 

Figure 12—50 Ocular Correction ICA dialog, first page if you click the “Recalculate” button 

 

On the alternative first page, you can make entries relating to the blinks:  

If you select the Redetect Blinks radio button, the blinks are detected again. 

If you select the Use Existent Blink Markers radio button, the blink markers that have not 
been rejected by the user are used in the subsequent calculation.  
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Ocular artifact correction is ICA-based. It runs analogously to the correction carried out by the 
ICA transform: Those ICA components that are relevant to the feature to be corrected are 
subtracted from the EEG. In comparison to the ICA transform, the Ocular Correction transform 
offers two functions for the specific task of correcting ocular artifacts: automatic and manual 
detection of blinks and automatic detection of ICA components that are relevant to the eye 
activity. The blink markers are determined by means of the same method used for non-ISA-
based ocular correction in Version 1.0 of the Analyzer. Moreover, they can be edited in 
semiautomatic mode. 

The relevant ICA components are selected by means of the following methods: 

1) The global field power method calculates the share of each ICA component in the global field 
power of the data set using only the intervals containing blinks. It is not important to this 
method which values the VEOG channel assumes. In other words, the VEOG channel is 
required exclusively for the detection of blinks. 

2) The method of relative VEOG variance calculates the share of each ICA component in the 
variance of the selected VEOG channel using only the intervals containing blinks. If the VEOG 
channel itself is not included in the ICA calculation, this calculation is replaced by a correlation 
calculation. 

3) The HEOG variance method calculates the share of each ICA component in the variance of 
the selected HEOG channel across the whole ICA range. If the HEOG channel itself is not 
included in the ICA calculation, this calculation is replaced by a correlation calculation. 

The advantage of semiautomatic mode is that the user can use the transparent blink markers 
to assess the relevance of the ICA components and exclude the relevant components. 

 

 

[MBJGS97] S. Makeig, A.J. Bell, T.-P. Jung, D. Ghahremani, T.J. Sejnowski, Blind separation of 
auditory event-related brain responses into independent components. Proc. Natl. Acad. Sci. 
USA, 94 (1997), 10979-10984. 
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12.2.7 Ocular Correction 
 
 

The Ocular Correction transform eliminates or at least reduces the effect of eye movements on 
the EEG. The Gratton & Coles method [GCD83] is used for this. 

 

To display the dialog box for the transform, you choose Transformations > Artifact 
Rejection/Reduction > Ocular Correction. 

 

Figure 12—51 Ocular Correction dialog box 

 

You can make the following settings: 

The method used appears in the Method drop-down list box. The Gratton & Coles algorithm 
and a slightly modified version of it, “Gratton & Coles without Raw Average Subtraction”, are 
available for selection. These algorithms and their differences are described below.  

Summary 

Procedure 
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Select the VEOG Channel check box if there is a VEOG channel in the EEG. 

Choose the channel’s name from the Channel Name drop-down list. 

If you select the Common Reference radio button, it is assumed that the reference electrode of 
the VEOG channel is shorted to the common reference. 

If, on the other hand, you select the Reference Channel radio button, it is assumed that the 
reference electrode of the VEOG channel is not identical to the common reference. 

The following principle applies: If your VEOG signal takes the form of a single channel, you 
should select Common Reference, because, as far as the program is concerned, the signal is a 
unipolar signal and thus shorted to the common reference. However, if your VEOG signal takes 
the form of two individual channels, such as “VEOG Upper” and “VEOG Lower”, select 
Reference Channel and then the second channel from the list of available channels. In blink 
detection, the program will then treat these two channels as a bipolar channel pair. 

 

The functions of the HEOG group box for the HEOG channel correspond to the functions of the 
VEOG group box for the VEOG channel. 

 

You can specify: 

• Whether the blinks are to be searched for in the VEOG channel selected above 
(By Algorithm radio button) 

• Or whether you have detected the blinks that are relevant to you without using 
the Ocular Correction transform (using a macro based on your own algorithm, for 
example) and have marked them with a “Blink Start” and “Blink End” marker 
(Based on Markers radio button) 

To do this, specify the names of the desired markers in the Start Marker and End 
Marker drop-down list boxes. 

If you select the By Algorithm radio button, you can also select the Write Only Markers check 
box to specify that no data correction is carried out in this analysis step and that the blinks 
found are merely marked in the data set. If you want to change these markers subsequently, 
you use the relevant functions in the semiautomatic view of the Ocular Correction ICA 
transform. 

Please note that on the first page of the dialog for the Ocular Correction ICA transform, the 
Write Only Markers and Write Pairs of Start and End Markers check boxes must be 
selected. 

You can carry out the actual ocular correction in a subsequent step by selecting the Based on 
Markers radio button.  

VEOG group box 

HEOG group box 

Blink Detection 

group box 
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In this group box, you select the channels for which correction is to be carried out (Enabled 
Channels). 

The VEOG and HEOG channels can be used for correction. This is not advisable, however, since 
the information contained in these channels is largely lost. 

The information loss is as follows: If you use an ocular channel with the Common Reference 
radio button selected, this channel has a constant signal after the correction. On the other 
hand, if you use an ocular channel with the Reference Channel radio button selected, both the 
ocular channel and the reference channel have the same signal after the correction. It is 
essential to take this into account when reusing the channels as pure data channels. 

 

The Gratton & Coles algorithm corrects ocular artifacts by subtracting the voltages of the ocular 
channels, multiplied by a channel-independent correction factor, from the EEG channels. 

The correction factors are calculated in several steps. 

In the first step, a blink detection method is applied to the vertical ocular channel in order to 
calculate separate factors within and outside blinks. 

In the next step, after the subtraction of the average, an average of the various events (i.e. of 
the different segmentation markers) is obtained for each channel. 

To calculate the correction factors, in the third step this average is subtracted from the channel 
in each segment in order to prevent the event-correlated data from being included in the 
calculation. This step is not included if you selected the “Gratton & Coles without Raw Average 
Subtraction” method. 

In the final step, the correction factors are calculated by linear regression. 

 

 

[GCD83] G. Gratton, M.G.H. Coles, E. Donchin, A new method for off-line removal of ocular 
artifact. Electroencephalography and Clinical Neurophysiology, 55 (1983), 468-484. 
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12.3 Transforms in the Frequency and Component Analysis group 
 
 

12.3.1 ICA (Independent Component Analysis) 
 
 

The ICA transform is used to split the EEG signals up into independent components using 
information theory methods. It is assumed here that EEG signals are a linear combination of 
independent components (independent as defined in information theory). The ICA transform 
separates the independent virtual components from the complex signals and analyzes them. 

The purpose of the ICA transform in what is known as “blind source separation” is to 
reconstruct source signals from a combination of these signals. Both the source signals and 
the combination are unknown, so assumptions are made about the signals and how they are 
combined. It is assumed that the signals to be reconstructed are statistically independent of 
each other. You will find detailed information on the theory used in [BS95], [Car98] and 
[MBJS96]. At this point, it is enough to say that the ICA transform is a purely statistical (i.e. 
mathematical) method. It is based on the above assumptions and does not use any additional 
physiological information. It is up to you, the user of the transform, to check that the 
assumptions are correct and that they correspond to the physiological conditions. This is 
critical to the meaningfulness of the results generated by the ICA transform. 

The result of the ICA transform is a set of components that are defined analogously to EEG 
channels in the time domain. In addition, the ICA transform provides a transformation matrix 
by means of which the components can be calculated from the channels. The infomax 
algorithm or the fast ICA algorithm is used to determine this weight matrix. The infomax 
algorithm is an iterative gradient method used to estimate maximum likelihood and is 
described in [MBJGS97], for example. The fast ICA algorithm is an iterative fixed-point method 
used to minimize negentropy and is described in [HKO01], for example. 

 

Please note that the term “fast” has a slightly different meaning when it is used in the name of 
the fast ICA algorithm from when it is used in the Fast Fourier transform (FFT), for example. The 
Fast Fourier transform is an accelerated method that returns the same results as a conventional 
Fourier analysis. ICA with infomax and fast ICA are two different methods of calculating 
independent components. Only in an ideal case do they return the same results. Fast ICA has 
stricter requirements in terms of the separability of components. If these requirements are met, 
it calculates more quickly than conventional methods, hence its name. If the requirements for 
good component separability are not met, calculation with fast ICA is generally slower than 
with other methods. In this case, the suitability of the initial data for an ICA analysis should be 
examined. 

 

To display the dialog box for the transform, you choose Transformations > Frequency and 
Component Analysis > ICA.  

Summary 

 

Procedure 
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Figure 12—52 ICA dialog, page 1 

 

On the first page of the ICA dialog, you specify the LDR-compatible files in which the ICA matrix 
and the inverse of the matrix are to be saved. The matrix and its inverse in the LDR files can 
then be used by the linear derivation transform. 

If you select the Write LDR-File for ICA Matrix check box, the calculated ICA matrix is written 
to an LDR file. In the File Name text box, you enter the name of the associated file. The 
placeholders $h (for the name of the history file) and $n (for the name of the current data set) 
are available to you. The Resulting File Name text box displays the full name of the file. 

If you select the Write LDR-File for Inverse ICA Matrix check box, the inverse of the ICA matrix 
is written to an LDR file. The File Name and Resulting File Name text boxes are available to 
you again in the same way as those above for the ICA matrix. 

There are also three options available to you for exporting the LDR files: 

• Write to Export Directory: The LDR files are written to the export folder. 

• Write to Raw Data Directory: The LDR files are written to the raw data folder. 

• Write to Following Directory: The LDR files are written to the folder you select by 
clicking the Browse button.  
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Click Next to go to the second page of the dialog. 

 

 

Figure 12—53 ICA dialog, page 2 

 

On the second page, you specify the size of the ICA matrix. The width of the matrix is the 
number of channels selected, and its height is the number of components to be calculated. 

In the Channel Names group box, you specify which channels are to be included in the ICA 
calculation. The number of selected channels is displayed below the two list boxes (Number of 
Enabled Channels:). 

In the Number of ICA Components group box, you specify how many ICA components are to 
be calculated: 

• By default, the number of components calculated is equal to the number of 
channels selected (the Number of Enabled Channels radio button is selected). 

• You can also specify that a lower number of components is calculated. To do this, 
you select the Number of Components radio button and enter the number of 
components to be calculated in the associated text box. 

If you erroneously enter a value in this text box that is higher than the number of 
selected channels, this entry is ignored and the maximum possible number of 
components (i.e. number of selected channels) is calculated.  
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• You can also specify that the number of components to be calculated is 
determined automatically by selecting the Components With Eigenvalue At 
Least radio button. 

• If you select this radio button, the covariance matrix of the signals is diagonalized 
(PCA method). The resulting values are referred to as eigenvalues. 

Those ICA components that correspond to the smallest eigenvalues provide little 
information. In most cases, they consist of noise and can therefore interfere with 
the calculation of the ICA matrix. They should therefore not be included in the 
calculation of the ICA matrix. To this end, you enter a limit value in the 
Components With Eigenvalue At Least text box (default value: 0.001). The 
components whose eigenvalues are under this limit value are not included in the 
calculation of the ICA matrix. 

Click Next to go to the third page of the dialog. 

 

 

Figure 12—54 ICA dialog, page 3  
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Because the ICA transform is a statistical method, it is not essential to use the whole length of 
the data set in the calculation. Specific ranges of the EEG signal are often more meaningful 
than the whole data set as far as the components are concerned. This is why the third page of 
the dialog allows you to limit the range of the EEG that is used in order to both limit the 
calculation to statistically significant ranges and improve performance. 

You can define the range of the EEG by means of five different methods. For methods 3, 4 and 
5, the ICA range is composed of the separately defined intervals by means of markers. 

• (1) Use Whole Data: The entire data set is used for the calculation. 

• (2) Use Interval: The calculation applies only to a specific interval, the beginning 
and length of which you specify in the Start [s] and Length [s] text boxes in the 
Range group box. 

• (3) Use Equal Intervals Around Markers: Intervals of equal size around the 
markers are used. 

From the Name drop-down list box in the Marker and Range group box, you 
choose the name of a marker. You then specify the beginning and end of the 
interval in relation to the selected marker in the Start [ms] and End [ms] text 
boxes. Example: If you enter a value of -100 in the Start [ms] text box and a value 
of 500 in the End [ms] text box, the interval begins 100 ms before the selected 
marker and has a length of 600 ms. 

If the selected marker is an interval marker, the interval is defined in relation to 
the starting point of this marker. 

• (4) Use Interval Markers: Intervals defined exclusively by interval markers are 
used. 

From the Name drop-down list box in the Interval Marker group box, you choose 
the name of the marker to be used. 

• (5) Between Start and End Markers: Intervals defined by start and end markers 
are used. 

From the drop-down list boxes in the Start and End Markers group box, you 
choose the names of the start and end markers to be used. 

If either or both of the selected markers are interval markers, the interval is 
defined in relation to the starting point of the marker. In other words, the end of 
the interval is defined by the starting point of the end marker. 

If an end marker occurs after several successive start markers, the interval starts 
at the first start marker in the series and ends at the end marker. If this end 
marker is followed by further end markers, these are ignored. The next interval 
starts at the next start marker. 

An interval is not recognized as an interval unless it is concluded by an end 
marker.  
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Click Next to go to the fourth page of the dialog. 

 

 

Figure 12—55 ICA dialog, page 4 

 

In the Sphering group box, you can choose between two sphering methods. Sphering is for the 
preliminary processing of the EEG signals: 

• Classic (conventional sphering): The conventional method treats all components 
equally. 

• Probabilistic (probabilistic sphering): The combination of probabilistic sphering 
and any ICA method is referred to in the literature as probabilistic ICA (PICA). The 
noise is filtered out of the EEG data set using the probabilistic method. 

If you are uncertain about the correct number of components, we recommend that 
you use this method. The reason for this is that, if the ICA transform is used with 
an incorrect number of components, it causes noise or exacerbates existing 
noise, thus contaminating components. This is because the noise has a Gaussian 
structure, and the Gaussian components can only be separated with great 
difficulty using the ICA method. 

The radio buttons in the ICA group box allow you to choose between the four available ICA 
methods: Restricted Infomax, Extended Infomax, Restricted Fast ICA and Extended Fast 
ICA.  
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If you select an infomax method, the Biased Infomax check box is available to you. If you 
select this check box, at each ICA calculation step an additional method ([MBJGS97]) is used in 
order to improve the quality of the ICA separation by highlighting particular characteristics of 
individual components. 

In the Number of Steps text box, you specify the maximum number of steps to be taken in 
order to get to the separating matrix (the matrix calculated for component separation). The 
default value for fast ICA methods is 150. The default value for infomax methods is 512. You 
can change these default values. 

 

In the Ordering group box, you select one of the following sort criteria for the components: 

• Kurtosis (in descending order) 

• Energy (in descending order) 

Kurtosis (K) is a numerical estimate of the peakedness of a curve (graph). The following 
distinctions are drawn: 

• K = 0 means normal peak, Gaussian or mesokurtic. 

• K > 0 means steep peak, super-Gaussian or leptokurtic. 

• K < 0 means flat peak, sub-Gaussian or platykurtic. 

Note that the restricted infomax method, unlike the extended infomax method, can only 
separate components with positive kurtosis (K > 0). 

 

Semiautomatic mode allows you to experiment with the result of the exclusion of certain 
components and the reconstruction of the data set from the other components. To do this, you 
select the Semiautomatic Mode check box. After you enter the parameters, a semiautomatic 
view appears. 

Click OK to start the ICA calculation. 

Please note the following points about the display: 

• The names of the components consist of the letter “F” followed by a number – in 
accordance with the selected sort criterion (kurtosis or energy). 

• If you include all the channels in the ICA calculation, only the components are 
displayed. 

On the other hand, if you do not select all the channels, the components are 
displayed at the top. The unselected channels are displayed below these in the 
order in which they occur in the original EEG. 

• Channel markers that were originally on a selected channel automatically turn 
into global markers. 

Channel markers that were originally on an unselected channel remain in position 
on that channel. 

Markers that were originally global remain global.  
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• If the ICA components are displayed with unselected channels, their amplitude is 
considerably lower than that of the channels. To obtain a better display, select 
one, several or all components and view them separately. 

 

 

Figure 12—56 Semiautomatic mode with the temporary Semiautomatic View dialog box 

 

The table in the upper part of the semiautomatic view contains the components and the names 
of the selected channels. The values in the columns represent the separating matrix. 

The column on the left has either a green or red background. Green means that the 
corresponding component has been selected for the reconstruction process, and red means it 
has not. If you double-click the row, the color switches from green to red.  
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If you click a row, it turns blue, and the map view (under the table) displays the head 
topography of the highlighted row (i.e. the selected component). 

 

The drop-down list box under the mapping view contains the following four items: ICA-
Components, Correction, Subtracted and Topographies. 

• If you choose ICA Components, the components are displayed first, followed by 
the unselected channels, as in semiautomatic mode. 

• If you choose Correction, the reconstructed data set is displayed without the 
components highlighted in red. 

• If you choose Subtracted, the reconstructed data set is displayed using only the 
components highlighted in red. 

• If you choose Topographies, the associated map view is displayed next to the 
components. 

 

Figure 12—57 “Correction” option, component F00 not selected (red)  
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Figure 12—58 “Topographies” option 

 

If you select the Show Normed Mappings check box, the maps and topographies are replaced 
with standardized maps and topographies. 

If you select the Overlay with Original Data check box, the current data is overlaid with the 
original data. This option is important, above all, when you have chosen Correction or 
Subtracted from the drop-down list box. 

 

If you want to view unselected channels and calculated ICA components simultaneously, it is 
difficult to find a scaling factor that suits them both. To increase the size of the ICA 
components independently of the channels, choose from the ICA Scaling drop-down list box 
the scaling factor or coefficient by which the ICA components are to be multiplied to optimize 
the display. 

You can select one of the four values provided or enter a user-specific value. Note that the ICA 
Scaling list box is only available if you choose ICA Components from the drop-down list box 
above it. 

 

The Recalculate button allows you to modify all the settings made. The ICA dialog appears 
again to allow you to make your changes. 

If you select the After Finish Show Correction check box, when you click the Finish button, 
the reconstructed data set is displayed without the components highlighted in red. If you do 
not select the check box, the ICA components are displayed first, followed by the unselected 
channels:  
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Figure 12—59 Display of the ICA components first, followed by the unselected channels 

 

If you have not selected semiautomatic mode, or if you have not selected the After Finish 
Show Correction check box in semiautomatic mode, the following user properties are 
automatically saved in the node created: MeanValue, ICAMatrix, InverseMatrix, 
NumberComponents: 

 

 

Figure 12—60 User properties, ICA  
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The user properties can be read by means of OLE Automation and used by other solutions. 

 

When using the ICA transform, you choose a sphering method and a method of ICA training. 

The data in the selected interval is stored in the main memory of the PC for further processing. 
If the volume of data in the interval is greater than the available main memory, as much data 
as possible is stored and processed. Consequently, the more memory the computer has 
available, the better the ICA transform works. We also recommend that you close other 
applications to make more memory available. 

The ICA transform consists of the following steps: 

• The mean values of the channels are subtracted from the data set. 

• The sphering matrix is calculated and applied to the data set (PCA). 

• ICA training: The resulting data is inspected repeatedly until the ICA matrix has 
been calculated with sufficient precision. 

• The ICA components are determined by applying the ICA matrix to the data set. 

• The arrangement of the components in the newly created data set is adjusted 
depending on which sort criterion is selected. 

The calculation and application of the sphering matrix to the data is also referred to as 
preprocessing. 

In contrast to conventional sphering, probabilistic sphering is designed to reduce noise in the 
EEG. 

The infomax methods, which are also known as gradient methods, are generally slower than 
the fast ICA methods when component separability is good. However, there are exceptions 
with fast ICA methods in which calculation is interrupted and new parameters have to be 
selected. In such cases, it is possible for a fast ICA method to be slower. 

The Infomax/Fast-ICA and Restricted/Extended options provide you with a total of four 
methods of ICA training. The restricted methods repeat the same training method for each 
component. The extended methods adapt the training method to suit the component 
depending on the kurtosis of the partially calculated component. 

Note that the restricted infomax method can only calculate components with positive kurtosis. 
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12.3.2 FFT (Fast Fourier transform) 
 
 

The Fourier transform converts data from the time domain to the frequency domain. In other 
words, the resulting data indicates the extent to which the individual frequencies between 0 Hz 
and up to half of the sampling rate are represented in the EEG. 

 

In principle, no previous processing steps are required before the transform is used. We 
nevertheless recommend that you carry out the FFT after: 

• Segmentation 

 

To display the dialog box for the transform, you choose Transformations > Frequency and 
Component Analysis > FFT Analysis. 

 

Figure 12—61 Fast Fourier Transformation dialog box 

 

You can make the following settings: 

 

In the Resolution group box, you specify the resolution of the new data set in hertz. You can 
choose between the maximum resolution, which is obtained from the number of points in the 
segments and the sampling rate (Maximum resolution), and a user-defined resolution (Other 
Resolution [Hz]). The maximum resolution is calculated as follows: sampling rate ÷ segment 
length.   

Summary 
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Resolution group 
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In the Output group box, you can make the following settings: 

• You specify the type of the resulting data and the unit in which it is calculated. 
You can choose between the following data types: voltage (Voltage [μV] radio 
button), voltage density (Voltage Density [μV/Hz] radio button), power (Power 
[μV2] radio button) and power density (Power Density [μV2/Hz] radio button). 

In the case of the voltage density and power density functions, the spectral line 
values are scaled as if they were calculated with spectral line spacing of 1 Hz. 
This permits comparisons between FFT analyses that have been carried out with 
different spectral resolutions. To this end, the spectral line values are multiplied 
by a constant factor b, which corresponds to the reciprocal value of the spectral 
line spacing (b=1/fb). 

• By selecting the Produce Complex Output check box, you specify that the FFT 
transform is to create complex data. You should do this whenever you want to 
further process the data resulting from the FFT with transforms that have to 
process not only the values of the spectral lines but also their phase information 
and consequently require complex data. Coherence analysis is an example of 
this. 

• The Use Full Spectrum check box allows you to specify whether you want only 
one or both halves of the spectrum to be used to calculate the spectral line 
values. When both halves are used, the spectral line values are effectively 
doubled. This is of particular significance when power spectra are calculated, 
since this check box allows both of the definitions of spectral power (μV² or as 
μV²/2) used with EEGs to be taken into account. If you select the Use Full 
Spectrum check box, the resulting FFT power spectra behave in accordance with 
the Parseval theorem, which states that the total power in the power spectrum 
should always be equal to the total variance in the time signal. 

• If you select the Normalize Segments check box, the FFT data becomes 
comparable in a different way. It is sometimes important in EEG research to be 
able to make relative comparisons by changing the spectral composition of the 
EEG signal. Since the total power of the EEG varies from segment to segment, 
such comparisons generally cannot be carried out. However, the Normalize 
Segments function allows you to normalize the total area in the EEG spectrum or 
part of the EEG spectrum and thus render it comparable. 

If you do not select this check box, the transform creates the data in the 
frequency domain. If you do select the check box, the data is multiplied after the 
Fourier transform by a factor that makes the normalization area under every 
channel and in every segment identical. In this case, it is not the absolute data 
that is output but the relative distribution of the activity to the individual spectral 
lines.  

Output group box 
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• In the Interval Start [Hz] and Interval End [Hz] text boxes, you can specify the 
lower and upper limits of the normalization range. The minimum lower limit is set 
at 0.5 Hz, since it is generally assumed that frequencies under 0.5 Hz are not 
electrocortical in origin and, moreover, that these frequencies are extremely 
unstable from segment to segment. The area of this frequency range is calculated 
and an area value of 100 is set by multiplying it by a normalization factor that 
differs from segment to segment and channel to channel. In the same way, all of 
the spectral line values that are not within the normalization range are multiplied 
by this factor and thus also normalized. 

Band comparisons, such as the relative alpha share of the EEG or the alpha slow 
wave index, can thus be calculated easily using this function. Normalization also 
makes it much easier to calculate the spectral corner frequency, for example. 

 

In the Data Window group box, you can specify the type of the FFT data window. The following 
three radio buttons allow you to choose between different window types: No Window, 
Hanning Window and Hamming Window. 

In the Window Length [%] text box, you enter the window length as a percentage of the 
segment length. 

The window function is displayed graphically. 

If you select the Apply Variance Correction check box, the power in the EEG signal is identical 
before and after the application of the FFT, even when a window function is used. 

The Periodic and Symmetric radio buttons allow you to configure the right-hand margin of the 
data window. Periodic configures the right-hand margin of the window in such a way as to 
optimize the analytical characteristics of the window for the periodic continuation of the 
window. Symmetric configures the right-hand margin of the window to be exactly symmetrical 
to the left-hand margin. 

 

The Use Compression check box allows you to specify whether you want to store the data 
compressed or uncompressed. Compressed data saves storage space in the history file but is 
not as accurate as uncompressed data. 

If you select the Use Compression check box, you can specify the resolution of the data in 
nanovolts (1000 nV = 1 μV) in the Resolution [nV] text box. The lower the resolution of the data 
(higher values), the greater the compression effect. Consequently, less storage space is 
required.  

Data Window group 

box 

Data Compression 

group box 
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Strictly speaking, a Fourier transform extends from 0 Hz to the maximum sampling rate. 
However, the data in the high frequency range results from conjugate-complex values from the 
data in the lower frequency range is therefore not calculated explicitly. 

The data values are scaled in such a way that a sine wave of 1 Hz and an amplitude of 100 μV 
generate a value of 50μV at 1 Hz when the output format is Voltage, calculation takes place 
without a data window (No Window) and the Use Full Spectrum check box is not selected. 
Together with the corresponding data value in the high frequency range (i.e. when the Use Full 
Spectrum check box is selected), this results in the original value of 100 μV at 1 Hz. This 
approach corresponds to the calculation of a Fourier transform with subsequent division by the 
number of data points used. 

 

Although the Fourier transform can in principle be used at any point in the process, it is 
recommended for segmented EEG data to save time. 

The transform is executed separately for each segment. It is not essential for the number of 
data points in a segment to be a power of 2. If the number is not a power of 2, the segments 
are automatically extended to the next higher power of 2, and the corresponding number of 
zeros is added to the existing data. 

This process, which is also known as padding, corresponds to the interpolation of the data in 
the frequency spectrum of the original data set. As a result, a frequency spectrum is obtained 
that has a higher resolution than the original data set. No data is lost here, and the resulting 
data does not contain any artifacts. 

On account of the interpolations, however, it cannot be expected that using this process on 
data with any segment length and sampling frequency will always produce comparable results, 
since the FFTs calculated in this way differ in terms of the total number of data points and thus 
also in terms of the information content of the original input data. This inevitably leads to 
differences in the resulting spectra. Interpolated FFT spectra are thus suitable, above all, for 
visual data inspection. 

To prevent the interpolation of the FFT data at all resolutions, you should thus ensure that the 
number of data points in the segments is a power of two and select the Maximum resolution 
radio button in the Resolution group box. 

If you select a different resolution from the maximum spectral resolution determined by the 
segment length and data rate, the resulting FFT spectra are also either interpolated or both 
interpolated and integrated, depending on the selected resolution. As mentioned above, 
interpolation like this always produces correct FFT spectra without creating any artifacts. Note, 
however, that an FFT analysis like this is not necessarily comparable with an FFT analysis using 
a data set that has the resolution selected here as the maximum spectral resolution. 

This can be illustrated by an example in which an EEG has a sampling rate of 1024 Hz and 
segments of 4096 points. The maximum spectral resolution is thus 0.25 Hz (1024/4096=0.25). 
If you select the Other Resolution radio button and enter a resolution of 1.0 Hz, instead of 
1024 data points being included in the analysis, as would be the case given a maximum 
resolution of 1.0 Hz (segments of 1024 data points and a sampling rate of 1024 Hz), four times 
that number of data points are included. The resolution of 1.0 Hz is established by integrating 
four spectral line values. If the resolution ratios are not exactly divisible, the overlaps of the 
values at the spectral line edges are interpolated. However, since the original segments are 
four times longer and thus inevitably contain different information from the short segments, in 
spite of the FFT resolution theoretically being identical, the results can by no means be 
expected to be the same.   

Additional 
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Note that this is not a problem caused by the method used; it is an inevitable result of the 
differences in the quantity and contents of the information included in the FFT analysis when 
there are different spectral resolutions.  

This problem, which is inherent in interpolation, applies particularly to the calculation of 
complex FFT values when a resolution other than the maximum spectral resolution is selected. 
This is because it is not just the values of the spectral lines but also their phase information 
that have to be interpolated and/or integrated. This can impair the flow of the phase 
information, which is actually rather constant, and, for example, make the result of a 
subsequent coherence analysis appear questionable. 

It is worth repeating that spectra interpolated like this are suitable above all for the visual 
inspection of data and should not form the basis for subsequent calculations. 

 

In the Fourier transform, it is assumed that the output signal is repeated periodically. Since this 
requirement is generally not met when EEG sections are transformed, the difference between 
the voltage level at the beginning and end of the segment is a point of discontinuity in Fourier 
transform calculations and causes the data to be corrupted. 

To reduce this effect, it is possible to place a data window over the segment to be transformed. 
This data window damps the EEG data at its margins. When the data window is applied, the 
voltage level at the beginning and end of the segment is 0, rising to the original measured 
value in the middle of the segment. 

The range in which the data window is used can be specified as a percentage. 100% means 
that only the value in the middle of the segment matches the original data value, and all other 
values are damped by the data window. The lower the percentage specified, the smaller the 
range changed by the data window. This principle is represented graphically and very clearly in 
the FFT module. 

The Hanning window is calculated using the following equation: 

WP = 0.5(1 – cos(2π x/P)). 

The Hamming window is calculated using the following equation: 

WP = 0.54 –0.46 cos(2π x/P)). 

P is the percentage specified in the Window Length [%] text box. Corresponding symmetric 
equations apply to the end of the segment. 

It follows from the way in which the data window works, as described above, that the overall 
signal and thus the total variance of the EEG signal are weakened by the window, particularly 
toward the margins. Accordingly, the use of a data window also results in the damping of the 
data produced by the Fourier transform. 

For this reason, before the Fourier transform is applied, a correction factor is calculated for the 
data window and window width used. This factor is used to multiply the data on completion of 
the Fourier transform. This correction ensures that the total variance of the transformed signal 
matches the total variance of the original signal. 

 

Digression: Function 

of the data window 
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12.3.3 Wavelets 
 
 

Like the Fourier transform, the wavelet transform is a method of analyzing the frequency of a 
signal. The essential difference between the two methods is that the Fourier transform uses the 
trigonometric functions as basic functions. In other words, the values are calculated by means 
of sine/cosine functions. The Wavelet transform, on the other hand, uses wavelets (i.e. 
functions whose properties can be adjusted to suit particular problems). In contrast to the FFT, 
it is possible with the Wavelet transform to analyze local frequency properties as well. 

The following example illustrates the difference between the Wavelet transform and the FFT: 

The frequency resolution (i.e. the accuracy with which statements can be made about the 
signal content at specific frequencies) in the case of the FFT is, at 1/T (T = segment length in 
data points), directly dependent on the length of the EEG sections included in the FFT analysis. 
In order to obtain frequency resolution accuracy of 1 Hz, you therefore require EEG sections of 
exactly a second (regardless of the sampling frequency). 

This is precisely where the analytical problem begins. The cortical activation that is actually of 
interest often takes place within quite a narrow time range around the time of stimulation. An 
example of this would be the examination of changes in the delta range directly after electrical 
pain stimulation. In this case, the changes that are of interest take place in the first 250 ms 
after stimulation. To carry out an FFT analysis with a frequency resolution of 1 Hz, 1000 ms must 
be included in the FFT analysis. Thus, four times as much data as is necessary is included in 
the analysis. In addition, the power in the delta band is also calculated for this data, which is 
actually superfluous, and this inevitably corrupts the results. 

Another result of this is that in our example the frequency content of the frequency range that 
is actually of interest here (e.g. the delta range) obviously does not exist to the same extent 
over the entire section analyzed using the FFT. The same applies to all the other signal 
components that occur in the EEG. A signal in which the frequency components vary over time 
is referred to as non-stationary. 

However, since the frequency resolution in the case of the FFT is directly linked to the number 
of data points included, it is simply not possible to make a statement about the changes to the 
spectral composition of the signal within intervals that are shorter than specified by the 
frequency resolution. Moreover, if the signal in the segments analyzed is not stationary, this 
variation in the signal over time cannot be represented with the FFT either. 

This is where wavelet analysis comes into play. The Wavelet transform compares the EEG 
signal with the wavelet used over the entire duration of the EEG signal and for different 
frequency ranges. It is critical here that after the wavelet transform for each point of time in the 
time domain there is also a wavelet value for each point of time and frequency range. In the 
above example, this would mean that after the Wavelet transform there would also be a curve 
for the activity over time for the delta band. 

The Wavelet transform also permits changes in the spectral content of EEG signals to be 
examined over time. This is a key difference between it and the FFT. 

A distinction can be drawn here between the discrete Wavelet transform and the continuous 
Wavelet transform.  

Summary 
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Discrete Wavelet transform (DWT) 

The discrete Wavelet transform is actually a special case of the continuous Wavelet transform 
(CWT), but it is nevertheless dealt with here first since, on account of its simple algorithm and 
associated high analysis speed, it is already widely used in EEG research. 

The discrete Wavelet transform is based essentially on a method known as “subband coding”. 
In this method, the signal of interest is filtered by means of two semiband filters that are as 
perfect as possible. One filter (the low-pass filter) filters the frequency components above the 
halfway point of the available frequency band (the Nyquist frequency), and the other filters the 
frequency components below the Nyquist frequency symmetrically. 

Since the resulting signal of the low-pass filter only contains frequencies up to the Nyquist 
frequency but still retains its full segment length, half of the data is inevitably redundant 
(Nyquist’s law) and is eliminated by subsampling (i.e. by simply deleting every second data 
point). As a result of this processing step, the time resolution of the signal is halved, since the 
entire signal is now characterized by half the data points. At the same time, however, half of 
the data points represent the entire frequency content of the signal, and the frequency 
resolution is thus doubled. This process of constant halving of the time resolution and 
doubling of the frequency resolution is referred to as subband coding. 

This subband coding is repeated for as long as frequency components of interest are to be 
extracted, and each step results in wavelet data that corresponds to the time-related 
composition of the frequency components in the original data. 

Ultimately, a set of coefficients is obtained that contains the time-frequency curve for all the 
required subcoding steps (i.e. for all the desired frequency ranges). 

An obvious limitation of this method is that it is impossible to examine the time-frequency 
behavior of a signal at a specific frequency, since in the DWT the original signal is repeatedly 
divided into half-frequency ranges, beginning at the Nyquist frequency. It is thus clear that a 
time-frequency analysis specifically for 32 Hz, for example, cannot be implemented. 

Given a signal with a sampling rate of 256 Hz, however, accurate time-frequency statements 
can be made for the frequency ranges 64-128 Hz, 32-64 Hz, 16-32 Hz, 8-16 Hz, 4-8 Hz, 2-4 Hz 
and 1-2 Hz. Cumulation of the result values is also possible so that, for example, the analysis 
of the delta band can be carried out on the time-frequency curve. 

A further advantage that often makes the DWT rather than the CWT the method of choice in the 
EEG field is the simplicity with which the wavelet coefficients can be converted back to the time 
domain. This is possible because the filters used represent orthonormal bases, and reverse 
conversion can thus be implemented easily. The discrete Wavelet transform can thus also be 
used for wavelet-based filtering of the data.  
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Continuous Wavelet transform (CWT) 

The continuous Wavelet transform provides considerably more scope at those very points 
where the DWT, which is actually very elegant, has its limitations. It permits specification of the 
frequency bands to be examined and of their resolution, and it offers more options when it 
comes to selecting the underlying filters (mother wavelets, see below). 

Unlike the DWT, the CWT does not work with semiband filters; it works with mother wavelets 
instead. These are short signal sections shaped on the basis of underlying functions in such a 
way that, when filters are applied to the raw data, they represent particular signal 
characteristics in the time-frequency domain as accurately as possible. Here, too, filtering or 
folding thus takes place, but with a specific filter characteristic for the signal of interest. 

The two mother wavelets used most frequently in the CWT are the “Mexican hat” and “Morlet” 
wavelets, which are shown below. 

Figure 12—62 The graphs of the complex Morlet wavelet (left) and the Mexican hat wavelet 

(right) 

 

The complex Morlet wavelet, which is also known as the modulated Gauss function, is defined 
by the following formula: 

( ) ctit
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The factor A is used for normalization. The parameter c is a special property of the Morlet 
wavelet. It enables the number of oscillations of the wavelet – and thus the filter width in the 
frequency range – to be varied. 

The real Morlet wavelet consists of the real part of the complex function. 

The formula for the Mexican hat wavelet is: 
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The Mexican hat wavelet looks rather like a sombrero, as you can see in the figure above. 

How do the two wavelets filter the raw data? To begin with, the mother wavelet is successively 
translated via the raw data, and for each point in the raw data a scalar product with all the 
points is calculated in the wavelet. As a result, the data is filtered with the wavelet or – 
depending on how it is viewed – a correlation function of the wavelet is calculated with the 
data in the time domain. The resulting wavelet vector thus represents a kind of point-for-point 
correlation of the raw data with the wavelet.  
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It becomes clear here why the selection of a suitable mother wavelet is important for the 
desired analysis in this approach. Both of the wavelets shown above will show a high 
correlation at precisely those raw data points or segments that correspond to the time-
frequency characteristic of the wavelet (thus, in this case, at local, steep rises with a particular 
time-voltage characteristic). 

But how can different frequency ranges be analyzed in this way? This is where it becomes 
evident that the CWT is closely related to the DWT. After the initial analysis step of the wavelet 
with all the points in the raw data set, the wavelet is widened by a small amount or “scaled”. 
Consequently, we talk about “scales” rather than frequencies in connection with the CWT, and 
the mother wavelet has a scale of s=1. However, widening the wavelet also means that when 
the data is filtered again with the wavelet, other, slower frequency components result in a 
higher correlation of the raw data with the wavelet.  

This is then carried out for the entire frequency band required and for the required number of 
scales. For each scale, a vector of wavelet coefficients is calculated that contains the time-
frequency behavior of the raw signal for the corresponding scale.  

Because the change to the wavelet in the case of the CWT is referred to as a change to the 
wavelet scale rather than to the wavelet frequency, the representation of the time-based 
section of data against the successively slowed frequency content is referred to as a 
“scalogram”. The scales of the wavelet calculation can, of course, be converted into 
corresponding frequency ranges again. Consequently, the wavelet results in the Analyzer can 
be displayed in a time-frequency chart again. 

On account of the scaling of the mother wavelet, it is important that there is an interaction 
between the time resolution and frequency resolution in the case of the CWT, just as there is 
with the DWT. At lower scale values (i.e. in the analysis of higher frequencies), the resulting 
wavelet coefficients have a good time resolution but a poor frequency resolution. At higher 
scales (i.e. in the analysis of lower frequencies), on the other hand, wavelet coefficients with a 
good frequency resolution but a poor time resolution are obtained.  

You will find more information on wavelet analysis in [LMR98], for example, from which the 
algorithm used for the discrete Wavelet transform was obtained.  
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No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Frequency and 
Component Analysis > Wavelets. 

 

Figure 12—63 Initial dialog box for the Wavelet transform 

 

In the Wavelet Transformation Methods group box, you can choose a discrete Wavelet 
transform (Discrete Wavelet Transformation), an invertible discrete Wavelet transform 
(Invertible Discrete Wavelet Transformation) or a continuous Wavelet transform 
(Continuous Wavelet Transformation). 

 

Moreover, you can specify for the discrete and continuous Wavelet transform which of the 
following are output: 

• The Wavelet coefficients (if you clear the check boxes) 

• Their absolute values (if you select the Calculate Absolute Values check box) 

• The power values, the square of the absolute values (if you select the Calculate 
Power Values check box)  

Procedure 
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The calculation of absolute coefficient values makes sense, for example, if you want to average 
the wavelet coefficients calculated from segmented data and are not interested in the polarity 
of the original signal, only in its spectral composition. 

A striking example of this involves investigating the EEG for induced versus evoked activity in a 
frequency range. The only factor of interest in terms of the induced activity is the absolute 
extent of the frequency activity. Its time (phase) position, on the other hand, is not of interest. 
However, it is precisely these phase differences in the presence of induced activity that are 
eliminated by averaging the data for an evoked potential. This means the Wavelet transform of 
the evoked signal only contains the evoked wavelet activity. The behavior is the same when 
calculating power values. 

 

If you select the discrete Wavelet transform, the Next button takes you to the Discrete 
Wavelet Transformation dialog box. 

 

Figure 12—64 Discrete Wavelet Transformation dialog box 

 

The Wavelet drop-down list allows you to specify the wavelet type for the discrete transform. 
You currently have the choice between the Haar wavelet and Daubechies wavelets of various 
filter lengths.  
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In the Start Level and End Level text boxes, you specify the frequency ranges (or transform 
levels) to be analyzed. A level 1 transform generates high frequency components (between half 
and a quarter of the sampling rate) at a high resolution. Higher levels generate lower-frequency 
components at a lower resolution. The frequency is halved from level to level. 

Like the continuous Wavelet transform, the discrete Wavelet transform also creates the 
transformed data in the form of a two-dimensional data field, where one dimension represents 
the time domain and the other dimension represents the logarithmically scaled frequency 
domain. The data values are displayed color-coded in a rectangular area in the Analyzer. 

Note that the specified limits are only guidelines. Because the discrete Wavelet transform 
works with filter methods, the components of a frequency of the EEG do not fall 100% into a 
single scale (frequency step); they also occur in neighboring scales in a very weakened form. 

 

If you select the invertible discrete Wavelet transform, the Next button takes you to the 
Discrete Wavelet Transformation dialog box. 

If the data to be processed is segmented data, you are taken to the Window Function dialog 
box in a second step. 

 

Figure 12—65 Discrete Wavelet Transformation – Window Function dialog box  
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Select a radio button (No Window, Hanning Window or Hamming Window), and specify the 
window width in the Window Length [%] text box. The window function is applied to the data 
before the Wavelet transform is executed. 

The window function processing step must be carried for the invertible discrete Wavelet 
transform for the same reason as for normal spectral analysis. In both cases, data ranges of a 
finite length are used in wavelet analysis. In the case of the transform, this would lead to 
discontinuities that would make it impossible to perform a complete reverse transform of the 
signal. 

 

If you select the continuous Wavelet transform, the Next button takes you to the Continuous 
Wavelet Transformation dialog box. 

 

 

Figure 12—66 Continuous Wavelet Transformation dialog box 

 

From the Wavelet drop-down list box, you choose the real Morlet wavelet, the complex Morlet 
wavelet or the Mexican hat wavelet as the basic wavelet. 

In the Minimal Frequency [Hz] and Maximal Frequency [Hz] text boxes, you specify the lower 
and upper frequency limits for the calculation. In the Frequency Steps text box, you specify 
the number of frequency steps for which the wavelet function is to be calculated.  
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40 frequency steps have proved to be practical for the usual representations of the entire EEG 
spectrum. As the number of frequency steps rises, however, the processing time becomes 
longer because the wavelet function is calculated separately for each frequency step. 

If you select the Linear Steps Instead of Logarithmic check box, the scaling shown in the 
frequency domain is linear. 

In the Morlet Parameter c text box, you specify the Morlet parameter c. This parameter affects 
the width of the envelope of the Morlet wavelet. 

 

Under Scales, you specify whether the scale limits are interpreted statistically (Gauss Borders 
(Standard Derivation)) or in a signal processing sense (Filter Borders). Consequently, the 
Low and High columns in the table are updated automatically. These specifications have no 
effect on the calculation of the wavelets. 

The Time Domain and Frequency Domain boxes display the wavelets in the time and 
frequency domains. 

The buttons  and  allow you to adjust the display of the graphs. 

The frequency ranges covered by the scales (frequency steps) cannot always be easily worked 
out in the case of the continuous Wavelet transform. Consequently, they are listed in the table 
to provide orientation. If you change the frequency range to be analyzed or the number of 
frequency steps, this table is automatically updated. 

As with the discrete Wavelet transform, the limits of the scales should be viewed only as 
guidelines. The Wavelet transform actually distributes a given frequency over the frequency 
range in the form of a more or less bell-shaped curve. The actual shape of the curve depends 
on the wavelet used. As with filters, the information in the dialog box therefore applies to the 
range in which the effect of the frequencies is strongest. Consequently, the overlapping of the 
boundaries shown in figure 12—62 is normal. If the ranges do not overlap, you have to expect a 
loss of information. In this case, you should select more scales. 

The frequency distribution of the wavelet function is nearly Gaussian in shape. The frequency 
limits in figure 12—62 are therefore shown as Gaussian or filter limits (68% or 71% of the signal 
amplitude at the wavelet’s central frequency). Figure 12—67 below shows examples of these 
limits for the Morlet and the Mexican hat wavelet. 

 
Figure 12—67 Filter limits of the Morlet wavelet (left) and Mexican hat wavelet (right)  
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The filter limits of the Morlet wavelet run symmetrically on either side of the central frequency, 
whereas the filter limits of the Mexican hat wavelet are slightly asymmetrical and offset to the 
left. The standard deviation of this function for the Morlet wavelet for a parameter c is 1/c. 
Consequently, the ratio of the frequency to the standard deviation is exactly c. The ratio of the 
filter frequency to half the filter width c’ for the Morlet wavelet is calculated with c’ = 1,2c. 

Unfortunately, the Morlet wavelet is not a wavelet in the sense of the actual wavelet definition. 
This explains why in many articles a value for c of at least 5 is required for the Morlet wavelet 
so as to guarantee at least an approximation to that of the Wavelet definition and to ensure 
further regularity properties. Alternatively, a correction term is also sometimes added to the 
underlying e function. In practical usage, the exact value of c is less important due to the 
numeric calculation. However, it can be used to make accurate statements about the frequency 
bands used: 

Take, for example, a Morlet wavelet with c = 5. At the filter frequency of 20 Hz, this results in a 
drop in the signal to 61% at the limits 16 Hz and 24 Hz (standard deviation) and a drop to 71% 
at the limits 23.3 Hz and 16.7 Hz (filter width). However, this does not mean that other 
frequencies are no longer contained in the wavelet-transformed signal. They are merely 
weakened, as can be seen in the figure above. 

If you change the value of the parameter c in the dialog, the width of the wavelet frequency 
functions displayed inevitably changes as well. As a general rule, a steeper frequency function 
of a wavelet at the same central frequency (i.e. with the parameter c getting higher) is 
associated with a poorer time resolution. You can easily reproduce this in the dialog by 
changing the parameter. 

It also follows from the above that a wavelet scale with a lower central frequency has, in 
absolute terms, a smaller standard deviation in the frequency distribution. On the other hand, 
the time resolution is comparatively poor. This can be illustrated very effectively by moving the 
vertical red line in the frequency distribution chart in the lower right part of the dialog box. As 
the frequency falls, the wavelet shown in the box in the upper right part of the dialog box 
becomes longer. 

This display is extremely useful for analyzing EEG data using wavelets, since the task, after all, 
is to find the optimum ratio between frequency and time resolution for the scales of interest. 
This can be achieved easily using the parameter c and the two boxes in the dialog box with the 
frequency and the time resolution of the resulting wavelets. 

The “natural” arrangement of the central frequencies of the scales between the upper and 
lower ends of the frequency band for wavelet analyses using frequency ranges is logarithmic 
and thus corresponds to the dyadic function of the discreted continuous wavelet function used 
here. 

However, what is often required is even, linear sampling of the spectrum rather than complete 
coverage of the frequency band between the upper and lower ends of the band. This can be 
achieved using the “Linear Steps instead of Logarithmic” option. A frequency band from 20 to 
50 hertz, sampled in 7 steps, would thus result in six wavelet functions with central 
frequencies of 20, 25, 30, 35, 40, 45 and 50 hertz instead of the central frequencies of 20.0, 
23.3, 27.1, 31.6, 36.8, 42.9 and 50 hertz applicable in the logarithmic arrangement.  
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If the data to be processed is segmented, the Normalize and Baseline Correction dialog box 
appears. 

 

Figure 12—68 Normalization and baseline correction of the wavelet transform 

 

Prior to convolution, the Wavelet function can be normalized with one of three normalization 
methods implemented in the Wavelet Transformation in order to select the type of data the 
wavelet function is meant to return during convolution with the data.  

You can specify whether the wavelet data is to be normalized (Enable Normalize) or whether 
baseline correction of the wavelet coefficients is to be carried out (Enable Baseline 
Correction). 

For both normalization and baseline correction, you can specify the time interval or data point 
interval for which the operation is to be carried out (Based on Time / Based on Data Points). 
You specify the beginning, end and length of the interval in milliseconds or data points. 

Under Wavelet Normalization, you choose which method is used to normalize the wavelet 
function by selecting one of the following ratio buttons: 

• Instantaneous Amplitude (Gabor Normalization): In close analogy to the Gabor 
Transform, the Wavelet Transformation directly returns the instantaneous 
amplitude of the wavelet analyzed signal if the wavelet function is normalized 
with the Gabor Normalization factor Aw. The formula used for this normalization 
is: A(ω)= Sqrt(2/π) / σT   

Continuous Wavelet 

transform: 

normalization and 

baseline correction 



 
Wavelets 12.3.3 

 
 
 

 
BrainVision Analyzer  12.3.3—- 12 - 

• Uniform Scale Power (Unit Energy Normalization): This method normalizes the 
wavelet function to have the same energy of 1.0 at all scales (unit scale energy). 
In this case, the wavelet power spectra of an analyzed signal are then directly 
comparable to each other across all scales. The formula used for this 
normalization is: A(ω)= 1 / (Sqrt(σT) * π ^(1/4)) 

• Relative Wavelet Power (Unit Scale Power to Sample Rate): This normalization 
method was the default method implemented in BrainVision Analyzer since 
Analyzer version 1.04. It is equivalent to the above Uniform Scale Power, except 
for an additional normalization with the square root of the sample frequency. 
With this normalization Wavelet scales thus have unit scale power across all 
scales and the resulting wavelet amplitude or power values will be reported 
relative to the sample rate. The formula used for this normalization is:  
A(ω)= 1 / (Sqrt(σT) * π ^(1/4)) * Sqrt(SampleFreq) 

If you select normalization, the wavelet coefficients are normalized to a total of 100 in the 
selected range for each scale (frequency step). This permits relative comparisons of the 
activities between conditions or test groups to be carried out. 

If you select baseline correction, the average value of the wavelet coefficients in the specified 
time range is calculated for each scale and deducted from all the wavelet coefficients in the 
entire time range. In this way, as with the analysis of time-based data, existing baseline 
activities can be obtained from the data before the experimental stimulation in order to get 
stimulus-induced changes to the frequency content. 

Note that the normalization and baseline functions can be used at the same time, but not over 
the same time ranges. This is because, by definition, a baseline function sets the total of the 
values in the defined time range to 0. If a normalization function were to be carried out at the 
same time, it would attempt to define this total of 0 as 100%. Purely due to the finite accuracy 
of the numeric results of the baseline function, completely nonsensical values would be 
calculated, although no errors would occur. The module therefore issues a warning when the 
same time ranges are entered for the normalization and baseline functions. The normalization 
and baseline ranges can, of course, overlap. Indeed, there may be very good reasons for 
making them overlap. 

 

 

[LMR98] A.K. Louis, P. Maaß, A. Rieder, Wavelets: Theorie und Anwendungen, Teubner, 
Stuttgart, 1998. 
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12.3.4 Inverse FFT 
 
 

The inverse FFT allows data to be converted back from the frequency domain to the time 
domain. This is generally desirable when artifacts or parts of the EEG that are not required can 
be removed more easily from the frequency-transformed data, but further processing is to take 
place in the time domain. A typical example of this is the use of user-specific filters, which is 
considerably easier and clearer in the frequency domain. 

 

The inverse FFT is typically used after: 

• Segmentation 

• The FFT 

 

To enable a Fast Fourier transform to be inverted accurately, you have to make certain 
parameter settings in the FFT dialog box: 

• Select the Voltage radio button. 

• Select the Produce Complex Output check box. 

• Do not select the Normalize Segments check box. 

 
We also recommend that you do the following things: 

• You should select the No Window radio button. If you do not do this, the output 
data of the inverse FFT is multiplied with the window function. 

• You should not select the Use Compression check box. This is because the data 
can no longer be recovered in its entirety following compression; only an 
approximation is possible. 

• You should not select the Other Resolution radio button. If you do, the inverse 
FFT can only restore the data converted by an interpolation process at a different 
sampling rate.   

Summary 

Prerequisite for use 

Settings in the FFT 

dialog box 
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Figure 12—69 Fast Fourier Transformation dialog box, parameter settings for the inverse 

FFT 

 

Once you have made the required settings in the Fast Fourier Transformation dialog box, you 
display the dialog box for the inverse FFT by choosing Transformations > Frequency and 
Component Analyses > FFT inverse. 

 

 

Figure 12—70 Inverse FFT dialog box  
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You can make the following settings: 

 
Because the Analyzer’s FFT adds the value 0 to segments whose length is not a power of 2, you 
can specify a pruning parameter in the FFT Segment Pruning group box. This value determines 
the length to which the segment is truncated in the time domain. 

There are four radio buttons for the pruning parameter: 

• No Segment Length Pruning: The segment is not truncated, and any zeros 
added are retained. 

• Prune Based on Time: You can enter a value for this. 

• Prune Based on Data Points: You can enter a value for this. 

• Prune Automatically: The invertable FFT stores the invisible information about 
the original length of the segments (i.e. before zeros were added to the data set) 
in the data set node. 

 
For each channel and segment, the FFT stores in the data set node a value that is required for 
the execution of the inverse FFT. For this reason, the number of segments, the number of 
channels and the channel sequence must not be changed by the transforms executed between 
the FFT and the inverse FFT. Otherwise, it is no longer possible to assign the value to the 
appropriate channel or segment. 

By default, the required data is calculated at runtime without any intermediate storage. 
However, if you select the Store Data in History node check box, the data is saved in a history 
node in order to optimize the performance of subsequent modules. 

In addition, if you select the Compress Stored Data check box, the data can be compressed 
with the specified resolution. You can specify the resolution in the Resolution text box. 
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12.3.5 Wavelet Extraction 
 
 

The Wavelet Layer Extraction transform allows you to extract a frequency range (layer) from a 
wavelet data set in order to further process it separately. The data set obtained as a result of 
this transform is a pure time domain data set (contrasting with the time/frequency domain of 
the wavelets). 

 

The transform is used after: 

• The Wavelet transform 

 

To display the dialog box for the transform, you choose Transformations > Frequency and 
Component Analysis > Wavelet Extraction. 

 

 

Figure 12—71 Extraction dialog box for selecting a layer 

 

In the Layer text box, you specify the layer to be extracted from the data set for further 
processing. 

The table lists the layers with their filter limits. 
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12.3.6 PCA (Principle Component Analysis) 
 
 

This is a secondary transform. In other words, it stores its results in the current workspace as 
secondary history files. 

 

The Principal Component Analysis transform is used, on the one hand, to reduce the volume of 
data and, on the other, to extract hypothetical variables that permit a data set to be 
characterized. It groups together covariant variables of a data set that can be interpreted as a 
single factor. 

 

You can use BrainVision Analyzer 1.0 to open PCA nodes created using BrainVision Analyzer 
2.0 without problems. However, this is not possible unless at least one of the data nodes on 
which the PCA calculation is based are in the workspace. In contrast, the PCA nodes created 
using Analyzer 2.0 supply data after their generation regardless of the existence of other 
nodes. 

In addition, the behavior of Analyzer 1.0 PCA nodes differs from that of Analyzer 2.0 PCA nodes 
with regard to the data forwarded to child nodes. The Analyzer 2.0 nodes forward the PCA 
components segment by segment. The Analyzer 1.0 forwards only the loadings as standard 
data (i.e. as graphs). 

 

If you are using segmented, averaged, ... data, you can only apply the transform when all the 
segments – even those from different data sets – have the same length. 

If you are using non-segmented data, the data must be of a uniform length (in this case, each 
data set is viewed as a single segment).  

Summary 
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To display the dialog box for the transform, you choose Transformations > Frequency and 
Component Analysis > PCA. 

 

 

Figure 12—72 PCA dialog, page 1 

 

If you select the Variables at Channels radio button, the channels are interpreted as 
variables. If you select the Variables at Time Points radio button, the points in time are 
interpreted as variables.  

If you have selected the Variables at Time Points radio button, the Condense Time Domain 
With a Factor of: check box and associated text box have a special significance. If you select 
this check box, the time domain is subdivided into groups of points of equal length. The length 
of each group corresponds exactly to the value in the Condense Time Domain With a Factor 
of: text box (the value in the text box is always in the range 1 to 1000). Consequently, the 
length of the time domain in points is reduced by this factor, and the sampling interval is 
increased by this factor. The use of a condensing factor thus reduces the volume of data and 
accelerates processing. 

If you select the Use VARIMAX Rotation check box, an optional method is used to rotate the 
inverse of the covariance matrix in its space. The purpose of this rotation is to make the 
differences between PCA components clearer. 

In the Output File text box, you can specify the name of the node in the secondary history files 
that contains the result. 

Click the Next button to go to the second page of the dialog:  

Procedure 
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Figure 12—73 PCA dialog, page 2 

 

The Select History Files group box allows you to select the history files included in the PCA. If 
you select the Use Whole Workspace radio button, the history nodes are searched for in both 
primary and secondary history files. If you select the Select Individual History Files radio 
button, on the other hand, you can select specific history files. 

If you select the Primary History Files Only check box, the list of selected node names 
contains only the node names of primary history files. 

In the Selection Filter text box, you can specify a filter to be used to search through the history 
file names. The placeholders “?” (for an unknown letter) and “*” (for an unknown part of a 
word) are available to you for this. If you click the Refresh button, the filter is applied to the list 
on the left, which contains the names of the history files. 

 

You then make a selection from the history file names contained in the list on the left. The 
Enable, Disable, Enable All and Disable All buttons allow you to change your selection. 

Click the Next button to go to the third page of the dialog.  
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Figure 12—74 PCA dialog, page 3 

 

On the third page of the dialog, you select the names of the history nodes. 

In the Selection Filter text box, you can specify a filter to be used to search through the history 
file names. The placeholders “?” (for an unknown letter) and “*” (for an unknown part of a 
word) are available to you for this. If you click the Refresh button, the filter is applied to the list 
on the left, which contains the names of the history nodes. 

The Enable, Disable, Enable All and Disable All buttons allow you to change your selection. 

Click the Next button to go to the fourth page of the dialog.  
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Figure 12—75 PCA dialog, page 4 

 

The Channel Names group box contains a list of the channel names of the first node found 
and a list of the selected channel names. The Enable, Disable, Enable All and Disable All 
buttons allow you to change your selection. 

 

Click the Next button to go to the fifth page of the dialog.  

Channel Names 

group box 
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Figure 12—76 PCA dialog, page 5 

 

In the Eigenvalue Selection Criteria group box, you select the criterion to be used to calculate 
the eigenvalue: 

• Take Eigenvalue 1 as Limit includes all eigenvalues greater than 1. 

• Take Eigenvalue Limit includes all eigenvalues greater than the value entered in 
the associated text box. 

• Take a Fixed Number of Eigenvalues selects the n largest eigenvalues, where n 
is the value in the associated text box. 

• Take Percentage of Total Variance includes the largest components in terms of 
variance (eigenvalues), whose sum exceeds the percentage entered in the 
associated text box (the text box can contain any value from 1 to 1000). 

When you have finished, click Finish. 

A new history file with the corresponding name appears on the Secondary tab of the History 
Explorer. If the Secondary tab already contains a file with an identical name, it is replaced with 
the new file.  

Eigenvalue Selection 

Criteria group box 
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A specific view appears with a Semiautomatic View dialog box on the right. 

 

 

Figure 12—77 Specific PCA view 

 

In secondary history files calculated with the “Variables at Channels” radio button selected, 
the components are displayed as graphs and the loadings as head topographies.  
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Figure 12—78 Display of the components as graphs when “Variables at Channels” is 

selected 

 

 

Figure 12—79 Display of the loadings as head topographies when “Variables at Channels” is 

selected 

 

In the corresponding secondary history files calculated with the “Variables at Time Points” 
radio button selected, the components are displayed as head topographies and the loadings 
as graphs.  
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Figure 12—80 Display of the components as head topographies when “Variables at Time 

Points” is selected 

 

Figure 12—81 Display of the loadings as graphs when “Variables at Time Points” is selected 

 

The box in the upper part of the Semiautomatic View dialog box contains all the history nodes 
used. You can switch between these nodes with ease in order to switch between different 
views of the components. 

If you select the Show All Segments radio button, all the segments of the history node 
selected in the box above are displayed. If you select the Show Segment radio button, you can 
use the associated drop-down list to select a segment to be displayed.  
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In the drop-down list, you can specify what is to be displayed by choosing Components or 
Loadings. 

If you choose Loadings, the controls above the drop-down list become unavailable. This is 
because the loadings correspond to the lines of a square root of the inverse of the shared 
covariance matrix. Consequently, these loadings are identical for all segments and all selected 
data sets. 

If graphs are displayed, the Clear Overlays button is also available to you for removing any 
overlays that have been created. Note that overlays can only be created with the channels in 
the grid view. 

If topographic heads are displayed, an additional group box appears. This contains the Show 
Only One Map check box, which allows you to limit the display to only one map. The 
associated drop-down list always contains the names of the head topographies that are 
currently being displayed: 

 

Figure 12—82 Additional function: “Show Only One Map” 

 

 

A data set created by means of the “Variables at Channels” radio button is referred to as a data 
set of the type “Components”. A data set created by means of the “Variables at Time Points” 
radio button is referred to as a data set of the type “Loadings”. 

Each history node created by the PCA transform consists of two interlinked data sets: one of 
the type “Components” and one of the type “Loadings”. In a history node of the type 
“Components”, the underlying data set is of the type “Components”. The additional data set of 
the type “Loadings” takes the form of a set of inserted user properties:   

Remarks 
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Figure 12—83 Properties of a node of the type “Components” (containing the data set of the 

type “Loadings” in the form of user properties) 

 

In history nodes of the type “Loadings”, the reverse applies: 

 

 

Figure 12—84 Properties of a node of the type “Loadings” (containing the data set of the 

type “Components” in the form of user properties)  
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The child nodes of a history node created by the PCA transform are displayed in conventional 
views rather than in the specific PCA view. It is necessary to understand their structure in order 
to be able to navigate in them effectively. The data displayed corresponds to the PCA segments 
in their natural arrangement within a selected node. The segment packages, which correspond 
to different selected nodes, are arranged one after the other in the order in which the selected 
nodes occur. The markers of the type “New Segment”, which define these segments, have 
meaningful names that take the following form: The first “New Segment” marker of a segment 
packet has the expanded name of the original node. All subsequent markers of the type “New 
Segment” have the ordinals 2, 3, 4 and so on as their names. These markers also contain the 
following user properties: “Original Node” and “Original Segment”: 

 

 

Figure 12—85 Marker names  
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Figure 12—86 User properties of the markers (Edit Markers transform) 

 

If you use the PCA transform on non-segmented data, the original data sets become segments. 

In all cases, however, the number of channels of the child nodes corresponds exactly to the 
number of components found by the PCA transform. These have the names P1 to Pn. 

In contrast to the channels of child nodes, the channels are named as follows in the PCA view: 
In data of the type “Components”, the names of the channels take the form k(segn), and the 
loadings are named P1 to Pn. In data of the type “Loadings”, the channels are named P1 to Pn, 
and the names of the head topographies take the form k(segn). 

If you use segmented data containing a time zero marker, these kinds of markers are also 
inserted in PCA components or PCA loadings. 

 

The entire set of data (from all the selected segments and nodes) is used to calculate a 
covariance matrix that corresponds to the selected criterion.  

In principal component analysis, the covariance matrix of all the variables is calculated first. If 
there are n variables, this results in an nxn matrix from which n factors can theoretically be 
extracted. In practice, however, you limit yourself to a number whose variance is greater than a 
specific limit in order to eliminate effects such as those caused by noise from the calculation. 

Method 
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If the number of desired factors is m, the m largest eigenvalues and the associated 
eigenvectors are calculated from the covariance matrix.  

The factor loadings are obtained from the product of the root of the eigenvalue and the 
eigenvector. From the factor loadings, the associated component is calculated for each value 
of a variable in such a way that the sum of the products of the component and factor loading 
approximate the value of the variable to optimum effect. 

The covariance matrix is a square matrix whose size corresponds to the number of channels 
when the “Variables at Channels” radio button is selected or to the number of points when the 
“Variables at Time Points” radio button is selected. Consequently, the user must select 
channels that are present in all the selected data or have carried out segmentation and 
calculated averages using the same segment length each time. (Otherwise, error messages are 
displayed.) 

When variables are selected as points in time, the variables take on different values depending 
on the channel, the segment and the EEG file. When variables are selected as channels, the 
values depend on the point in time, the segment and the EEG file. 

The covariance matrix, which is always a symmetrical, real, positive-definite matrix, is 
diagonalized using the Lagrange method. The diagonal elements are referred to as the 
eigenvalues of the matrix. The largest eigenvalues are selected using the selection criterion 
selected in the dialog, and the part of the covariance matrix that meets this criterion is 
retained. 

Using the theory of symmetrical, real, positive-definite matrices, a square root of the inverse (of 
the relevant part) of the covariance matrix is calculated. The columns of this matrix are known 
as loadings. However, this method of breaking down the variables is just one of many. A direct 
result of the construction of the loadings is that they are orthogonal, although this is not 
required on physiological grounds. For this reason, the results of the Principal Component 
Analysis transform are often rotated subsequently in the hope of obtaining data that better 
corresponds to the physiological facts. The results of the Principal Component Analysis 
transform with or without rotation should never be accepted uncritically; you should always 
subject them to a scientific examination. 

If the “Variables at Channels” radio button is selected, the loadings are vectors whose length 
corresponds to the number of channels, and they are displayed as head topographies. If the 
“Variables at Time Points” radio button is selected, the loadings are vectors whose length 
corresponds to the number of points, and they are displayed as EEG graphs. 

The loadings matrix is multiplied out individually with each EEG segment as a matrix. The result 
of this multiplication is referred to as a PCA component. If the “Variables at Channels” radio 
button is selected, the PCA components are vectors whose length corresponds to the number 
of points, and they are displayed accordingly as EEG curves. If the “Variables at Time Points” 
radio button is selected, the PCA components are vectors whose length corresponds to the 
number of channels, and they are displayed as head topographies. 

 

 

[RM81] F. Rösler, D. Manzey, Principal Components and VARIMAX-Rotated Components in 
Event-Related Potential Research: Some Remarks on Their Interpretation. Biological Psychology 
13 (1981), 3-26. 
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12.4 Transforms in the Segment Analysis Functions group 
 
 

12.4.1 Peak Detection 
 
 

The Peak Detection transform is for detecting and marking peaks. Peaks are local minimum or 
maximum values in an averaged EEG. 

The transform allows you to specify peaks in a table, together with their name and range. You 
also have to specify whether the peak is positive or negative. You can select specific channels 
where the peaks are to be marked. 

 

The Peak Detection transform is typically used after: 

• Average 

 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > Result Evaluation > Peak Detection. 

 

 

Figure 12—87 Peak Detection dialog, first page  
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In the Automation Methods group box, you specify whether peak detection is to be carried out 
in semiautomatic mode (Semiautomatic Detection radio button) or automatic mode 
(Automatic Detection radio button). 

In semiautomatic detection, a cursor appears at the point at which the algorithm finds a peak. 
You can use this cursor to change the position of the peak manually. 

 

In the Detection Methods group box, you select the peak search method. 

• If you select the Search for Global Maxima in Interval radio button, a search is 
carried out for the global maximum (or minimum) in a set interval. 

• If you select the Search for Local Maxima in Interval radio button, a search is 
carried out for a local maximum. 

• If you select the Search for Weighted Local Maxima in Interval radio button, a 
search is carried out for a weighted local maximum. 

The difference between a local and global maximum is that, in the search for a global 
maximum, the edge points of the intervals are found as peaks if the value there is greater (or 
less) than all the values within the interval. 

In the search for local maxima, extreme values are searched for within the interval. The edge 
values are only included if this initial search is unsuccessful. 

Since several local maxima can occur in an interval in certain circumstances, it is possible to 
weight them during selection. When this method is used, all maxima that are found are 
multiplied by the weighting factor 1-a*t*t, and the highest value is then searched for. The value 
“t” is from the interval [-1, 1] and describes the variance of the position of the data point from 
the middle of the search interval. The value “a” can be entered in the Weight text box. The 
value can be in the range from 0 to 1. 

If the weighting is 0, the weighted method is identical to the unweighted method. If the 
weighting is greater than 0, peaks that are closer to the middle of the interval have a higher 
weighting than peaks at the edges of the interval. However, the peaks found are still all local 
maxima of the voltage distribution. The weighting function only has an impact on the selection 
of peaks when there are several possible local maxima, not on their position or size. 

 

 

In the Searching Methods group box, you can choose between two different methods for 
settings markers: 

• If you select the Separate Search for Every Channel radio button, the search for 
peaks and the setting of markers is carried out separately for each channel 
selected. 

• If you select the Search Peak in a Reference Channel and Set Markers with 
Respect to this Peak radio button, the search for peaks is carried out only in a 
specified channel. In all the selected channels, the peaks are marked at the 
position at which they are found in the specified channel. 

The detected peaks are output as markers of the type “Peak”.  

Automation Methods 

group box 

Detection Methods 

group box 

Searching Methods 

group box 
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On the second page of the dialog, you enter the peaks you want to search for. 

 

 

Figure 12—88 Peak Detection dialog, second page, Separate Search for Every Channel radio 

button selected 

 

You can make the following settings: 

• In the Name cell, you enter the name of the peak (“p300” and “n50” in our 
example). 

• In the Start [ms] and End [ms] text boxes, you specify the length (i.e. the 
beginning and end) of the interval in which you want to search for peaks. 

• The Polarity drop-down list allows you to specify the polarity (positive or 
negative) of the peak. 

• If you selected the Search Peak in a Reference Channel and Set Markers with 
Respect to this Peak radio button on the first page of the dialog, you can use the 
Reference Channel drop-down list to specify the reference channel to be 
searched for. 

• The Color cell indicates the color in which the peak indicator is displayed in the 
semiautomatic search. To assign a color to a peak or change the color selected, 
click the relevant cell. A color selection dialog box appears. 

• The Insert Line, Remove Line and Remove All buttons allow you to add rows to 
the table and delete them again either individually or all together. 

 

On the third page of the dialog, you select the channels in which the peak marker is to be set.  

Separate Search for 

Every Channel radio 

button 
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Figure 12—89 Peak Detection dialog, third page, Separate Search for Every Channel radio 

button selected 

 

If you selected semiautomatic peak detection, the semiautomatic view appears. This permits 
fine adjustment of the peaks detected. 

 

Figure 12—90 Extract from a semiautomatic peak detection dialog, second page, Separate 

Search for Every Channel radio button selected  
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The drop-down list box at the top of the temporary semiautomatic view dialog box allows you 
to select the active channel. An active channel is highlighted in orange (like the channel “AF2” 
in our example). 

If you click the corresponding row of the table, a section highlighted in gray appears that 
indicates the search interval set for the peak. 

If you double-click a row, the associated peak cursor turns into a movable slider. You can use 
the mouse to move this slider into the ideal position. You can cancel the operation by pressing 
the <Escape> key. The slider turns back into the peak cursor. 

Alternatively, you can display the gray highlighting and the slider by clicking the peak cursor. 
This also activates the corresponding channel. 

The Undo and Redo buttons allow you to undo and redo changes, respectively. 

If you want to interrupt what you are doing and resume later, you click the Suspend button. 
The Data Inspector transform is highlighted in red in the list of history nodes, and all the 
processing steps carried out continue to apply. 

You click the OK button to conclude your entries. 

 

If you search a fixed reference channel for peaks, the table on the second page of the dialog 
also contains the Reference dialog box. You can select the reference channel from the 
associated drop-down list. 

 

 

Figure 12—91 Peak Detection dialog, second page, Search Peak in a Reference Channel radio 

button selected  

Search Peak in a 

Reference Channel 

radio button 
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On the third page of the dialog, you select the channels in which the peak marker is to be set 
(as for the Separate Search for Every Channel radio button). 

If you selected semiautomatic peak detection, the semiautomatic view dialog box appears. 
This permits fine adjustment of the peaks detected. 

Note that there is no drop-down list allowing you to select a channel in the semiautomatic 
view. 

 

Figure 12—92 Extract from a semiautomatic peak detection dialog, Search Peak in a 

Reference Channel radio button selected 
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12.4.2 LRP (Lateralized Readiness Potential) 
 
 

The LRP transform calculates the lateralized readiness potential (LRP) from two data sets (e.g. 
movements of the left and right hands). 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > Result Evaluation > LRP. 

The first step is to create two data nodes. You should segment the first node based on the first 
condition (e.g. movement of the left hand) and the second node based on the second 
condition (e.g. movement of the right hand). In the second step, you obtain an average for both 
nodes. 

 

Figure 12—93 LRP, selection dialog for the second data set 

 

The LRP transform then calculates the lateralized readiness potential and writes the result to 
new channels whose names take the following form: LRP(., .). To run this calculation, you begin 
by selecting the path of the second data set in the dialog.  

Summary 

Procedure 
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The structure of the selection tree in the dialog is like the Analyzer’s history tree. You select the 
path by clicking the node. You can search for the node by expanding certain parts of the tree 
using the buttons on the right-hand side of the dialog box. 

In addition, you can use the Keep Channels of Parent check box to specify whether the 
channels of the parent node are to be included in the new data set or whether the new data set 
is to consist of LRP data only. If you double-click the selected node or click the Next button, the 
second page of the dialog appears, in which you can select the channels for the LRP. 

 

Figure 12—94 LRP, selection dialog for the channels 

 

When the LRP is calculated, the difference between contralateral and ispsilateral electrodes in 
the parent node and the corresponding reverse difference in the second node are formed, and 
the average of these two differences is calculated. The two left-hand columns of the channel 
list are therefore assigned to the first data node (parent), and the two right-hand columns are 
assigned to the second data node. 

It is generally sufficient to fill the two left-hand or two right-hand columns. The dialog then 
searches for the corresponding channels in the other data set and fills the other columns 
accordingly when suitable channels are found. You can also modify these entries. If no suitable 
channels are found, you have to fill all columns manually. 

When all the columns of the required rows are filled correctly, you conclude your entries by 
clicking the Finish button. The LRP is calculated. The structure of the LRP channels is also 
described in the operation information. 
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The following example illustrates how entries are made: 

In an experiment, a warning stimulus tells the subject which hand to use in response to a 
subsequent imperative stimulus. The warning stimulus, imperative stimulus and response (left 
hand, right hand) are stored as markers in the raw EEG. The Segmentation transform and 
advanced Boolean expressions are used to create two segmented data sets (nodes). One node 
corresponds to the response with the left hand, and the other to the response with the right 
hand. You will find more information on this in section 12.4.5, “Segmentation”. 

An average is calculated for the two nodes, and the average nodes are given meaningful names 
(e.g. Avg left, Avg right). The LRP data is to be created as subnodes of the “Avg left” node. 
Consequently, the LRP module is applied to this node. The “Avg right” node is selected as the 
second data set. The LRP is to be calculated, for example, for channels C3 and C4 (i.e. C4 - C3 is 
calculated for “Avg left” and C3 - C4 for “Avg right”). These differences are then averaged. Thus, 
C4 is entered in the first column and C3 in the second column. The channel names C3 and C4 
appear in the third and fourth columns. After the calculation, a channel named LRP(C4,C3) 
appears. This is the result of the formula (C4(left) – C3(left) + C3(right) – C4(right)) / 2. 

 

 

You will find further information on lateralized readiness potential in: 

[SUL96] W. Sommer, R. Ulrich, H. Leuthold, Das Lateralisierte Bereitschaftspotential als 
psychophysiologischer Zugang bei der Untersuchung kognitiver Prozesse. Psychologische 
Rundschau, 47 (1996) 1-14. 
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12.4.3 ERS/ERD (Event-Related Synchronization/Desynchronization) 
 
 

The ERS/ERD transform is for the analysis of the event-related course of individual frequency 
bands of the EEG. 

 

This transform is typically executed after:  

• Segmentation 

• Baseline correction (optional) 

• Bandpass filtering (optional) 

 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > Result Evaluation > ERS/ERD. 

 

Figure 12—95 ERS/ERD dialog box  
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You make the following settings before running the ERS/ERD transform: 

 

If you select the Use Filter check box, filters are used. In the Filter Frequency [Hz] and Filter 
Bandwidth [Hz] text boxes, you specify the filter frequency and bandwidth. 

If you have already carried out bandpass filtering, it is not necessary to select the Use Filter 
check box. 

 

In the ERS/ERD Method group box, you select the method for the processing of the EEG. The 
methods – Instantaneous Power and Intertrial Variance – differ in terms of what happens 
before averaging (see [KP95]). In the case of the Instantaneous Power method, the voltage 
measured is squared before averaging, while the Intertrial Variance involves calculating the 
variance of the signal. 

 

If you select the Show Change Compared to Reference Interval check box, the data is 
specified as a percentage change based on the comparison with the reference interval. 

In addition, you can create a data set for the significance by selecting the Create a Data Set 
for Significance check box. 

The significance is calculated for either ERS (Show Significance for ERS radio button) or ERD 
(Show Significance for ERD radio button). 

 

To configure the reference interval, in the Reference Interval Settings group box you select 
either the Based on Time radio button for a time-based setting or the Based on Data Points 
radio button for a data point-based setting. 

You can also specify that either the mean (Reference Uses Mean radio button) or the median 
(Reference Uses Median radio button) is to be used. 

 

You make the settings for the averaging of the segmented data in the Segment/Channel 
Selection group box, as described in section 12.4.6, “Average”. 

The number of available segments is displayed under Available Segments. 

It is possible to obtain an average for all segments or a selected range of segments by 
selecting either the Use Full Range or Specify Range of Segments button. If you select the 
Specify Range of Segments radio button, you can specify the range of segments to be 
included in the From and To text boxes. 

You can also specify whether only the segments with odd segment numbers (segment 1, 3, 5, 
etc.) or even segment numbers (2, 4, 6, etc.) are to be averaged by selecting the Calculate 
with Odd - Even Segments check box and then selecting the Use Only Odd Segments or Use 
Only Even Segments radio button.  
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Another option is individual channel mode, which you activate by selecting the Enable 
Individual Channel Mode check box. Individual channel mode allows you to run averaging on 
each channel separately. If only one channel in a segment has been marked as bad, the other 
channels are still used for averaging. As a result, the number of segments included in 
averaging may be different for each channel. If you do not select the check box, all segments 
that contain a “bad interval” marker are rejected in their entirety. 

Before you can use individual channel mode, you have to take a number of steps by way of 
preparation. You will find more information on this in section 12.4.6, “Average”. 

 

 

[KP95] J. Kalcher, G. Pfurtscheller, Discrimination between phase-locked and non-phase-locked 
event-related EEG activity. Electroencephalography and Clinical Neurophysiology, 94(1995), 
381-384. 
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12.4.4 Grand Average 
 
 

Grand Average is a secondary transform. It is used to create one or more grand averages from 
different averages. 

The result is stored in secondary history files in the current workspace. 

 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > Result Evaluation > Grand Average. 

 

Figure 12—96 Grand Average dialog box 

 

You can specify the following in the table: 

• In the Name of the Involved History Nodes separated by commas column, you 
specify the names of the data sets involved, separated by commas. 

• In the Output file column, you specify the name of the output files.  

Summary 

Procedure 
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In the Input History Files group box, you can make the following settings: 

• If you select the Primary History Files Only check box, you restrict the list under 
Available Files to primary history files. 

• If you select the Use Whole Workspace radio button, all the available files in the 
workspace are included in the calculation of the grand average. 

• If you select the Select Individual History Files radio button, you can select 
individual history files. 

• In the Selection Filter text box, you specify the selection filter. This filters 
selectable files by means of name criteria. An asterisk (*) stands for one or more 
characters, and a period (.) stands for a single character. If the workspace 
contains the files “Test1H2”, “Test2G” and “Hest5”, for example, the string 
“Test*” filters out the files “Test1H” and “Test2G” (i.e. makes them available). 
The filter “.est*” accepts all three files. Once you have set the filter, you click the 
Refresh button to refresh the selection of available files. 

• All the available files are listed in the Available Files text box. 

• The Selected Files text box contains all the selected files. 

• To select one or more files or remove them from the list of selected files, you 
select them and then click the Add or Remove button. The Add All and Remove 
All buttons do the same for all files. 

In the lower part of the dialog box, you can make the following settings: 

• If you select the Create a Data Set for Standard Deviation check box, an 
additional data set is created. This contains the standard deviation. 

• To activate individual channel mode, you select the Enable Individual Channel 
Mode check box. This check box allows you to include data sets that have 
channels missing in averaging. As a result, the number of segments included in 
averaging can be different for each channel. 

• If you select the Calculate Weighted Average check box, the average nodes 
included in the calculation of the grand average are weighted with the number of 
segments included in them. 

• If you select the Include Selected History Files to Saving Parameters check 
box, the selected history files are stored in the file for the parameters used. 

• You can use the Load Parameters button to load previously saved settings from 
a parameter file and then use or change them. 

• The Save Parameters button allows you to save the settings you have made in 
parameter files so that they can be used again. If you do this, the dialog box that 
appears allows you to save the list of selected files as well as the other 
parameters. 

On completion, the new files appear in the lower part of the History Explorer. 

 

Input History File 

group box 
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12.4.5 Segmentation 
 
 

The Segmentation transform allows you to subdivide an EEG into segments. 

The sections of the EEG data set that do not meet the segmentation criterion are automatically 
suppressed. In other words, the resulting data set appears as a sequence of segments that 
meet the criterion. 

Existing segment boundaries are respected during segmentation. In other words, no new 
segments are created within which another segment boundary is located. 

The result of segmentation can be either a data set with multiple segments or a separate data 
set for each segment calculated. 

In addition, you can also further segment an already segmented data set using additional 
criteria (subsegmentation). We advise you to use subsegmentation when you want to average 
different stimuli in a data set separately having carried out artifact correction beforehand. In 
this case, you select all the stimulus markers first, segment the data set and then carry out 
ocular artifact correction. You can subsegment the resulting corrected data set again 
separately for each stimulus marker. 

 

No previous processing steps are required before the transform is used. To display the dialog 
box for the transform, you choose Transformations > Segment Analysis Functions > 
Segmentation. 

 

Figure 12—97 Segmentation Wizard, page 1  
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You can make the following settings: 

 

In the What kind of Segmentation would you like to be performed? group box, you specify 
the segmentation criterion or type. The following radio buttons are available: 

• Create new Segments based on a marker position: Segmentation is carried out 
relative to a marker position. A start position and an end position must be 
specified for the segmentation. The start and end positions can also be before 
the marker position. You can choose any marker types. 

• Divide data set in equal sized segments: The data set is subdivided into 
segments of the same length. 

• Set new segments manually: You specify the segments manually. 

• Create new segments limited by start and end markers: The beginning and 
end of the segment are defined by markers. 

 

In the How should the data be stored? group box, you specify the storage options for the 
data. The following radio buttons are available: 

• Do not store data, calculate data on demand: The data is not stored. It is 
created on request. 

• Cache data to a temporary file: The data is stored in a temporary file on the hard 
disk. 

• Store data compressed in history file: The data is stored compressed in the 
history node. 

In the Resolution [nV] text box, you can specify the resolution (precision) of the 
compression. 

You will find detailed information on the storage options in the subsection entitled “Additional 
information: storage options” in this chapter. 

Once you have made your selections, the Next button takes you to the second page of the 
wizard. 

 

 

If you selected marker-based segmentation (Create new Segments based on a marker 
position), on the second page of the wizard you select from the list of available markers 
(Available Markers list box) one or more markers to be used for the purpose of segmentation 
(these then appear in the Selected Markers list box). 

In the Advanced Boolean Expression text box, you can enter the selection criteria of the 
advanced Boolean expressions. You can specify marker names together with time windows in 
milliseconds and the operators “not”, “and” and “or”. You will find detailed information on the 
advanced Boolean expression function in the subsection entitled “Additional information: 
advanced Boolean expressions” in this chapter.   

“What kind of 

Segmentation…” 

group box 

„How should the 

data be stored?” 

group box 
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Figure 12—98 Second page of the Segmentation Wizard, marker-based segmentation 

 

Once you have made your selections, the Next button takes you to the third page of the wizard. 

 

 

Figure 12—99 Third page of the Segmentation Wizard, marker-based segmentation 

 

On the third page of the wizard, you specify the relative positions of the interval based on time 
specifications (Based on Time radio button) or data points (Based on Data Points radio 
button). In the Start [ms] and End [ms] text boxes, you specify the beginning and end of the 
interval, and in the Duration [ms] text box you specify its length.   
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(If you make an entry in one of the six text boxes, the values in the other text boxes affected by 
it are adjusted accordingly.) 

If you select the Allow Overlapped Segments check box, overlapping segments are included 
in segmentation. If you do not select this check box, only the first segment of two overlapping 
segments is included. 

If you select the Skip Bad Intervals check box, segments that contain “bad interval” markers 
are not included. The “bad interval” markers are set when the Data Inspector transform is 
used. If you use the Average transform subsequently in individual channel mode (see section 
12.4.6, “Average”), you should on no account select the Skip Bad Intervals check box. 

The Finish button concludes your settings for marker-based segmentation. 

 

If you selected time-based segmentation (Divide data set in equal sized segments radio 
button), you can make the following settings on the next page of the Segmentation Wizard: 

In the Size of Segments group box, you specify the size of the interval for the segment. You 
can specify the interval size in seconds. To do this, you select the Based on Time radio button 
and enter the desired value in seconds in the associated text box. You can also specify the size 
of the interval in points by selecting the Based on Data Points radio button and entering a 
value in the associated text box. 

In the Overlap Segments group box, you can also specify how the segments are to overlap. As 
when specifying the segment’s interval size, you can specify the values in seconds (by 
selecting the Based on Time radio button and making an entry in the associated text box) or 
data points (by selecting the Based on Data Points radio button and making an entry in the 
associated text box). 

If you select the Skip Bad Intervals check box, segments that contain “bad interval” markers 
are not included. 

 

 

Figure 12—100 Second page of the Segmentation Wizard, time-based segmentation  
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Once you have made your selections, the Next button takes you to the third page of the wizard. 

On the third page, you are asked whether you want to create a separate data set for each new 
segment. This allows you to further process each segment separately. 

 

 

Figure 12—101 Third page of the Segmentation Wizard, time-based segmentation 

 

The Finish button concludes your settings for time-based segmentation. 

 
 

If you specified that new segments are to be specified manually (by selecting the Set new 
segments manually radio button), you enter the new segments on the second page of the 
Segmentation Wizard. 

 

 

Figure 12—102 Second page of the Segmentation Wizard, manual specification of segments 

Specifying segments 
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The second page of the wizard contains two tables. The first table (Parent Segment Table) 
contains the segments that already exist in the parent node. You enter the new segments in the 
second table. You can specify the beginning, end and duration of the new segment based on 
time and data points. (If you make an entry in one of the six text boxes, the values in the other 
text boxes affected by it are adjusted accordingly.) 

If a new segment goes beyond the boundary of an existing segment, an error message 
(Segment intersects a parent segment) appears at the edge of the dialog box. If this 
happens, make a new entry. 

The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table and 
delete them again either individually or all together. 

Once you have made your selections, the Next button takes you to the next page of the wizard. 

 

 

Figure 12—103 Third page of the Segmentation Wizard, manual specification of segments 

 

The Finish button concludes your settings for the manual specification of segments.  
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If you specified segmentation based on start and end markers (by selecting the Create new 
segments limited by start and end markers radio button), you select the corresponding 
markers on the second page of the Segmentation Wizard. 

 

 

Figure 12—104 Second page of the Segmentation Wizard, segmentation based on start and 

end markers 

 

You specify the start marker by choosing an item from the Marker which defines the start of a 
segment drop-down list and the end marker by choosing an item from the Marker which 
defines the end of a segment drop-down list. 

If you select the Skip Bad Intervals check box, segments that contain “bad interval” markers 
are not included. 

Once you have made your selections, the Next button takes you to the third page of the wizard. 

 

 

Figure 12—105 Third page of the Segmentation Wizard, segmentation based on start and end 

markers  

Segmentation based 
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On the third page, you are asked whether you want to create a separate data set for each new 
segment. This allows you to further process each segment separately. 

The first start marker found is linked with the first end marker found to form a segment, the 
second start marker is linked with the second end marker and so on. Consequently, it is also 
possible to create overlapping segments. If an end marker is found without a preceding start 
marker, it is ignored. Start markers for which no end marker is found by the end of the data set 
are also ignored. 

 

 

In the case of most transforms, it is not the results that are stored temporarily but information 
that describes the result of the operation. In the case of the Segmentation transform, this 
information consists of the position of the new segments in the data set. 

If you request data for display or further processing (transform or export), it is recalculated by 
the transform object. The advantage of this approach is that no intermediate files are 
generated for the various operations yet all intermediate results are nevertheless retained. 

A disadvantage, however, is that the speed of certain steps – such as Ocular Correction, 
Baseline Correction and Average – is reduced as a result of the constant recalculation. 

To counteract these negative effects, the results of the Segmentation transform can be stored 
temporarily in a cache file. The transform then accesses the cache file when data is requested. 

Temporary and persistent cache files are available to you for storing the segmentation data. 
You can also store the data directly in the history file. 

Persistent cache files are stored in the same folder as history files. They are saved permanently 
and not deleted until the associated transform node is deleted from the history tree by means 
of the Purge Deleted Nodes function. You can consider these cache files as being part of the 
history file. However, this method of storage is more efficient and allows even larger volumes 
of uncompressed data to be stored. Note that persistent cache files of a node continue to use 
storage space on the hard disk until the node is finally deleted from the cache for deleted 
nodes. 

Temporary files only exist for as long as the history file is open. If the history file is opened 
again after being closed, the temporarily stored information is still available, but it is 
nevertheless recalculated on request. You should therefore carry out operations that follow 
segmentation without closing the history file. 

If you subsequently want to carry out further operations following segmentation, you can 
recreate the temporary cache file. To do this, you open the history file and right-click a history 
node for segmentation. This opens a context menu from which you choose Cache Data to 
recreate the cache file.   

Additional 

information: storage 

options 
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Figure 12—106 Cache Data menu command 

 

To access the folder in which the temporary files are stored, you choose File > Configuration > 
Administration. In the Cache Path text box, you can select the folder by using the Browse 
button. 

 

Figure 12—107 Selecting the cache folder in the Analyzer Administration dialog box  
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After averaging, the cache is no longer required because the Average transform stores the 
result in the history file. 

As an alternative to persistent or temporary cache files, you can also store the data directly in 
the history node. This means the raw data is no longer needed for subsequent operations that 
access the segmented data. This is particularly advantageous when the raw data of a 
workspace is distributed across multiple CDs and, for example, a PCA is to be carried out. 

The Segmentation transform compresses the data before it is stored. The Analyzer works 
internally with floating-point numbers only, but these are unsuitable for compression and have 
to be converted into integers first. To this end, you have to specify a resolution (precision). For 
EEG data this resolution should be about 100 nV (nanovolts, 1 μV = 1000 nV), which is 0.1 μV. 
A lower value means a higher resolution but less compression. 

The data is generally stored segment by segment, regardless of the storage option selected. 
This can result in problems if you have created very long segments because the computer 
many not have enough RAM. Very long segments are therefore subdivided into smaller blocks 
when they are saved. 

 

ABE is a kind of conditional segmentation that is only used for segmentation relative to a 
marker. It is used, for example, to select those segments in which a test subject has pressed a 
response button within a certain time after the triggering of a stimulus. 

Essentially, ABE allows segment selection to be made dependent on the existence or absence 
of one or more markers in one or more intervals relative to the reference marker. The markers 
can be of any type (segment markers, reference markers, DC correction etc.). 

The following are examples of entries made in the Advanced Boolean Expression text box: 

• You select a reference marker. You only want to include segments in which the 
test subject pressed the button R1 between 50 and 100 ms after the reference 
marker. The following expression should be entered in the text box: 

R1(50,100) 

• If you want to include all segments in which the test subject pressed the button 
R1 between 50 and 100 ms after the reference marker and also pressed the 
button R2 between 100 and 200 ms after the reference marker, the expression is: 

R1(50,100) and R2(100,200) 

• If you want to include segments in which the test subject pressed either R1 or R2 
within the above intervals, the expression is: 

R1(50,100) or R2(100,200) 

  

Additional 

information: 

advanced Boolean 

expressions 
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• If you only want to include segments when either only R1 or only R2 was pressed 
within the above interval (exclusive OR), you can use the following expression: 

R1(50,100) and not R2(100,200) or not R1(50, 100) and R2(100,200) 

Consider which operators take precedence when you form the expressions. The 
“not” operator takes the highest precedence, followed by “and” and then “or”. 
You can change the precedence by using parentheses: Expressions in 
parentheses are calculated first. 

• not (R1(50,100) or R2(100,200)) 

In this example, the expression “R1(50,100) or R2(100,200)” is calculated first, 
and the result is negated by the operator “not”. Consequently, all segments in 
which the test subject pressed either R1 within 50 to 100 ms or R2 within 100 to 
200 ms are not included. Alternatively, you could use the following expression: 

not R1(50,100) and not R2(100,200) 

You can also enter negative values in the Advanced Boolean Expression text box. Negative 
values always relate to the time before the reference marker. 

Any spaces are ignored, and no distinction is drawn between uppercase and lowercase. 
Consequently, “r  1( 1, 2)” is identical to “R1(1,2)”. In the ABE – in contrast to the reference 
marker – all markers with the same sequence of characters are handled in the same way 
regardless of spaces. In other words, the marker value “r  1” is equivalent to “r1” and “R1”. 
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12.4.6 Average 
 
 

The Average transform is used for averaging segmented data. 

 

This transform is typically used after: 

• Filtering (optional) 

• Segmentation 

• Ocular Correction (optional) 

• Artifact Rejection 

• Local DC Detrend (optional) 

• Baseline Correction 

 

When using individual channel mode with the Average transform, note the subsection entitled 
“Additional information: individual channel mode” in this chapter. 

 

Note that you make settings for marker types, exclude segments with incorrect subject 
responses and make other configuration settings in the Segmentation transform, not here. 

 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > Average. 

 

 

Figure 12—108 Average dialog box  
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You can make the following settings: 

 

In the Segment Range group box, you specify the time range whose segments are to be 
included in averaging. 

• The number of available segments is displayed under Available Segments. 

• If you select the Use Full Range radio button, all segments are included in 
averaging. 

• If you select the Specify Range of Segments radio button, you can specify the 
range of segments to be included in the From and To text boxes. 

 

If you select the Enable Individual Channel Mode check box, you activate individual channel 
mode, which allows bad intervals to be taken into account channel by channel. If you do not 
activate individual channel mode, all segments that contain a “bad interval” marker are 
rejected in their entirety. 

 

If you select the Enable Odd-Even Averaging check box, the Average Only Odd Segments 
and Average Only Even Segments radio buttons become available. These radio buttons allow 
you to specify whether only segments with odd numbers (segment 1, 3, 5, etc.) or only 
segments with even numbers (2, 4, 6, etc.) are to be averaged. 

The segments in the specified time range (under Segment Range) are used as the basis for the 
count. 

 

If you select the Create a Data Set for Standard Deviation check box, the standard deviation 
is output as a new data set. 

If you select the Calculate Signal-to-Noise Ratio (SNR) check box, the signal-to-noise ratio is 
calculated and stored in the operation information.  

Segment Range 

group box 
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Odd-Even group box 

Statistical Data 

group box 
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If you use individual channel mode, each channel is treated separately instead of all channels 
from every segment being included in averaging. If a channel in a segment has been marked as 
bad, all the other channels are still used for averaging. Consequently, the number of segments 
included in averaging may differ from channel to channel. 

Before you can use individual channel mode, you have to take a number of steps by way of 
preparation. 

• If you use the Data Inspector transform, you have to activate individual channel 
mode there as well (see also section 12.2.5, “Data Inspector”). 

• During segmentation you must not suppress the bad intervals (see section 12.4.5, 
“Segmentation”). 

• If you use the Artifact Rejection transform instead of or in addition to the Data 
Inspector transform, you must also activate individual channel mode there in 
order to merely mark channels rather than reject entire segments (see section 
12.2.4, “Artifact Rejection”). 

 

The signal-to-noise ratio (SNR) is a measure of the quality of the EEG signal. Since there is no 
exact information available on either the signal or the noise in the EEG, your average total 
powers must be estimated statistically. 

The average noise power of the EEG is calculated for each channel first. It is assumed that 
averaging eliminates the noise. In a second step, the average noise power is then calculated 
from the total of the squares of the differences between the EEG value and the average value, 
divided by the number of points minus 1. 

In order to ascertain the average power of the signal in the EEG, you first calculate the total 
power of a channel of the EEG. The total power is obtained by calculating the mean of the 
squares for all data points of the channel before averaging. 

It can be assumed that the signal and noise are uncorrelated. Consequently, the average 
power of the signal is equal to the difference between the average total power and the average 
noise power. 

The SNR is then calculated from the quotient of the average signal power and the average 
noise power. 

The result of the SNR calculation is stored in the resulting history node as a description. You 
obtain the result and other information by right-clicking the icon or displaying a context menu 
in the view and choosing the Operation Infos menu command. A window opens, showing 
information on the transform that has been performed. (You will find detailed information on 
the commands on the context menu in section 5.1, “The new user interface of the Analyzer”.) 
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12.4.7 Baseline Correction 
 
 

The Baseline Correction transform is used to correct the baseline of each segment. 

Correction is generally performed before averaging. An interval in a segment is defined in 
which the average voltage level corresponds to the new zero point of the segment values. In 
other words, the average (baseline) of the points in the defined interval is ascertained, and this 
is subtracted from all points in the segment. This operation is carried out for all the channels in 
the data set. 

 

The Baseline Correction transform is typically used after: 

• Segmentation 

• Artifact Rejection 

• Filtering (optional) 

• Ocular Correction (optional) 

• Local DC Detrend (optional) 

 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > Baseline Correction. 

 

 

Figure 12—109 Baseline Correction dialog box 

 

You can select any interval to be used to obtain the average voltage. It is generally positioned 
where activity is at its lowest level – ideally before the stimulus or other reference markers. To 
do this, you specify the values for the beginning (Begin [ms]) and end (End [ms]) of the 
interval in milliseconds. 

 

Note that if you do not use the Baseline Correction transform, there may be a flattening off of 
the average signal. 
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12.4.8 DC Detrend 
 
 

This DC Detrend transform calculates the DC trend from the EEG signal. 

Two different methods are used, depending on whether the transform is applied before or after 
segmentation. 

If you apply the transform before segmentation, global trend correction is carried out, as 
described in [Hen93]. To begin with, the average voltage is calculated for each prestimulus 
interval of the specified marker type. In a second step, the average voltage is calculated for 
every DC reset in an interval directly before the DC reset. The difference between the average 
voltage before the DC reset and the average voltage of the first prestimulus interval after this 
DC reset is added as an offset to all voltage levels after this DC reset. In a third step, all average 
values calculated for the prestimulus intervals along the time axis and corrected by adding the 
offset are taken into account and the trend is ascertained by applying linear regression to this 
data. Only intervals that do not contain a DC reset are included in the calculation. Finally, the 
trend is subtracted from the original data, taking into account the DC offset. 

 

To minimize the impact of DC trends on ocular artifact correction as far as possible, it is 
advisable to perform DC trend correction before ocular artifact correction. 

 

To display the dialog box for the transform, you choose Transformations > Segment Analysis 
Functions > DC Detrend. 

 

 

Figure 12—110 DC Detrend dialog box  
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You can make the following settings for the algorithm: 

• The Length of Intervals Based on Time and Length of Intervals Based on Data 
Points radio buttons allow you to specify the interval length in milliseconds or 
data points, respectively. 

• From the drop-down list box you choose the marker type for the calculation of the 
prestimulus intervals (Marker Type for Calculating). You then specify the length 
of these intervals in the Length of Interval Before Markers [ms] text box. 

• In the Length of Interval Before DC Correction [ms] text box, you specify the 
length of the intervals before DC trend correction. These are used to calculate the 
average voltages and the offsets for the subsequent data. 

 

If you apply the DC Detrend transform after segmentation, local trend correction is carried out. 
A linear function is subtracted from the data of each segment. The slope and limit values of 
this linear function are calculated for every segment from a certain interval at the beginning 
and end of the segment. 

You can make the following settings: 

• The Intervals Based on Time and Intervals Based on Data Points radio buttons 
allow you to specify whether the intervals are based on time or data points. 

• In the Interval at Segment Start and Interval at Segment End text boxes, you 
specify the length of the interval – in milliseconds or data points – at the 
beginning and end of the segment. 

 

 

Figure 12—111 DC Detrend for Segments dialog box (for local DC trend correction) 

 

 

[Hen93] E. Hennighausen et al., A correction method for DC drift artifacts. 
Electroencephalography and clinical Neurophysiology, 86 (1993), 199-204. 
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12.5 Transforms in the Comparison and Statistics group 
 
 

12.5.1 t-Test 
 
 

It is often not possible to estimate reliably on the basis of two EEG curves – the grand averages 
of two groups or two experimental conditions, for example – whether visible differences are 
also statistically significant. 

Conversely, with examinations of a more exploratory nature, it is often not possible to clearly 
ascertain from the available averages the intervals in which the conditions or groups have 
particularly marked differences. In all these cases, it can be very useful to calculate t-values for 
the data. 

The t-Test transform permits the calculation of paired and unpaired t-tests as well as t-tests 
against zero. 

It can be applied to segmented and unsegmented data as well as to averaged data and grand 
averages. 

No preliminary work is necessary on the data (obtaining the differences or a priori averaging of 
the data, for example) in order to apply the t-test. Nor do the data set lengths of reference and 
comparison nodes have to match. In this case, the t-test is only carried out for the common 
time range. 

 

The t-Test transform is typically used after: 

• Segmentation 

 

To display the dialog box for the transform, you choose Transformations > Comparison and 
Statistics > Statistical Analysis > t-Test. 

The dialog box that appears contains radio buttons (Paired t-Test and Unpaired t-Test) that 
allow you to choose between a paired or unpaired t-test. 

For the unpaired t-test, you can use the Equal Variance check box to specify whether equal 
variance is to be assumed between the two groups compared. Since this is a common 
assumption in EEG research, this check box is selected by default. However, if you know that 
this assumption does not apply, clear this check box. 

Please note that an F-test for equal variance is not carried out in the t-Test transform. If you 
select this check box, the formula corrected for variance inequality is used. 

If you select the Enable Individual Channel Mode check box, you activate individual channel 
mode, which allows bad intervals to be taken into account channel by channel. If you clear the 
check box, bad intervals are taken into account segment by segment.   
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Figure 12—112 t-Test dialog, first page 

 

If you selected the paired t-Test in the first page of the dialog, the second page offers you the 
choice between a regular paired t-test (Test Against Second Dataset) and a t-test against zero 
(Test Against Zero), which is a special case of the paired t-test. This tests whether the values 
differ significantly from zero. 

If you want to carry out your paired t-test against a reference node, you can select this from the 
list of existing history files. 

In addition, by selecting the Use Relative Path for Template or Drag and Drop check box you 
can specify whether the comparison node is to be determined and stored relative to the 
reference node. In this way, for example, you can carry out the same t-test for each history file 
when running history templates, without having to specify the comparison data sets explicitly 
each time. 

Please note, however, that this check box is only available for comparison nodes that are in 
the same history file as the reference node. When you select the check box, all the history files 
except your current one are removed from the list of available history files.  
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If you selected the unpaired t-test in the first page of the dialog, the next page offers you the 
same options as for the paired t-test. The only difference is that the option of a test against 
zero is not available to you. 

Depending on whether you select a paired t-test, an unpaired t-test or a t-test against zero, all 
the required calculation steps are carried out (e.g. obtaining the differences across all 
segments in the paired t-test for segmented data, averaging of the differences and calculation 
of the t-values). 

 

 

Figure 12—113 Selecting the t-Test type of the second data set 
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12.5.2 Cross Correlation 
 
 

The Cross Correlation transform enables you to calculate the cross correlation between two 
channels in a segmented EEG. It is a statistical measure of the dependency of two channels. 
Time- and frequency-shifted dependencies are also calculated. If the transform is applied to 
complex data, the complex cross correlation is calculated. 

 

The averaged Cross Correlation transform is typically used after: 

• Segmentation 

 

To display the dialog box for the transform, you choose Transformations > Comparison and 
Statistics > Cross Correlation. 

 

Figure 12—114 Cross Correlation dialog box 

 

The calculation is carried out as follows: 

• First, the cross correlation between the specified pairs of channels is calculated 
segment by segment using the following formula: 

• CrCorr(c1, c2)(j) = Σi (c1(i) – Avg(c1) ) (c2 (i+j) – Avg(c2) ) *
 / ( StdDev(c1) * StdDev(c2) ), 

• i = 1,..., segment length, j = 1-segment length, ..., segment length 

• Avg: average of all values in the segment 

• StdDev: standard deviation of all the values in the segment 

• The value 0 is added to the channels outside the segment for the purpose of the 
calculation. 

• In a second step, an average is obtained across all segments for each of these 
pairs.  

Summary 

Prerequisite for use 

Procedure 
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The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table and 
delete them again either individually or all together. The Restore Default button fills the table 
with all the data. 

When you apply the transform to data in the frequency domain, you can enter in the Band 
Selection group box a frequency band to which the calculation is to be restricted. 

If you are working with data in the frequency domain, enter in the table the channels between 
which the cross correlation is to be calculated. 

If you select the Take Whole Range radio button, all the available data is included in the 
calculation. 

You select a specific frequency band by selecting the Take Band radio button and entering the 
beginning and end of the band in the Begin [Hz] and End [Hz] text boxes. You also have the 
option of selecting the entire frequency range. To calculate the auto correlation of a channel, 
select the channel name in both the left- and right-hand list box of a row in the table. As a 
result, you get the channels in which the average of the cross correlations is shown against the 
time or frequency shift. 

The value shown for Available Segments is the total number of available segments. 

If you want to use all the segments, you select the Use Full Range radio button. If you want to 
specify the range of segments to be included in the calculation, you select the Specify Range 
of Segments radio button. 

If you select the Enable Individual Channel Mode check box, you activate individual channel 
mode, which allows bad intervals to be taken into account channel by channel. If you clear the 
check box, bad intervals are taken into account segment by segment. 
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12.5.3 Data Comparison 
 
 

The Data Comparison transform allows you to compare two data sets or two channels of a data 
set after averaging. Currently, the module can carry out the following comparisons: 

• Difference waves 

• Cross-correlation 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Comparison and 
Statistics > Data Comparison. 

 

 

Figure 12—115 Initial Comparison dialog box 

 

In the initial dialog box, you select the comparison method you want to use. The following 
methods are available: 

• Calculation of difference waves (Difference) 

• Calculation of the sum of two channels (Sum) 

• Calculation of the ratio of the initial channel to the comparison channel (Ratio) 

• Calculation of the ratio of the initial channel to the comparison channel as a 
percentage (Percent Ratio) 

• Calculation of the cross-correlation (Cross Correlation). 

In the calculation of ratios, the initial data value is divided by the other data value. If the other 
data value is zero, zero is used as the result.  

Summary 

Procedure 
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In the next dialog box, the Comparison Wizard, you specify whether the comparison is to be 
carried out within the current data set (Compare Channels) or between two data sets 
(Compare Datasets). 

 

 

Figure 12—116 Comparison Wizard, page 1 

 

If you opt for a comparison of channels within a data set, a channel selection dialog box is 
displayed. This allows you to select channel groups to be subtracted from each other. 

You choose the channels from drop-down list boxes. The Insert Line, Remove Line and 
Remove All buttons allow you to add rows to the table, remove individual rows or remove all 
rows.   
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Figure 12—117 Comparison Wizard, page 2 when the Compare Channels radio button is 

selected 

 

If you opt for a comparison of two data sets, a data set selection dialog box is displayed. The 
dialog box contains a list of all the history files in the current workspace. You can open a data 
set by double-clicking its file name. 

The following buttons make it easier for you to navigate in the table: 

• Expand History File: Expands the current history file. 

• Expand Same Names: Expands all history files that have a data set of the same 
name, up to this data set. 

• Expand All: Expands all history files. 

• Collapse All: Closes all history files. 

If you select the Keep Remaining Channels check box, all channels that do not have a 
corresponding channel in the other data set are nevertheless retained. 

The Use Relative Path for Template or Drag and Drop check box allows you to save the 
relative path of the data set for comparison. In other words, the history templates will always 
look for this data set in the same history file. 

You select a data set by means of a double or single click. The Finish button concludes your 
entries.   
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Figure 12—118 Comparison Wizard, page 2 when the Compare Datasets radio button is 

selected 

 

A view with overlays appears. The black line represents the result of the transform, the red line 
represents the initial node, and the blue line represents the other node for comparison. 

 

Figure 12—119 Part of the standard view (data set overlay)   
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Figure 12—120 Part of the grid view (channel overlay) 

 

If you click the name of a node (when comparing data sets) or channel (when comparing 
channels) in the upper left corner of the view, the corresponding channel is deactivated or 
activated again. 

The view context menu also contains the additional command Display Static Overlays. This 
allows you to switch between the overlays created by comparison and the normal overlays. You 
can only add other overlays to the node for comparison if this command does not have a check 
mark against it. 

 

 

Figure 12—121 Context menu containing the Display Static Overlays command 
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12.5.4 Covariance 
 
 

The Covariance transform can be used as a preliminary step for various forms of coherence 
calculation. When the Formula Evaluator is used at the same time, it is possible to implement 
the majority of the methods described in the literature and other related methods. 

In contrast to the Coherence transform, the data output by the Covariance module is always of 
the same type as the processed input data. Consequently, it is possible, for example, to 
calculate and further process complex-valued coherence or to calculate the correlation of 
channels in the time domain. 

 

The Covariance transform is typically used after: 

• Segmentation 

 

To display the dialog box for the transform, you choose Transformations > Comparison and 
Statistics > Covariance. 

 

 

Figure 12—122 Covariance dialog box  

Summary 

Prerequisite for use 

Procedure 
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You specify whether all possible channel combinations (Calculate Covariance of All 
Combinations of Channels radio button) or only a selection of channel combinations (Select 
Combination of Channels for Covariance Calculation radio button) are included in the 
calculation. 

If you decide on individual combinations, you can enter the channel combinations in the table. 
Alternatively, you can choose a channel from the drop-down list box on the right. 

These two methods use the following formulas to calculate the covariance: 

• Cov(c1, c2)(x) = 1/N Σ (c1, i (x) – avg(c1 (x)) ) (c2, i (x) – avg(c2 (x)) )* 

• Cov(c1, c2)(x) = 1/N Σ c1, i (x) c2, i (x)* 

The Subtract Average check box allows you to specify whether method (1) or (2) is used. In 
both formulas, totaling is carried out using the segment number i. The average value obtained 
applies to the segments at a fixed time or at a frequency of x and with a fixed channel c. 

The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table and 
delete them again either individually or all together. 

If you click the Combine Channel with All button, all combinations of the selected channel are 
added to the table. 
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12.5.5 Coherence 
 
 

The Coherence transform calculates the coherence between channels. Coherence is a measure 
of the dependency of the data between the individual channels over time. 

 

The Coherence transform is typically executed after: 

• The Fast Fourier transform 

Note that calculation is only possible with complex frequency data. 

 

To display the dialog box for the transform, you choose Transformations > Comparison and 
Statistics > Coherence. 

 

Figure 12—123 Coherence dialog box  

Summary 

Prerequisite for use 

Procedure 
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The four radio buttons allow you to choose between four methods of calculating coherence: 

• Use Correlation / Autocorrelation: quotient from correlation and 
autocorrelation 

• Use Cross-Spectrum / Autospectrum: quotient from cross-spectrum and 
autospectrum 

• Calculate Only Cross-Spectrum: calculation of the non-normalized cross-
spectrum 

• Calculate Phase of Cross-Spectrum: calculation of the phase of the cross-
spectrum 

 

The first method calculates the coherence using the following formula: 

Coh(c1, c2)(f) = | Cov(c1, c2)(f) |² / ( | Cov(c1, c1)(f) |  | Cov(c2, c2)(f) | ) 

in conjunction with 

Cov(c1, c2)(f) = Σ (c1, i (f) – avg(c1 (f)) ) (c2, i (f) – avg(c2 (f)) )
* 

 
In the second formula, totaling is carried out using the segment number i. The average is 
obtained with reference to the segments with a fixed frequency f and a fixed channel c. 

The second method uses the cross-spectrum instead of the covariance. The formula is as 
follows: 

Coh(c1, c2)(f) = | CS(c1, c2)(f) |² / ( | CS(c1, c1)(f) |  | CS(c2, c2)(f) | ) 

in conjunction with 

CS(c1, c2)(f) = Σ c1, i (f) c2, i (f)
* 

Here, too, totaling is carried out using the segment number i. 

 
The third method merely calculates the cross-spectrum, as specified in the formula with CS. 

 
The fourth method calculates the phase of the cross-spectrum. The phase is specified as a 
radian measure, and the curve is continued constantly at the transitions -Pi and +Pi in such a 
way that the range of values can theoretically extend across the entire range of real numbers 
but always specifies an angle (between the complex number vector and the real axis). 

 
In methods 1 and 2, values between 0 and 1 are obtained for each frequency and each channel. 
In method 3, complex values are obtained, but only the amount is output.  

Method group box 
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You specify whether all possible channel combinations are to be included in the calculation 
(by selecting the Calculate Coherence of All Combinations of Channels radio button) or only 
a selection of combinations (by selecting the Select Combination of Channels for Coherence 
Calculation radio button). 

The Insert Line, Remove Line and Remove All buttons allow you to add rows to the table and 
delete them again either individually or all together. 

If you decide on individual combinations, you can enter the channel combinations in the table. 
Alternatively, you can choose a channel from the drop-down list box. 

If you click the Combine Channel with All button, all combinations of the selected channel are 
added to the table. 

If you select the Use Paired Channels View check box, the result is displayed in a two-part 
view. On the left, you see curves in the frequency domain that represent the coherence 
calculated for each frequency point and each channel combination. On the right, the 
coherence values between the channels are represented by lines. Their coloring reflects the 
coherence on a scale from 0 to 1. If the check box is cleared, the result is displayed in one of 
the frequency views. 

 

Figure 12—124 Output of the coherence data 

 

Channels tab 



  
LORETA 12.6.1 
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12.6 Transforms in the Special Signal Preprocessing group 
 
 

12.6.1 LORETA 
 
 

The LORETA transform allows you to view the LORETA data over the time range. Regions of 
interest (ROIs) are defined for this purpose. Each ROI is displayed in the Analyzer as a virtual 
channel. 

 

The virtual MR anatomical images are made available by the Montreal Neurological Institute of 
McGill University. 

 

You call the required dialog box by choosing Transformations > Special Signal 
Preprocessing > LORETA. 

 

Figure 12—125 Dialog box for the LORETA transform 

  

Summary 

 

Procedure 
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Click New ROI… to create a new ROI. The New Region appears, in which you can enter the 
name of the new ROI. The name you enter here is also the name of the virtual channel. 

 

 

Figure 12—126 Creating an ROI 

 

To add lobes to the ROI, click Add Lobe…. You can use the Left, Both and Right radio buttons 
to specify whether the left lobe, right lobe or both lobes are to be added. 

 

 

Figure 12—127 Adding lobes  

Creating ROIs 
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You can use the Add Gyrus… and Add Brodmann Area… buttons to add gyri and Brodmann 
areas to the ROI. 

 

The Add Current Position… button allows you to add a specific position. You can choose 
whether to add the nearest voxel to the mouse pointer (by selecting the Nearest Voxel radio 
button) or to define a sphere with a specified radius around the current position (by selecting 
the Sphere around Point radio button). 

 

 

Figure 12—128 Adding a specific position 

 

The Add Block… button allows you to add a rectangular block, whose limits you can specify. 

 

 

Figure 12—129 Adding a block  
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The Details of Selected Region of Interest box lists everything specified. 

 

 

Figure 12—130 Part of the LORETA transform dialog box, containing a list of the 

components of the ROI “Frontal”  
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From the 3D Anatomy drop-down list, you can choose a virtual MR anatomical image. 

The Remove ROI and Remove All buttons allow you to remove ROIs individually or all at once. 

In the Value Extracted from Voxels group, you can specify which value is to be calculated for 
the virtual channel from the corresponding ROI. You can choose the x-coordinate, y-coordinate, 
z-coordinate, absolute value of the coordinates or power (square of the value). 

 
The Keep Old Channels check box allows you to specify whether the original channels are to 
be retained. The New Channels on Top text box allows you to specify whether the virtual 
channels are to be displayed before the original channels in the view. 

 
The Up and Down buttons allow you to specify the order of the ROIs in the data set. 

 
The Import ROIs… button imports ROIs that have already been defined. The Export ROIs… 
button allows you to export ROIs you have created as an .xml file so that they can be used 
subsequently. 

The Export Blank ROIs File button exports voxel data, including the anatomical data, in a .csv 
file. You can open this file in Excel, for example, define the ROIs manually and re-import them 
as a .csv file. 

 

The OK starts the calculation of the transform matrix and gives you the ROIs as new virtual 
channels. You can use the other modules of the Analyzer to work with these. 

 

 

[PML94] R.D. Pascual-Marqui, C.M. Michel, D. Lehmann, Low resolution electromagnetic 
tomography: a new method for localizing electrical activity in the brain. International Journal of 
Psychophysiology, 18 (1994) 49-65. 
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12.6.2 MR Correction (MRI scanner artifact correction) 
 
 

In Version 1.0 of the Analyzer, both forms of MRI artifact correction were grouped together in 
the same transform (MRI Artifact Correction). In Version 2.0 of the software, there are separate 
transforms for scanner artifact correction and pulse artifact correction. 

 

The scanner artifact correction transform allows the detection and correction of artifacts that 
occur during the recording of an EEG in an MRI scanner as a result of changes to the magnetic 
field in the scanner. 

 

The methods used in scanner artifact correction are based on techniques described in [All00]. 

The basic principle behind the correction of scanner artifacts is that the intervals interfered 
with by the MRI scanner are averaged. The averaged scanner artifact curve is then subtracted 
from the original curve in the affected intervals. This generally does not completely eliminate 
the scanner artifacts. Consequently, you should subject the data in the corrected ranges to a 
further correction by means of filters included in the transform. 

It is possible to separate the detection of scanner episodes from scanner artifact correction 
and, as an initial step, to merely mark up the artifacts. The correction can therefore be based 
either on the detection method or on markers that already exist in the EEG. 

You can use markers in order to define the intervals affected by scanner artifacts. Markers can 
be created by the scanner directly or by means of a macro. The quality of the averaged artifact 
curve to be subtracted from the individual sections in a subsequent step depends directly on 
the precision with which the markers are set over the duration of the signal. The transform 
implements methods by means of which a reference point (generally the starting point) is 
always marked for the scanned intervals. 

There are two methods available for this: the simple gradient method and the gradient method 
with TDD (template drift detection). 

In the simple gradient method, the sum of the gradients of the curves between two data points 
in the selected channels is calculated. If this sum exceeds the set threshold, a “scan start” 
marker is set. 

In the gradient method with TDD, the current scanned interval is also compared with the first 
scanned interval, and “drifts” and “shifts” are calculated by means of an interpolation method 
for each scanned sampling interval in which an artifact occurs. 

“Drift” are the differences in time between the averaged artifact curve and the scanner artifact 
of each interval. This drift is caused when the time of repetition (TR) of the scanner is not a 
multiple of the sampling rate. Consequently, the artifacts of the individual intervals drift by a 
fraction of a sampling interval even if the “scan start” markers are positioned perfectly. 

Drifts of the scanner rate in relation to the sampling rate no longer occur if the scanner and MR 
amplifier have been synchronized by means of the BrainVision SyncBox. This hardware option 
provides an ideal alternative to using TDC.  

 

Summary 

Preliminary remarks 

on methodology and 

notes for users 

On drifts and shifts 
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The information about drifts of a sampling interval is made available by the template drift 
compensation method when the artifacts are subsequently corrected. Moreover, the drift is 
adjusted appropriately at the beginning of the interval. This is of great benefit particularly in 
the case of continuous artifacts. 

The TDD corrects certain marker positions by one or two points. These corrections are referred 
to as shifts. Their purpose is to compensate for the repeated effect of drifts. 

If the scanner artifacts occur one after the other without being interrupted by artifact-free 
sections, it is very difficult to determine exactly where the next interval begins. Against this 
background, template drift detection can often significantly improve the positioning of the 
“scan start” markers. 

In the simple gradient method, the accuracy with which the beginning of the artifact is 
detected does not necessarily increase when a larger number of channels are included. We 
therefore recommend that you use a single channel for this. Ensure that this channel actually 
contains all the existing scanner artifacts. 

The accuracy of template drift detection, on the other hand, does increase when more channels 
are used. Results can therefore improve if you select a larger number of channels than you do 
for the simple gradient method. 

The interval to be corrected can be moved relative to the starting point obtained (by means of 
markers or methods) in accordance with the selected interval range. If you enter negative 
values for the starting point when selecting the interval range, the beginning of the interval is 
positioned before the marked reference point. 

 

It is possible to detect and correct artifacts in one and the same process, although you can 
also do it in two steps: 

• 1. Search the scanned intervals and set markers. You can then execute further 
transforms to analyze the time-related stability of the markers found (compare 
the marker position with the beginning of the scanner artifact). You should carry 
out checks like this, in particular, when you want to use external markers. The 
Analyzer’s “Marker Timing” solution is ideal for the analysis of the artifact 
markers. It shows the time between successive markers as a time-voltage curve. 

• 2. Correct the scanned intervals. 

 

You call the required dialog box by choosing Transformations > Special Signal Processing > 
MR Correction.  

Prerequisite for use 

Procedure 
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Figure 12—131 MRI Artifact Correction dialog, page 1 

 

You can separate the detection of scanner episodes from scanner artifact correction and, as an 
initial step, merely apply markers to the scanner artifacts. The correction can therefore be 
based either on the detection method or on markers that already exist in the EEG. The 
Detection group box allows you to specify whether you want to use the detection method (Use 
Detection Method radio button) or markers (Use Markers radio button) for artifact detection. 
You should select the Use Markers radio button if the scanned intervals are defined by 
existing markers. You select markers from the drop-down list box, which contains all the 
markers set in the EEG. 

If you select the Use Detection Method radio button, you can use the Write Only Markers 
function. This function is used only to set markers; no artifact correction is performed. Artifact 
detection is thus carried out for either the current or a future correction. In this case, the 
markers found can be read if you apply the scanner artifact correction transform again and 
select the Use Markers radio button. 

If you select the Write Only Markers check box and clear the Use Template Drift Detection 
check box, the artifacts are detected in that the marker positions are accepted as artifacts. 

If you select both the Write Only Markers check box and the Use Template Drift Detection 
check box, the artifacts are detected by means of template drift detection (TDD).  
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If you carry out artifact detection with the Use Template Drift Detection check box selected, 
the quality of artifact correction is improved because template drift detection (TDD) corrects 
certain marker positions by calculating shifts in order to compensate for the effect of the drifts 
of the scanner. 

Unlike in BrainVision Analyzer 1.0, it is possible to select the Use Template Drift Detection 
check box when the Use Markers radio button is selected. This is because it is not certain that 
the selected markers have drifts as user properties. This is the case when you use external 
markers. 

 
The two large boxes in the lower part of the dialog box allow you to select the channels for 
which artifact detection is to be carried out. 

 
In the Gradient Trigger (μV/ms) text box, you can specify the value of the gradient trigger. The 
Histogram… function helps you to determine a suitable gradient trigger. If you click this 
button, the Gradient Histogram dialog box appears. 

The histogram displays the frequency distribution of the gradients and thus allows you to set a 
suitable gradient trigger. The gradient trigger is a limit value for automatically determining the 
scanner artifacts. The point in the EEG graph at which the gradient is greater than the gradient 
trigger is taken as the beginning of the artifact. 

The Display button allows you to indicate the position of the value entered in the Trigger text 
box in the histogram. The +/- buttons allow you to resize the image. 

The optimum gradient trigger value depends, among other things, on the channel selection. 

 

 

Figure 12—132 Histogram  

Explanation 
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The Enable/Disable and Enable All/Disable All buttons allow you to select the channels to 
which the gradient criterion is to be applied. 

If you select Artifact Type > Continuous and Select Channels for Detection > Write Only 
Markers, the dialog contains no further pages. You conclude your settings by clicking the 
Finish button. 

The Next button takes you to the second page of the dialog. 

 

 

Figure 12—133 MRI Artifact Correction dialog, page 2  
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In the Artifact Type group box, you specify whether the scanner artifacts are interrupted 
(Interleaved) or continuous (Continuous). 

• The Interleaved radio button allows you to detect scanned intervals when the 
intervals containing artifacts are followed by sections of the EEG that contain no 
scanner artifacts. 

• The Continuous radio button allows you to detect scanned intervals containing 
artifacts when these intervals succeed each other without interruption. Specify 
the value of the scan period in the TR [ms] text box. The intervals are delimited 
by means of the time of repetition. 

You can also make additional settings for the marker position or the point at which the artifact 
begins. You can specify the positions based on time or data points (using the Based on Time 
or Based on Data Points radio button). 

If you make an entry in one of the six text boxes, the values in the text boxes affected by it are 
adjusted accordingly. 

If you select the Select Channels for Detection > Write Only Markers check box, the wizard 
contains only pages 1 and 2. 

 

 

Figure 12—134 MRI Artifact Correction dialog, page 3  

 



 
MR Correction (MRI scanner artifact correction) 12.6.2 

 
 

 
BrainVision Analyzer  12.6.2—- 7 - 

In the Baseline Options group box on the third page of the dialog, you can specify whether 
baseline correction is to be carried out before averaging and which period of the interval 
(relative to the marker, in other words to the reference point) is to be used for this. To do this, 
select the Enable Baseline Correction for Average check box. Baseline correction is carried 
out by averaging the data in the time range specified in the Start and End text boxes. This 
average is calculated channel by channel and subtracted from each data point in the interval. 

We recommend that you always carry out baseline correction because it prevents jumps from 
occurring in the corrected EEG. Without baseline correction, the base level influences the 
calculation of the scanner artifact and is also subtracted at correction. 

If you select the Compute Baseline Over the Whole Artifact check box, the baseline is 
calculated precisely across the whole artifact. The Start and End text boxes are no longer 
accessible. 

For some EEGs, the method for obtaining the baseline delivers better results when the baseline 
is calculated within an interval that is partially outside the artifact. In this case, enter a 
relatively large negative value (e.g. -300) in the Start text box and a relatively small positive or 
negative value (e.g. between -25 and 25) in the End text box. 

For other EEGs, the method delivers better results when you calculate the baseline within the 
artifact. In this case, enter a relatively small positive value in the Start text box and a relatively 
large positive value in the End text box. To calculate the baseline within the artifact, you can 
also use the default: Compute Baseline Over the Whole Artifact. 

 

The Average Options group box contains the four methods of selecting the intervals for the 
calculation of the averaged artifact curve. They are template calculation using all the intervals, 
correlation, sliding average calculation and template drift correction (TDC). 

All four methods are based on subtracting templates (averages) from the artifacts. These 
templates are always calculated by averaging the artifacts. The EEG sections marked as “bad 
intervals” are not included in the template calculations. However, they are corrected as far as 
possible by means of template subtraction. 

Depending on the method selected, not all the scanned intervals are used to calculate the 
templates, since data in some intervals cannot be used in the calculation and would falsify the 
averages obtained. 

In the template calculation method with all intervals (the first radio button in the group box), 
clearly, all the scanned intervals are used. In the correlation method, only those intervals are 
included in the calculation that have at least a minimum correlation with the existing averaged 
artifact curve. In the sliding average calculation, a sliding average of the intervals is calculated. 
If you have used template drift detection to obtain the intervals, you can use the template drift 
compensation method to distribute the intervals to a number of averaged artifact curves, 
depending on the drift. 

 

Note that the Detect Saturation function from Version 1.0 of the Analyzers is not included in the 
MR transform. This is because the Data Inspector transform provides more flexible methods for 
the same purpose.  

Baseline Options 

group box 

Average Options 

group box 
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1) If you select the Use All Scanned Intervals for Average radio button, all the scanned 
intervals are used in the template calculation, and there is no need to make any further 
settings. All artifact sections of the EEG that are identified by markers are included in 
averaging. 

 

2) If you select the Select Scanned Intervals for Average by Following Criteria radio button, 
the template calculation is based on the correlation method [All00]. In this method, the 
inclusion of individual artifacts in the template depends on whether they correspond to the 
averaged template. 

In the Start at Interval Number text box, you specify the interval at which averaging begins, 
and consequently you can eliminate from the averaging a specific number of episodes at the 
beginning of the measurement. This makes sense when your MR system inserts “dummy 
volumes” at the beginning of a measurement to stabilize the system. These “dummies” often 
have anything from a slightly different to a significantly different structure over time from the 
MR volume measurements. Consequently, including these “dummies” in the averaged artifact 
would make this template less representative. 

In the Include Always Following Number of Intervals from Start Interval text box, you 
specify the number of intervals that must be included in the averaging in order to obtain a 
useful value for the subsequent correlation. 

The value in the Include Other Intervals Only If Correlation Exceeds text box is used as 
follows: 

If you select the Common Use of All Channels for Bad Intervals and Correlation check box, 
the correlation of each of the interval’s channels with the corresponding channel of the 
template is calculated. If this correlation is greater than the value in the Include Other 
Intervals Only If Correlation Exceeds text box, the interval’s channel is included in the 
template calculation. If the correlation is lower, the corresponding channel is not included. 

If you clear the Common Use of All Channels for Bad Intervals and Correlation check box, 
the correlation of all the interval’s channels with the corresponding channels of the template is 
calculated as a first step. If a correlation is lower than the value in the Include Other Intervals 
Only If Correlation Exceeds text box, a switch is made to the next interval, and the channels 
from the affected interval are not included in the template calculation. If all the correlations are 
greater than this value, the entire interval is included in the template calculation. 

We recommend that you do not select the Common Use of All Channels for Bad Intervals 
and Correlation check box if you are using the second method of the two described because 
correction is more precise when more intervals per channel are included in the template 
calculation. 

In the following example, four intervals are ignored at the beginning, but the following five 
intervals are included in the template calculation. All other intervals must have a correlation of 
0.8 with the template to be included in the template calculation: 

  

Description of the 4 

methods: Method 1 

Method 2 
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The Upper Limit for Number of Intervals check box and text box allow you to limit the number 
of intervals to be included in the template calculation in order to reduce the processing time. 

The Write Markers for Low Correlation check box allows you to put a “low correlation” marker 
on intervals that do not meet the correlation criterion specified in the Include Other Intervals 
Only If Correlation Exceeds text box. 

If you select the Common Use of All Channels for Bad Intervals and Correlation check box, a 
global marker is set for all channels. If, on the other hand, you clear this check box, a separate 
marker is set for each channel. 

 

3) The Use Sliding Average Calculation option addresses the following problem with 
combined EEG and MRI measurement: As soon as the subject moves his or her head in the 
scanner even slightly, the resulting EEG artifacts are modified, in some cases considerably. 
This substantially reduces the quality of a template calculated across all intervals. A solution to 
this problem is to calculate the template by means of a sliding average of a selected number of 
intervals. 

A separate template is calculated for each interval to correct the interval. 

Example: Let’s assume you have entered the value 10 in the Number of Intervals for Sliding 
Average text box. The following 21 intervals are therefore included in the template calculation: 
the interval itself and the 10 preceding and 10 subsequent intervals. 

Note that the sliding method in Version 1.0 of the Analyzer differs from the method in Version 
2.0. In the former, only the 10 intervals preceding the current interval in our example would be 
used in the calculation of the template. 

Another way to solve the problem (of the subject moving his or her head) is to position “head 
movement” markers manually. The Edit markers transform allows you to position these 
markers at those points in the EEG at which the subject clearly moved his or her head. The EEG 
sections delimited by markers are considered as separate EEGs by the scanner artifact 
correction transform. Consequently, separate template calculation and correction is carried out 
for each of these sections. 

 

4) The template drift compensation method (TDC) uses several artifact templates to reduce 
problems caused by the drifting of the scanned intervals in relation to each other by fractions 
of a sampling interval (template drift). The method is based on using for averaging only those 
intervals that have similar template drift. 

We would like to point out again here that TDC does not have to be used if scanners and MR 
amplifiers are synchronized with each other by means of the BrainVision SyncBox. 

Note that you can only use the TDC method if you selected the Use Template Drift Detection 
check box to measure the template drift when detecting the scanned intervals. 

The drift in relation to the ideal position is assigned to each scanned interval as a fraction of a 
sampling interval between -0.5 and 0.5. A range of these drifts is assigned to each of the 
artifact templates managed by template drift compensation. For the purpose of averaging, 
each template takes into account only those intervals that fall within its range.  

Method 3 

Method 4 
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In the Number of Templates To Use text box, you specify the number of templates used. If you 
use a large number of templates, the correction should be more precise. However, fewer 
intervals are included in the calculation of each template in this case. Consequently, the 
significance of the template is reduced. 

If you select the Drift-differences and Shifts in Operation Infos check box, all drift 
differences and shifts are added to the operation information. The drift differences are not 
nominal drift values; instead, they represent the difference between two successive drifts.  

For a better selection of the number of templates used, you can also base yourself on the 
values of the drift differences or the distribution of the drifts. 

 
 

The Next button takes you to the fourth page of the dialog: 

 

 

Figure 12—135 MRI Artifact Correction dialog, page 4 

 

The dialog box allows you to select the channels for which the correction is to be carried out. 
You can select all the channels (Use All Channels for Correction) or make a selection from 
those that are available (Use Following Channels). You can also use the Enable >>/<< Disable 
and All Enable/All Disable buttons to make your selection.  
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The Next button takes you to the fifth page of the dialog: 

 

 

Figure 12—136 MRI Artifact Correction dialog, page 5 

 

The EEG is recorded in the scanner with a very high sampling frequency so that the scanner 
artifacts can be detected correctly and subsequently corrected. However, data with high 
frequencies takes a lot of time to process and requires a great deal of storage space. You 
should therefore carry out downsampling following artifact correction. To do this, select the Do 
Downsampling check box. 

The New Frequency check box contains the value of the output frequency. This is the nominal 
value of the sampling rate of the output data. (Note that in Version 1.0 of the Analyzer the 
downsampling factor was specified at this point.) You can either enter a value or choose one 
from the drop-down list box. 

If you decide to enter a value rather than choose one from the list, the frequency you specify 
may be adjusted to the nearest possible frequency when you move the cursor out of the New 
Frequency box. This is because downsampling can only be carried out with factors that are 
integers in order to avoid interpolation effects.  

Down-sampling 

group box 
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In the Filtering group box, you can make filter settings. Filtering is necessary if residual 
frequencies that do not have a physiological origin remain after the correction of the EEG. 

There are two filter types available: low-pass and band-rejection filters. The Apply Lowpass 
Filter function filters frequencies that are higher than the value entered in the Cut-off 
Frequency [Hz] text box.  

You can also choose between the two filter types FIR (finite impulse response) and IIR (infinite 
impulse response). You specify the gradient of the IRR filter by choosing one of the two values 
from the Slope for the IIR Filter drop-down list box. 

The FIR filter used here is the same as the filter used in Version 1.0 of the Analyzer and is very 
strong. Analyzer 2.0 therefore offers you the option of using an IIR filter. This IIR filter is a 
typical Butterworth filter, as used in the Filters transform. 

The Apply Bandrejection Filter function (the band-rejection filter used here is an FIR filter) 
filters out the frequencies in the Rejected Frequencies [Hz] text box with the bandwidth 
specified in the Bandwidth text box. 

You can use the Apply Bandrejection Filter function (the band-rejection filter used here is an 
FIR filter) to filter out specific frequency ranges. You can specify these ranges in the Rejected 
Frequencies [Hz] and Bandwidth text boxes. In the former you enter the averages, and in the 
latter the bandwidth of the frequency ranges. In order to enter values in the Rejected 
Frequencies [Hz] text box, enter them in the text box to its right and then click Add. To remove 
one or more values, select them and then click Delete. 

The Next button takes you to the Store Corrected Data in History Node dialog box:  

Filtering group box 
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Figure 12—137 MRI Artifact Correction dialog, page 6 

 

This allows you to specify the storage options for the data calculated so that the subsequent 
operations can be performed more quickly: 

• Do Not Store Data, Calculate Data on Demand: The data is not stored. Instead, 
it is calculated on demand. 

• Store Corrected Data in Cached File: The data is stored in a cache file. 

We recommend that you use this option to avoid increasing the size of the history 
files. 

• Store Data Uncompressed in History File: The data is stored uncompressed in 
the history file that belongs to the data set. 

• Store Compressed Data in History File: The data is stored compressed in the 
history file that belongs to the data set. Compression means the data takes up 
less storage space, but precision is reduced. 

In the Compression Resolution [μV] text box, you specify the coefficient by 
which the data is to be compressed. The default value is 100. 
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Click the Finish button to start artifact correction. 

 

 

[All00] P.J. Allen et al., A Method for Removing Imaging Artifact from Continuous EEG Recorded 
during Functional MRI. Neuroimage 12 (2000), 230-239. 
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12.6.3 CB Correction (pulse artifact correction) 
 
 

In Version 1.0 of the Analyzer, both forms of MRI artifact correction were grouped together in 
the same transform (MRI Artifact Correction). In Version 2.0 of the software, there are separate 
transforms for scanner artifact correction and pulse artifact correction. 

 

This transform allows the detection of pulse beats and the correction of pulse artifacts 
(cardioballistic artifacts) that occur during the recording of an EEG in an MRI scanner. 

 

Although it is theoretically possible to detect and correct pulses in one and the same process, 
it is not advisable – particularly not when the quality of the correction using the selected 
parameters for a given data set cannot be assessed. We therefore recommend that you break 
the process down into two separate steps: 

• (1) Search for ECG episodes before correcting the pulse artifacts. Unless you 
perform the search for pulse artifacts in semiautomatic mode, we recommend 
that in this step you merely set markers and then analyze their structure over 
time. The Analyzer’s “Marker Timing” solution is ideal for the analysis of the 
pulse markers. It shows the interval between successive markers as a time-
voltage curve. 

• (2) Correct the pulse artifacts. 

The advantage of subdividing the process into different steps is that the interim results can be 
analyzed, permitting intermediate steps to be performed manually or automatically, for 
example adjustments to markers or an artifact search using the Raw Data Inspector. 

 

To display the relevant dialog box, you choose Transformations > Special Signal Processing 
> CB Correction.  

 

Summary 

Recommendations on 

the use of the 

module 

Procedure 
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Figure 12—138 Cardioballistic Artifact Correction dialog, page 1 

 

At this point, you specify whether you want to use the peak detection method (Use Peak 
Detection) or markers (Use Markers) for artifact detection. 

If you select the Use Markers radio button, the markers already set in the EEG are used to 
determine the pulse intervals, and artifact correction is performed for those pulses that are 
identified by a marker. You select the markers that are to function as R-peak markers in the EEG 
from the R-Peak Markers drop-down list, which contains the names of all the markers set in 
the EEG. 

Note that these markers do not necessarily correspond to the point identified as the R-peak in 
heart physiology; they are a recurring attribute of the pulse, allowing the time at which the 
pulse beats occur to be identified. 

If you select the Use Peak Detection radio button, the pulse peaks (R-peaks) are detected and 
marked; this is done either for the current correction or, if you have selected the Write Only 
Markers check box, for a future correction. 

The Semiautomatic Mode check box allows you to enable/disable semiautomatic mode for 
subsequent editing of the results of pulse detection.  
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In the Search Pulse Template group box, make the following settings:  

If you select the Use Template Markers check box, the existing pulse template is used. This 
check box is only available when the data set contains markers with the names “TSTART”, 
“TPEAK” and “TEND” in this order. 

If this check box is not available or not selected, the Start and Length text boxes are not 
available. These text boxes allow you to enter an interval during which a pulse template is 
searched for. You select the channel to be searched from a drop-down list. This is generally an 
ECG channel. If the ECG recording is not of sufficient quality, or no ECG channel has been 
recorded, you can use an EEG channel with well-defined pulse artifacts instead. 

If you select the Mark Found Template check box, three markers (“TSTART”, “TPEAK”, “TEND”) 
are set in the pulse template. How the pulse template markers are displayed depends on the 
settings made. 

 

 

Figure 12—139 Pulse template when the Use Found Template check box is selected and either 

the Semiautomatic Mode check box is not selected or the semiautomatic phase is over 

 

 

Figure 12—140 Pulse template when semiautomatic mode is enabled  
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In the Pulse Rate group box, you make the pulse rate settings (the interval between two 
pulses). The pulse rate can be specified both in ms (as a time value) and in bpm (beats per 
minute). You specify the average pulse rate and associated tolerance range (+/-) in ms and the 
minimum and maximum tolerance values (Min. and Max.) in bpm. 

When you change the value in one of the four text boxes and position the mouse pointer in 
another text box, the values in the text boxes affected by this are adjusted as appropriate. 

In the pulse detection process, the values in the Correlation and Amplitude group box play 
the following role: 

In the intervals in which the current correlation is greater than the value in the Correlation 
Trigger Level text box, maximum correlations are searched for. If the value of the amplitude at 
the maximum correlations lies strictly between the minimum and maximum amplitude triggers, 
this value is identified as the pulse peak. The Correlation Trigger Level value is always 
between 0 and 1. 

The default values for the amplitude in the Min. and Max. text boxes are 0.6 and 1.2. If the 
default values do not lead to satisfactory results, adjust the values for Min and Max down/up. 

In the Mark Pulses with R-Peak-Marker text box, you can enter the name of the R-peak 
marker. 

If you have selected the Write Only Markers check box, there are no further parts to the dialog 
because no artifact correction is performed. All that happens is that pulses are marked. Click 
Finish to finish making your settings. 

If the Write Only Markers check box is not selected, the Next button takes you to the second 
page of the dialog.  
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Figure 12—141 Cardioballistic Artifact Correction dialog, page 2 

 

You can either specify a time delay (by selecting the Time Delay [ms] check box and entering 
the value) or have it calculated (Time Delay Computation). The time delay is the delay 
between the heartbeat and the occurrence of the artifacts caused by it in the EEG channels. 

To enter a time delay, select the Time Delay check box and enter the desired value in the 
associated text box. If you do not select the check box, the time delay is calculated 
automatically. 

 
If you decide to have the time delay calculated automatically, enter the beginning and length of 
the interval in which the calculation is to be carried out in the Start [s] and Length [s] text 
boxes. 

If, on the other hand, you select the Use Whole Data to Compute the Time Delay check box, 
the entire data set is used to calculate the time delay, and the Start [s] and Length [s] text 
boxes are no longer accessible.  
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By means of the Number of Pulse Intervals Used for Average in One Direction option, the 
template is calculated using a sliding average of a selected number of intervals.  

A separate template is calculated for each interval to correct the interval. For example, let’s 
assume you have entered the value 10 in the Number of Pulse Intervals for Average in One 
Direction text box. The following intervals are therefore included in the template calculation: 
the interval itself and the 10 preceding and subsequent intervals – a total of 21 intervals. 

Note that the pulse correction process in Version 1.0 of the Analyzer differs from the process in 
Version 2.0. In the former, only the 10 intervals preceding the current interval in our example 
would be used in the calculation of the template. 

You use the two list boxes below this to select channels. 

The Next button takes you to the third page of the dialog: 

 

 

Figure 12—142 Cardioballistic Artifact Correction dialog, page 3  

Correction group 

box 
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This allows you to specify the storage options for the data calculated so that the subsequent 
operations can be performed more quickly: 

• Do Not Store Data, Calculate Data on Demand: The data is not stored. Instead, 
it is calculated on demand. 

• Store Corrected Data in Cached File: The data is stored in a cache file. 

We recommend that you use this option to avoid increasing the size of the history 
files. 

• Store Data Uncompressed in History File: The data is stored in a history file 
uncompressed. 

• Store Compressed Data in History File: The data is compressed and stored in a 
history file. Compression means the data takes up less storage space, but 
precision is reduced. 

In the Compression Resolution [μV] text box, you specify the coefficient by 
which the data is to be compressed. The default value is 100. 

If you selected the Semiautomatic Mode check box in the Pulse Detection Parameters dialog 
box, the artifact correction process is started when you click Finish. 

 

On the other hand, if you did not select the Semiautomatic Mode check box, a data window 
opens in semiautomatic mode. This allows you to modify the results of pulse artifact correction 
subsequently. The temporary Peak Detection semiautomatic view dialog box appears on the 
right-hand side of the window. 

To examine the pulse peaks in detail, click the channel label to display the channel specified 
in the ECG (EEG) Channel text box. The channel initially contains only red and green markers. 
Yellow markers are added subsequently. 

 

Figure 12—143 Markers in semiautomatic mode  
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The colors have the following significance: 

• The green markers indicate points that are clearly pulse peaks as far as the peak 
detection process is concerned. 

• The red markers indicate points that are potentially pulse peaks but do not meet 
all the mathematical conditions for this. 

• The yellow markers indicate red or green markers that have been confirmed or 
moved by the user. 

Rules for the colors: 

• If you click or move a green or red marker, it turns yellow. 

• A yellow marker does not change its color if it is moved. 

• If you click a yellow marker, it is deleted. 

• If you click anywhere in the channel, a yellow marker is created. 

 
The Undo and Redo buttons in the lower part of the temporary semiautomatic view dialog box 
allow you to reverse and restore the changes.  
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Figure 12—144 Semiautomatic view 

 

When you terminate semiautomatic mode by clicking Finish, the green and yellow markers – 
but not the red ones – are treated as pulse peaks. 

The Settings group box at the top of the Peak Detection semiautomatic view dialog box 
contains the most recently selected parameters for calculating: 

• The name of the selected channel 

• The interval between two pulses with a tolerance range 

• The marker name 

• The correlation trigger 

• The amplitude trigger  
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The table shows the intervals in which not enough peaks were detected. These intervals are 
known as gaps. If you double-click a row in the table, the view switches to show the position of 
the gap. The table is continuously updated when the markers are deleted or confirmed. 

If you select the Correlation > Graph check box, the correlation graph is displayed in the 
channel as an overlay. The Correlation Scale list box contains the factor used to display the 
correlation. By changing this value, you can change the size of the correlation graph in order to 
adjust it to the display of the EEG. 

If you select the Correlation > Trigger check box, the correlation trigger is displayed. 

The Correlation > Cut function shows either: 

• The correlation wherever it is greater than the correlation trigger (only within 
these intervals is a search carried out for the maximum correlations) 

or 

• The constant trigger value wherever the correlation is lower than the correlation 
trigger 

The green markers indicate local maximum correlations obtained within the intervals by means 
of the “correlation > correlation trigger” attribute. 

 

 

Figure 12—145 Correlation trigger (green line) and local minimum correlation  

Correlation and 

Amplitude group 

boxes 
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If you select the Amplitude > Graph check box, the amplitude graph is displayed in the 
channel as an overlay. The Amplitude Scale list box contains the factor used to display the 
amplitude. 

If you select the Amplitude > Trigger check box, both amplitude triggers are displayed. 

The Amplitude > Cut function shows either: 

• The constant value of the minimum trigger if the amplitude is lower than the 
minimum trigger value (A < min) 

or 

• The amplitude graph if A is greater than the minimum and lower than the 
maximum (min < A < max) 

or 

• The constant value of the maximum trigger if A is greater than the maximum (A > 
max) 

Consequently, only the pulse peaks that meet the criteria “correlation > correlation trigger” and 
“min. amplitude trigger < amplitude < max. amplitude trigger” are output as reliable peaks. 

 

 

Figure 12—146 Minimum (pink) and maximum (green) amplitude triggers  
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Figure 12—147 

 

In Figure 12—147, you can see in the highlighted area on the left that the local maximum 
correlation is greater than the correlation trigger. However, the amplitude is outside the 
permissible amplitude range. A red marker is therefore used here (unreliable peak). In the 
highlighted area on the right, the criteria “correlation > correlation trigger” and “min. amplitude 
trigger < amplitude < max. amplitude trigger” are met, so the corresponding peak is output as a 
reliable peak (green marker). 

 

The pulse template is identified in the channel by a light blue marker. This marker also 
contains an internal peak marker (a vertical black line with a circle). Both the position and size 
of the marker and the position of the internal marker can be changed. 

If you press the right mouse button and then choose Move Template Here, you can move the 
template to the required position in the EEG: 

 

 

Figure 12—148 Pulse template, “Move Template Here” function 

 

Click the Recalculate button to recalculate the markers when the template has been moved.  



 
CB Correction (pulse artifact correction) 12.6.3 

 
 
 

 
BrainVision Analyzer  12.6.3—- 13 - 

The Change Settings and Recalculate button displays the Change Settings dialog box. This 
dialog box contains the same elements for peak detection as the main Pulse Detection dialog 
box. It also contains the Use Marked Template and Find Another Template radio buttons. 

 

 

Figure 12—149 Dialog for changing the settings subsequently 

 

If you select the Use Marked Template radio button, the existing template is used. If you 
select Find Another Template, a new template is obtained. 

Click the OK button to conclude and apply your settings. 

Click the Finish button in the temporary semiautomatic view to start artifact correction. 

 

 

As with MRI scanner artifact correction, the correction of pulse artifacts is based on a template 
averaging process. Because the pulse beats are extremely variable, only the sliding method 
can be used successfully. The first step is to reliably detect the ECG episodes in order to 
determine precisely the time at which the artifacts associated with a heartbeat begin. It is not 
absolutely essential to determine the R-peak position here; it is enough to obtain a clearly 
defined, recurring attribute of the ECG recording. 

It is possible to separate the detection of pulse episodes from pulse artifact correction and, as 
an initial step, to highlight the pulse attributes. The correction can therefore be based either on 
the detection method or on markers that already exist in the EEG. 

The correlation method compares the ECG curve over time with a template curve in terms of 
their shape and amplitude and searches for peaks in those sections in which the correlation 
exceeds a specific threshold.  

Method 
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Because of the great variety of EEG/ECG recordings and situations, it is difficult to apply the 
parameters used in one case to another case. Semiautomatic mode was introduced to allow 
suitable parameters to be found and to provide an insight into the detection process. 

In order to calculate averages for the pulse artifacts in the EEG channels, the trigger times 
obtained are transferred from the ECG channel to the EEG channels, taking into account a 
selectable time delay. The correction is performed over an interval that includes the trigger 
point. The length of the interval corresponds to the average spacing between R-peaks. To 
obtain the average pulse curve, corresponding intervals of the preceding and following 
sections of the EEG are used. Linear trends are calculated before averaging. Sections identified 
as bad intervals are excluded from the calculation. The correction involves subtracting the 
calculated average pulse curve from the EEG. This is performed separately for each ECG 
episode and each channel. 

 

 

[All98] P.J. Allen et al., Identification of EEG Events in the MR Scanner: The Problem of Pulse 
Artifact and a Method for Its Subtraction. Neuroimage 8 (1998), 229-239. 
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12.7 Transforms in the Others group 
 
 

12.7.1 Data Cache 
 
 

The Data Cache transform allows the data of the parent node to be saved so that it can be 
accessed more quickly than if it had to be recalculated. 

The Data Cache transform always queries the data of the parent node at fixed intervals. 
Segmented nodes are saved segment by segment. Non-segmented nodes are saved at user-
definable intervals. 

Whether or not the Data Cache transform can be used effectively depends on the preceding 
transformations. Some transforms, such as the Average transform or the Fast Fourier transform, 
always save their data in the history node. Others, such as the MR Correction transform, have 
parameter options that allow data to be stored temporarily. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Others > Data 
Cache. 

 

 

Figure 12—150 Data Cache dialog box  
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The four radio buttons in the dialog box allow you to choose between four different methods of 
data storage: 

• Store in Persistent Cache File: The data is stored in a permanent file on the hard 
disk. 

• Store in Temporary Cache File: The data is stored in a temporary file on the hard 
disk. 

• Store Uncompressed in History Node: The data is stored in the history node 
uncompressed. 

• Store Compressed in History Node: The data is compressed and stored in the 
history node. 

In the Compression Resolution [nV] text box, you can specify the resolution 
(precision) of the compression. The resolution for EEG data should be about 100 
nV (nanovolts, 1 μV = 1000 nV), i.e. 0.1 μV. A lower value means a higher 
resolution but less compression. 

Note that persistent cache files continue to use storage space on the hard disk until the 
associated transform node is removed from the cache for deleted nodes by means of the 
Purge Deleted Nodes function. 

Note also that when very large quantities of data are stored uncompressed in the history node, 
this can result in increased access times. 

 

The Cache Data on Request check box is only relevant to the first two storage methods. If the 
check box is selected, the cache is only calculated the first time you request the data. If the 
check box is cleared, the data is only calculated when you conclude your entries with OK. 

Regardless of the Cache Data on Request check box, the data of the parent node is always 
requested in segments or the intervals used. 

Total Data Size indicates the total volume of the uncompressed data. 

The text boxes in the Cache Intervals group box are only relevant in the case of non-
segmented data: 

• Data Request Interval [s]: The data is always written to the cache at intervals of 
n seconds. 

• Request Buffer Before Interval [s]: The data is also requested from the parent 
node n seconds before the actual cache interval. 

• Request Buffer After Interval [s]: The data is also requested from the parent 
node n seconds after the actual cache interval. 

Consequently, the cache consists of several intervals of the length specified in the text boxes 
in the Cache Intervals group box. For each of these intervals, a quantity of data is requested 
from the parent node that corresponds to the sum of all three values. The request before and 
after the cache interval is relevant when settling times have to be taken into account, as with 
IIR filters, for example. 

The four data storage methods always respect the above when data is not segmented. 
Consequently, the cache is always filled with the same data, regardless of the order in which it 
is structured. 
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12.7.2 Edit Markers 
 
 

The Edit Markers transform allows you to set and edit markers. 

 

No previous processing steps are required before the transform is used. 

To display the dialog box for the transform, you choose Transformations > Others > Edit 
Markers. 

 

 

Figure 12—151 Initial Edit Markers dialog box 

 

To begin with, you specify the type of marker editing. You can choose from the following 
modes: 

• Automatic: This mode is for editing existing, complete marker groups. 

• Table: In this mode, you can set and edit individual markers. The markers are 
positioned with pinpoint precision. 

• Graphical: This mode allows you to set and edit individual markers freely in the 
EEG. 

  

Summary 

Procedure 
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If you select the Automatic radio button, the Next button displays the following dialog box: 

 

Figure 12—152 User Markers dialog box after you select the Automatic radio button 

 

Each row in the table represents an editing rule. For each row, all the markers of the data set 
are selected with a suitable type and description and edited as specified. The rows are 
processed in the order in which they appear in the table. 

The controls in the upper part of the dialog box make it easy to create new rows for the table. 
Existing rows can be edited directly in the table. 

From the Choose Marker Type drop-down list, you choose the type of the marker to be 
changed. The list contains the marker types that exist in the data set. When changes are made, 
the New Marker Type text box is updated. From the Choose Marker Description drop-down 
list, you choose a description for the marker. 

If you select the Delete these Markers? check box, all markers of the chosen type and with 
the chosen description are deleted. 

The New Marker Type and New Marker Description text boxes allow you to change the 
marker type and description. The Choose Channel drop-down list allows you to choose the 
new channel for the markers. If the marker channel is not to be changed, you can select No 
Change. 

In the Time Shift in ms text box, you specify the value for the time shift of the marker. The 
relevant marker is moved by this value to the left (negative value) or right (positive value) on 
the axis. 

The Clear button deletes all entries and resets the Choose Channel function to All. The Add 
button adds the new editing rule to the table. 

The Move Row Up and Move Row Down buttons allow you to change the position of the 
selected row in the table and thus the order of the various processing steps.  

Automatic mode 



 
Edit Markers 12.7.2 

 
 
 

 
BrainVision Analyzer  12.7.2—- 3 - 

The User Properties button displays the following dialog box, which contains the user-specific 
marker properties. These properties apply to a single marker group in each case: 

 

 

Figure 12—153 User Properties dialog box, Edit Markers transform 

 

In the Property Name cell, enter the name of the property. You can make any entry here. The 
Value cell contains the associated value. This value is assigned a programming data type that 
you choose from the drop-down list in the Datatype column. 

The Show Original User Properties and Show Changed User Properties radio buttons allow 
you to specify whether the original user properties or the user properties you have edited are to 
be displayed. 

You can delete existing user properties by selecting the row in the grid in the view of the 
changed user properties and pressing the <Delete> key to delete it. The row turns red, and the 
data type NULL appears in the Datatype column. Alternatively, you can specify the data type 
by choosing NULL from the drop-down list. To undo this deletion, you can set one of the other 
data types for the row at any time.  
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If you select the Table radio button, the Next button displays the following dialog box: 

 

Figure 12—154 Edit Markers dialog box after you select the Table radio button 

 

The table contains the type (Type column), the description (Description column), the 
associated channel(s) (Channel column), the marker position in ms (Position column), the 
line width of the marker (Points column), the user-specific properties (User Properties 
column) and the marker status (Status) for the markers set in the EEG. 

A marker can have the following statuses: unchanged, changed, deleted and added. The 
Status column is updated automatically. The statuses have the following color codes: 

• Unchanged markers: black 

• Changed markers: blue 

• Added markers: green 

• Deleted markers: red 

 

You change the entries in the Type, Description, Position and Points cells by double-clicking 
the cell. You select a channel from the drop-down list in the Channel column. You delete a 
column from the table by pressing the <Delete> key. 

If you select the Show Original Markers radio button, the status of the markers in the original 
data set is displayed. If you select the Show Changed Markers radio button, the changed 
markers are displayed in the color coding corresponding to the changes made.  

Manual mode 
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If you click the Reset Selected Markers button, the selected markers are reset to their original 
status. The Reset All button resets all markers to their original status. 

The User Properties button displays a dialog box containing the user-specific marker 
properties. These properties apply to a single marker. This dialog box is the same as the User 
Properties dialog box in automatic mode. 

 

 

If you select the Graphical radio button, the Next button displays a data window in interactive 
mode. The window contains a temporary Semiautomatic View dialog box that helps you with 
marker editing. 

 

 

Figure 12—155 Part of an EEG with the temporary Semiautomatic View dialog box after 

selecting the Graphical radio button 

 

A marker must be active before you can edit it. If it is, the marker label is framed by a gray box. 
In the case of a marker with multiple points, the box appears as soon as you position the 
mouse pointer on the marker. In the case of a marker with only one point, the box appears 
when you position the mouse pointer on the marker label.  

Graphical mode 



 
Edit Markers 12.7.2 

 
 
 

 
BrainVision Analyzer  12.7.2—- 6 - 

Shift+Click on Graph to add marker function: 

You set a marker by holding down the <Shift> key and clicking in the graph. You can set the 
properties of the new marker using the controls under Next New Marker. This is useful when 
you want to create a number of markers of the same type. By means of a single mouse click you 
create a marker of the width specified in the Point Width text box. If you want to set a marker 
with a different number of points, hold the mouse button down and drag the mouse pointer to 
the left or right over the graph. 

 

 

Figure 12—156 Markers with more than one point 

 

Drag/drop markers to reposition them and Hold alt key while dragging to fix marker data 
position functions: 

You change the position of a marker by clicking the marker, holding down the mouse button 
and dragging the marker to the desired position. The graph on which you are positioning the 
active marker changes color from black to orange. 

You can place a marker on a graph, in a channel or in the margin along the bottom of the 
screen for all channels in the area of the marker. If you hold down the <Alt> key when dragging, 
the marker is placed on the new channel but remains on the same data point.  

 

 

Figure 12—157 Changing the position of a marker  
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Markers with multiple points have a positioning handle at each end with which you can change 
the size of the marker. The positioning handle becomes visible when you move the mouse 
pointer near the end of the marker. 

 

 

Figure 12—158 Marker with positioning handles 

 

Markers that apply to all channels and range highlighting can be resized in a similar way. 

 

    

Figure 12—159 Positioning handles of a marker for all channels and range highlighting 

 

Click on Marker Label to Edit function: 

To edit a marker, click the marker or its label. A dialog box appears, in which you can change 
the marker’s description (in the Description text box), type (in the Type drop-down list box) 
and width (in the Point Width text box). 

 

 

Figure 12—160 Dialog box for editing markers in graphical mode 

 

Shift+Click on Marker to Remove Marker function: 

To delete a marker, press the <Shift> key and click the marker or its label.  
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The controls in the Next New Marker group box set the properties of the next marker created 
with <Shift> plus a mouse click. From the Description and Type drop-down list boxes, you can 
either choose a description or type from those already in the data set or enter a new text. In the 
Point Width text box, you specify the length of the marker in data points. 

The Undo and Redo buttons in the lower part of the temporary semiautomatic view dialog box 
allow you to reverse and restore the changes. 

If you want to interrupt your editing of the markers and resume later, you click the Suspend 
button. The Edit Markers transform is highlighted in red in the list of history nodes, and all the 
processing steps carried out continue to apply until you open the node again with a double-
click. No transforms or anything else can be applied to the interrupted node. 

 

 

Figure 12—161 Interrupted marker editing 

 

If you click the Cancel button, interactive mode is terminated and the operations performed 
are not saved. 
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12.7.3 MATLAB® 
 
 

The software package MATLAB® from MathWorks has become established in the scientific 
world for a variety of reasons. Its numerous libraries for signal processing and visualization, 
some of which are available free, have made MATLAB® a valuable tool in the field of brain 
research as well. Of all the libraries that are available in this field of application, the EEGLab 
package has made a particular name for itself. 

MATLAB® and the Analyzer have different strengths in terms of functionality and user 
guidance, so they complement each other ideally. The MATLAB® transform allows data to be 
exported from the Analyzer to MATLAB®, processed there and then imported back into the 
Analyzer. In this way, MATLAB® processing methods are integrated in the Analyzer, in a similar 
way to macros, and can also be used in history templates. 

 

In order to use the transform, you must have a valid license for MATLAB® Version 7.4 or higher 
installed on your computer. This is not shipped with BrainVision Analyzer; you have to 
purchase the license directly from MathWorks. Simply installing a MATLAB® runtime 
environment does not allow you to run the MATLAB® transform. 

 

The transforms of the Analyzer can essentially be subdivided into two categories: 

There are transforms that calculate and store their data when the history node is created, and 
there are transforms that first create a history node and do not calculate the data and make it 
available until requested to do so by views or subsequent transforms. The transforms of the 
first category include the Average transform and the Fast Fourier transform (FFT). The data 
calculated by these transforms differs so fundamentally in its structure from the original data 
that it makes sense to calculate it fully and store it each time the transform is called.  

The transforms belonging to the second category include filtering transforms and the RMS 
transform. A section of these transforms can be calculated using sections of the original data 
set. The original data sets that use these transforms are generally of the same order of 
magnitude as raw data. Calculating and storing all of this data would be very heavy on 
resources, which is why calculation on request makes more sense. 

The MATLAB® transform supports both procedures. This means you can select the most 
suitable option, depending on the original data and the scope of the required calculation in 
MATLAB®. 

 

To display the dialog box for the transform, you choose Transformations > Others > Matlab. 

Depending on whether you want to calculate the data when the node is created or on request 
(see the preliminary remarks), select the Calculate Data on Creation of Node or Calculate 
Data on Request radio button. The appearance of the dialog box differs depending on which 
radio button you select:   

Summary 

Prerequisite for use 

Preliminary remarks 

Procedure 
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Figure 12—162 MATLAB® dialog box with the Calculate Data on Creation of Node radio 

button selected 

 

 

Figure 12—163 MATLAB® dialog box with the Calculate Data on Request radio button 

selected  
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If you select the Calculate Data on Creation of Node radio button, a large text box appears in 
which you can enter the MATLAB® code to be processed. Enter all the code required to process 
the EEG data, change properties and create new markers in the Code Executed on Creation of 
Node text box. 

If you select the Calculate Data on Request radio button, two text boxes appear for MATLAB® 
code. In the first of these text boxes, you enter all the MATLAB® commands that you want to 
be executed when the node is created. These will generally involve changes to the EEG 
properties or the creation of new markers. Note that if you select this radio button, for 
performance reasons no EEG data is made available to you at this stage. The EEG data is not 
transferred to MATLAB® until requested by subsequent transforms or views. In the lower text 
box, you enter the code for the processing of this data. 

You will find examples of the use of these two radio buttons at the end of the chapter. 

Data can be exported to MATLAB® in two different formats: a simple matrix format or the 
EEGLab format.  

To select the EEGLab format, select the Export Data in EEGLab Format check box. The EEGLab 
format is adequately documented so it is not necessary to provide a description of it here. 

The matrix format of the data, which you get when you do not select the check box, has the 
following structure: 

 

 

Figure 12—164 Data in simple matrix format 

 

The exported EEG data is stored in a MATLAB® matrix with the name EEGData. The data points 
correspond to the rows of the matrix, and the channels correspond to the columns. In the case 
of segmented data, the matrix has an additional dimension that corresponds to the individual 
segments. This format is ideal for further processing by the signal processing and data 
visualization commands (filter, plot, etc.) contained in MATLAB®. The EEG properties are 
contained in the MATLAB® Properties variable.   
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Figure 12—165 Properties variable 

 

This is a variable of the type struct, in which the individual properties can be accessed by 
means of their names. This also applies to any user properties in the data set. The individual 
properties are stored in MATLAB® according to their type. The channel properties, for example, 
can be accessed via the field of structs called Channels. 

 

 

Figure 12—166 Channel properties 

 

It is similar with the markers. By default, these are not exported to MATLAB® because this 
could involve the export of large volumes of data. To export markers to MATLAB®, you have to 
select the Export Markers check box explicitly in the dialog box. A variable called Markers 
then becomes available to you in MATLAB®. This is a field of structs. As with the properties, 
these structs provide access to the individual marker properties.  
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Figure 12—167 Markers variable 

 

The EEGPosition and EEGPoints variables specify the position and length of the EEG data in the 
overall data set. They are relevant primarily when the EEG data is processed on request. 
Otherwise, the position is 1 and the length is the length of the original data set. 

The FileName variable specifies the name of the history file, and the NodeName variable 
specifies the name of the history node. The Analyzer variable contains information about the 
Analyzer. You can also use these variables in template mode to program flexible behavior in 
MATLAB® scripts. 

 

 

Figure 12—168 Variables with information on the node and the Analyzer environment  
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The EEGTime variable, which is exported together with segmented data, contains a time vector 
of the EEG data set. This can be used, for example, in the plot function for drawing the time 
axis. 

The data is imported into the Analyzer again from the variables described above. In other 
words, changes in Properties and EEGData are imported back into the Analyzer as changes. The 
current status of the transform does not allow changes to be made in the markers. However, 
you can create new markers by creating a variable in MATLAB® called NewMarkers that has a 
similar structure to the Markers variable. 

In addition to the options described above, you can also make the following settings in the 
dialog box: 

Export Data as Single: To save storage space when there are large volumes of data, the EEG 
data is stored as floating-point numbers with single precision. 

Pack Data During Transfer: When large volumes of data are transferred to MATLAB®, storage 
bottlenecks can occur there because MATLAB® loads matrices in contiguous portions of main 
memory. If you select this check box, a pack command is called in MATLAB® at regular 
intervals during the transfer of data in order to enlarge the contiguous portion of main memory. 
If you do not transfer large volumes of data, we recommend that, in order to obtain better 
performance, you do not select this check box. 

Show Matlab Window: This setting opens a MATLAB® command window following data 
export. Processing is suspended in the Analyzer, and the following message window appears. 

 

 Figure 12—169 Message window 

 

You can then execute commands interactively in MATLAB® and examine and edit data. Note 
that these commands entered interactively are not returned to the Analyzer. They are thus not 
suitable for History Template mode. However, interactive mode is ideal for familiarizing 
yourself with the data in MATLAB® and compiling commands that you can enter in the 
MATLAB® command field when the MATLAB® transform is called subsequently. 

When you click OK in the message window, the Analyzer resumes processing, imports the data 
from MATLAB® and writes it to the history node created.   
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The procedure is similar for Raise EEGLab. In this case, the interactive user interface of EEGLab 
appears in addition to the MATLAB® command window. The package must be installed on 
your computer, and the paths must be registered with MATLAB®. If you select the Raise 
EEGLab check box, you can specify the name of the data set in EEGLab. You can use the 
placeholders $h and $n for this, as elsewhere in the Analyzer. 

 

 

Figure 12—170 Interactive EEGLab user interface 

 

Note that it only makes sense to select the Show Matlab Window and Raise EEGLab check 
boxes for working interactively with MATLAB®/EEGLab if the data is calculated and stored 
when the history node is created.  

In the operation information of the Analyzer, you will find, in addition to the parameters that 
are set, including the MATLAB® code, the contents of a variable called Description, which you 
can define and to which you can assign values in MATLAB®. In this way, it is possible to 
transfer information from the calculation in MATLAB® to the operation information of the 
Analyzer. 

 

The functionality of the MATLAB® transform is illustrated below using two examples. 

Example 1: Simple plot with MATLAB® 

In this example, the plot function of MATLAB® is used to display the EEG data. The exported 
matrix already has the appropriate format for this. 

For this example, select a node with a short data set (an Average data set, for example). The 
example does, of course, work with longer data sets, but that requires more resources. 

Select Calculate Data on Creation of Node and Show Matlab Window. In the code text box, 
enter the following command: 

plot(EEGTime, EEGData); 

Then run the transform by clicking the OK button.  

Examples 
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Figure 12—171 Example: simple plot 1 

 

MATLAB® is called, and an additional window opens. This contains a MATLAB® plot of the 
EEG data. 

 

 

Figure 12—172 MATLAB® plot of the EEG data 

 

When you click OK in the message window, MATLAB® is closed again and a new node is 
created that contains the data of the original node because, apart from the plotting of the data 
in MATLAB®, no further operations have been executed.  

If you want to navigate through the MATLAB® plots using the Analyzer navigation function, 
specify that the graph is to be created on request. For this example you can use a larger data 
set (a raw data set, for example).  
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Figure 12—173 Example: Simple plot 2 

 

A new node appears in the Analyzer that displays the same data as the original data set. In this 
case, no data is stored additionally in the history node. In addition, a MATLAB® plot window 
appears whose display changes when you navigate in the Analyzer.  
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Example 2: FIR filter with MATLAB® 

MATLAB® offers comprehensive signal processing methods. For example, you can use two 
commands to create an average FIR filter. Because this kind of filter tends to be used on raw 
data, the Calculate Data on Request radio button is provided: 

 

Figure 12—174 Example of the creation of an FIR filter 

 

In this case, an FIR filter with a length of 9 is created with constant filter coefficients of 1/9. If 
necessary, you can use the MATLAB® functions to define more complex FIR filters.  

When you execute the MATLAB® transform with the above parameters, you get a new history 
node that makes the filtered data available on request with the help of MATLAB®. Compare 
the data with the raw data in the Analyzer using the overlay function, and try navigating 
through the data set. Try the transform out in a history template as well. 
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12.7.4 Topographic Interpolation 
 
 

The Topographic Interpolation transform allows virtual EEG channel values to be obtained on 
the basis of real existing values. The background to topographic interpolation is the spatial 
distribution of the electrodes on the surface of the head. The purpose is to establish the 
comparability of the EEG data with external data. 

The Topographic Interpolation transform is used in two cases:  

It is used when the channels of two different EEGs are to be compared, but the EEGs differ in 
their channel configuration. Additional, virtual channels are created for the EEG that 
correspond to those of the data set to be compared. 

The transform is also used when an error-ridden or defective channel has to be replaced (for 
example, because of excessive noise or a failed electrode during recording of the EEG). In this 
case, the Edit Channel function is used first to remove the affected channel from the data set. 
In a second step, the corresponding value is calculated by means of topographic interpolation. 
The virtual channel that has been calculated is then added to the EEG data set. 

 

Note that the EEG data set must have at least four channels with coordinates. 

 

To display the dialog box for the transform, you choose Transformations > Others > 
Topographic Interpolation. 

 

Figure 12—175 Topographic Interpolation dialog box  

Summary 

Prerequisite for use 

Procedure 
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In the Topographic Interpolation dialog box, you specify whether the data is to be calculated 
by triangulation and linear interpolation (Triangulation and Linear Interpolation radio 
button) or interpolation with splines (Interpolation by Spherical Splines radio button). 

If you decide on interpolation with splines, you enter the spline order in the Order of Splines 
text box and the maximum degree of the Legendre polynomial in the Max. Degree of Legendre 
Polynomials text box. 

If you select the Default Lambda check box, the default value of 10-5 (1e-5) is automatically 
accepted. If you clear the check box, you can enter a different value. 

We recommend that you enter a value of 10 in the Max. Degree of Legendre Polynomials text 
box and a value of 10-5 (1e-5) in the Lambda text box. 

 
If you clear the Keep Old Channels check box, the output data set contains only the 
interpolated channels. If you select it, the data set contains both the old and new channels. 

The New Channels On Top check box allows you to specify whether new channels are added 
at the beginning or end of the list of channels. This setting is only relevant if you have selected 
the Keep Old Channels check box. 

In the table, you enter the name (in the Name column), Radius (in the Radius column) and 
coordinates (in the Theta and Phi columns) of the channel created by interpolation. 

Please note the following special rule: If you enter a channel name of a channel that already 
exists in the EEG, this channel is no longer included in the output data set. (However, this is 
only relevant if you have selected the Keep Old Channels check box.) The original channel is 
always used in interpolation, regardless of the special rule. 

Note that it is not possible to enter one and the same channel name in the table. You receive 
an error message if you do this. 

 

Two different interpolation methods are used: triangulation and linear interpolation and 
interpolation by spherical splines. In triangulation and linear interpolation (Triangulation and 
Linear Interpolation radio button), the surface of the head is triangulated (divided up into 
triangles), and the values are calculated for each triangle by means of linear interpolation. 

Interpolation by spherical splines (Interpolation by Spherical Splines radio button) consists 
of a set of basic spline functions. The form of the basic functions is influenced by the Order of 
Spline parameter. The spherical splines are calculated by means of an approximation method. 
The degree of accuracy of the result of the calculation depends on the Maximum Degree of 
Legendre Polynomials and Lambda parameters. We recommend that you enter a value of 10 in 
the Max. Degree of Legendre Polynomials text box and a value of 10-5 (1e-5) in the Lambda 
text box. Experience has shown that these values lead to satisfactory results. Because they are 
used so frequently, the results are also comparable. If you select the Default Lambda check 
box, the default value of 10-5 (1e-5) is automatically applied. If you clear the check box, you can 
enter a different value. We recommend that you only do this if you know that the value you 
enter will meet your requirements.   

 

 

Additional 

information 
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Figure 12—176 Selecting the interpolation method on the Maps tab of the Default View 

Settings dialog box 

 

 

[Per90] F. Perrin et al., Spherical splines for scalp potential and current density mapping. 
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13 Add-ins 
 
 

13.1 Marker Navigation 
 
 

The Marker Navigation add-in allows you to navigate to selected markers. 

To display the add-in, you choose Add Ins > Tools > Marker Navigation. A dockable window 
opens in the upper part of the view. 

 

Figure 13—1 Marker Navigation interface element 

 

The Marker Type and Marker Description drop-down list boxes contain all the marker types 
and marker descriptions in the associated data set. You can use the drop-down list boxes to 
navigate to specific markers. To navigate to any type or any description, choose <any> from the 
corresponding drop-down list box. 

The buttons  and  allow you to navigate to the next or previous marker that meets 
the criteria chosen from the Marker Type and Marker Description drop-down list boxes. If the 
data set does not contain a combination of marker type and description, the buttons are 
inaccessible. 

If you navigate to a marker in this way, the marker appears in the middle of the part of the EEG 
that is displayed. The marker appears in green in the marker window. 

Note that the Marker Navigation add-in does not change the channel display. In other words, 
markers may not be visible in the channels. 

If you have multiple data sets open, navigation is carried out separately for each data set, and 
that includes the selection of the marker type and description. 
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13.2 Analyzer Video 
 
 

The Analyzer Video add-in is for playing video data and EEG data synchronously. 

The prerequisite for the operation of the plug-in is that Codec must be installed. You will find 
Codec and notes on its installation on the BrainVision CD. 

Open an EEG data set containing a video sequence, and call the add-in by choosing Add Ins > 
Plug In > Analyzer Video. A dockable video window opens in the upper part of the view. 

The video view is possible for both raw data and derived history nodes (transforms). 

 

Figure 13—2 Combined EEG/video playback 

 

The date and time of the video recording are displayed at the top of the window. 

The video window contains the buttons Play, Pause and Stop. The Sync. EEG button allows 
you to synchronize the EEG manually with the current video position. 

The transparent bright blue highlighting indicates the position in the EEG. If you activate the 
marker by clicking the data displayed, the context menu allowing you to select transforms does 
not appear. To display this menu, you then have to right-click the data. 

If you select the Video is Master check box, the navigation in the EEG follows the navigation in 
the video. In other words, if you change the position of the slider for the video, the slider for 
the EEG jumps to the corresponding position in the EEG view. 

If you select the EEG is Master check box, the navigation in the video follows the navigation in 
the EEG. In other words, if you change the position of the slider for the EEG, the slider for the 
video jumps to the corresponding position in the video. 

If both check boxes are selected, navigation in the EEG and video is fully synchronized. 
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13.3 Generic Data Header 
 
 

The Generic Data Header add-in allows you to generate header files for the Generic Data Reader 
(GDR). 

To call the add-in, you choose Add Ins > Others > Generic Data Header.  

The Select Data File dialog box appears, in which you can select a file containing EEG data. The 
Generic Data Header dialog box then appears. 

 

Figure 13—3 Generic Data Header dialog box 

 

The dialog box allows you to make entries for the .vhdr file to be created. On the various tabs 
(Properties, ASCII Infos, Binary Infos and Channels), you can make appropriate entries for 
your EEG. You will find detailed information on the settings in section 16.1.2, “Generic Data 
Reader”. 

On the Channels tab, you can specify the number of channels in the EEG in the Number of 
Channels text box. Click Refresh to add new rows to the table or delete rows from the table. 

You can also rename the channels in the table, among other things. However, we recommend 
that you find out how many channels there are before you start renaming them.  



 
Generic Data Header 13.3 
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Figure 13—4 Renaming channels 

 

The Save Header button saves your entries and creates the .vhdr file. Once the header file has 
been created, you can display the data on the right-hand side of the dialog box by clicking 
Display View. The label on the button then changes to Update View. If you make changes to 
the settings, you can update the view by clicking Update View. 

 

Figure 13—5 Display of the EEG 

 

The buttons + / –, Scale up/Scale down and <-- / --> allow you to navigate in the EEG 
displayed. 

 



  
LORETA 13.4 
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13.4 LORETA 
 
 

The functions of the LORETA add-in are the same as the functions of LORETA as a transient 
view. You will find a detailed description in section 14.3. 

The difference between LORETA as a transient view and as an add-in is as follows: As a 
transient view, LORETA is tied to a selected data set. As an add-in, on the other hand, the 
display of the data relates to the current view, and it is possible to switch between the different 
views. 

To execute LORETA as an add-in, you choose Add Ins > Others > Loreta. 

 

 



  
Transient transforms 14 
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14 Transient transforms 
 
 

The transient transforms are exclusively for the temporary display and inspection of the EEG 
data. They are transient because their result is not stored anywhere. 

You call the transient transforms by using the mouse to select a point or section of the EEG. 

A context menu appears when you release the mouse button, offering you a selection of 
transforms (3D Head View, CSD Map, FFT, Loreta, Map, Zoom).  

If you select one of these transforms, the current data window is divided into two. The result of 
the transform is displayed on the right. It applies to the currently selected point or section. If 
you change the position of the marker, the transient view is updated. 

 

 

Figure 14—1 First menu for calling the transient transforms  
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Alternatively, you can select a section of the EEG, right-click in the EEG to display the context 
menu and choose an item from the Transient Views submenu. 

 

 

Figure 14—2 Second menu for calling the transient transforms 

 

When you select one of these transforms, the current data window is divided into two. The 
result of the transform is displayed on the right. It applies to the highlighted section of the EEG. 
If you change the position of the highlighted section by positioning the mouse over it, holding 
down the mouse button and moving the mouse pointer horizontally, the result of the transient 
view is updated. 

The dockable window on the right has a separate toolbar at the top, which allows you to 
change the settings of the transient view. 

You can change the size of the subwindow for the display of the transient transforms by using 
the mouse to move the separating bar between the subwindows. 

You close the right-hand subwindow by clicking the cross  in its title bar. 

 



  
3D Map 14.1 
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14.1 3D Map 
 
 

The 3D Map option creates a 3D topographic map that displays the voltage distribution on the 
head in the time or frequency domain. 

In order to generate the map, the program requires information about the position of the 
electrodes. If you used electrode names on the 10/10 or 10/20 principle when recording the 
EEG, the program should have this information. However, if you used other channel names, you 
can use the Edit Channels transform to enter the correct coordinates. You will find detailed 
information on this in section 12.1.6, “Edit Channels”. 

 

 

Figure 14—3 3D map 

 

You will find more information on the 3D map in section 9.2.4. 
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14.2 Current Source Density (CSD) 
 
 

You will find detailed information on the CSD Interpolation transform in section 12.4.6. 

If you use the CSD transform in its transient form, the current source density is represented in a 
map. An order of 4 and a polynomial degree of 10 are used implicitly for the calculation. 

To display the result of the transient CSD transform to best effect, we recommend that you use 
interpolation by means of spherical splines for the map. You do this by selecting the 
Interpolation by Spherical Splines radio button on the Maps tab of the Default View 
Settings dialog box (see also section 7.3.2, “Category-related view settings”). 

 

 

Figure 14—4 CSD map 
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14.3 LORETA 
 
 

The LORETA transient view is for source localization by means of the Low Resolution Brain 
Electromagnetic Tomography method of R. D. Pascual-Marqui. 

 

The virtual MR anatomical images are made available by the Montreal Neurological Institute of 
McGill University. 

 

You can use LORETA on a data point, a selected range of the EEG or the currently displayed 
section of the EEG. 

You begin by selecting a point or range in the EEG. A context menu appears. Choose the Loreta 
command from the menu. 

 

 

Figure 14—5 Context menu for calling LORETA 

 

A dockable window opens. The window contains three cross-sections through a virtual head. 

The window works in the same way as a map: You can use the mouse to move the point or 
range highlighting. The display of the cross-sections changes to reflect this.   

Summary 

 

Procedure 
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Figure 14—6 Docked LORETA window 

 

 

Figure 14—7 LORETA window, detailed view  
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(1) You can navigate in the cross-sections or layers of the tomography either by using the 
mouse to move the four yellow sliders on the borders of the cross-sections in the desired 
direction or by clicking a point in the cross-section and using the mouse wheel to scroll up and 
down. When you click in a cross-section, the position of the sliders is updated. 

(2) If you move the highlighting in the EEG in the view window and then release the mouse 
button, the display in the LORETA window is updated. 

 

In the status bar of the LORETA window, Range indicates the range or point selected in the 
view (range or single-point highlighting), the cross-section coordinates of the sliders (in 
parentheses) and the current flow density. 

The information box above the status bar, which relates to the position of the mouse in the 
LORETA window, provides the following information (in this order): 

• The parentheses contain the cross-section coordinates of the current position of 
the mouse pointer (crosshair). When you move the mouse pointer around the 
cross-section, the coordinates displayed change accordingly. 

• The value for Best match at specifies the distance from the current mouse 
position of the next voxel containing stored physiological data. This is the data 
from the LORETA program. 

• The next three lines indicate the associated anatomical data of the brain areas in 
the vicinity of the mouse pointer. 

 

 

Figure 14—8 Display of the mouse pointer in the cross-section 

 

If the mouse pointer is positioned outside the three cross-sections, the information box 
displays the values of the current intersection of the three cross-sections. 

  

Navigation 

LORETA window 
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You display the context menu of the LORETA window by right-clicking in the window. The 
context menu contains the following commands: 

 

Figure 14—9 Context menu of the LORETA window 

 

Save as File saves the LORETA view as a file. The graphics formats EMF, BMP, PNG and JPEG 
are available to you. 

Print opens the dialog box for printing the LORETA view. 

Lock Navigation to Maximum: If you choose this command, the display focuses on the 
position with the strongest brain activity. 

 
Settings… opens the associated dialog box for changing the settings: 

• From the 3D Anatomy drop-down list, you can choose a virtual MR anatomical 
image. 

• You can also switch between automatic and manual scaling. 

 

 

Figure 14—10 Settings dialog box 

  



 
LORETA 14.3 
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Show Horizontal Slices… opens a new window (Horizontal Slices) containing horizontal 
cross-sections (z-axis) at fixed intervals. If you right-click in the window, the associated context 
menu appears. This contains two commands: 

• Settings… displays the Borders and Step dialog box, in which you can specify 
the minimum and maximum z-coordinates and the size of the steps (in the Step 
text box). 

• Export as Bitmap… allows you to export the file as a bitmap. 

 

Figure 14—11 Dialog box for displaying the horizontal cross-sections, 

including settings dialog box 
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14.4 Fast Fourier transform (FFT) 
 
 

The FFT displays the frequency spectrum of the current section. It always uses the standard 
view and the currently selected montage. 

The transient view also has a separate toolbar. 

 

Figure 14—12 FFT as a transient transform 
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BrainVision Analyzer  14.5—- 1 - 

14.5 Map 
 
 

The Map option creates a 2D topographic map that displays the voltage distribution on the 
head in the time or frequency domain. 

As with the 3D Map transient transform, valid head coordinates are required to display the 2D 
map. If you used electrode names on the 10/10 or 10/20 principle when recording the EEG, the 
program should have this information. However, if you used other channel names, you can use 
the Edit Channels transform to enter the correct coordinates. You will find detailed information 
on this in section 12.1.6, “Edit Channels”. 

 

Figure 14—13 2D map 
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14.6 Zoom 
 
 

The Zoom option enlarges (zooms) the display of the current EEG section. It always uses the 
standard view and the currently selected montage.  

The transient view has a separate toolbar. 

Note that the zoom function is only available for the time domain. 

 

 

Figure 14—14 Zoom 

 



  
Export components 15 
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15 Export components 
 
 

The export components can be used to export data sets, markers, area dimensions and so on 
to files so that they can be further processed using other programs. You will find the export 
components on the Export tab. 

As with transforms, there are two groups of export components: simple exports (in the 
NodeExport group) and multiple exports (in the Multiple Export group). Simple export 
components always have a single input data set. ASCII exports provide an example. Multiple 
export components always have multiple input data sets. They include the Peak Information 
Export component, which creates a table of peak values on the basis of a selection of history 
files or history nodes. 

In contrast to multiple export components, simple export components can operate with 
templates. They can also only be executed when a data set is displayed – in the same way as 
primary transforms – and always relate to the active data set window. 

The simple export components provide placeholders for the name of the history file ($h) and 
the name of the current data set ($n). The advantage of using placeholders is that export 
components can also be used in history templates without existing exported files being 
overwritten constantly. This can be illustrated by an example in which there are two history 
files: “EEG1” and “EEG2”. The “Average” data set is exported for both, and the name “$h_$n” 
is entered. The resulting file names are “EEG1_Average” and “EEG2_Average”. 

If you have selected a block in the current data set, you can use the simple export components 
to export this block exclusively. 

You specify the folder for the export files by choosing File > Workspace > New or by choosing 
Edit and then entering it in the Export Files text box in the Edit Workspace dialog box. 

 

 

Figure 15—1 Specifying the export folder 

 

The next two sections of this chapter describe all the simple and multiple export components 
that are currently available with the Analyzer. The structure of this chapter is based on that of 
the Ribbon: All the export components contained on the Export tab are described one after the 
other (going from left to right).  
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BrainVision Analyzer  15—- 2 - 

When you have completed your entries, a dialog box containing the name and storage location 
of the export file appears. The dialog box below is an example for the Besa export component: 

 

 

Figure 15—2 Besa export, information on the export file 

 

Note 



  
Besa Export 15.1.1 
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15.1 Simple export components 
 
 

15.1.1 Besa Export 
 
 

The Besa Export component exports the data set or section of the data set in BESA ASCII 
format. The exported file has the file name extension “.raw”. 

 

To display the dialog box for the Besa Export component, you choose Export > NodeExport > 
Besa.... 

 

 

Figure 15—3 Besa Export dialog box 

 

You can make the following settings: 

• If you select the Export Selected Block check box, only the selected block is 
exported. This check box is only accessible if you have selected a block. 

• If you select the Export Channel Names check box, you can also export the 
channel names. 

• The Export File Name text box allows you to enter the name of the export file, for 
which you can also use placeholders. The name you create in this way appears in 
the Resulting File Name text box. 

 

Summary 

Procedure 



  
EDF Export 15.1.2 
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15.1.2 EDF Export 
 
 

The EDF Export component allows you to export EEG data in EDF or EDF+ format. 

 

To display the related dialog box, you choose Export > NodeExport > EDF.... 

 

 

Figure 15—4 EDF Export dialog box 

 

You can make the following settings: 

• The EDF and EDF+ radio buttons allow you to specify whether the data is 
exported in EDF or EDF+ format. 

• If you select the Export all Channels check box, all channels are exported. 

• The Select >> and << Remove buttons allow you to specify which of the available 
channels (in the Available Channels list box) are to be exported (i.e. included in 
the Selected Channels list box). 

• If you select the Set Resolution Manually check box, you gain access to the 
Range +/- [mV] text box, in which you can specify the range of values for the 
data to be exported. In the Resolution [μV] text box, the corresponding 
resolution of the values is automatically adjusted. 

• The Export File Name text box allows you to enter the name of the export file, for 
which you can also use placeholders. The name you create in this way appears in 
the Resulting File Name text box. 

Summary 

Procedure 



  
Markers Export 15.1.3 
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15.1.3 Markers Export 
 
 

The Marker Export component saves selected markers in an ASCII file. 

 

To display the dialog box for the Markers Export component, you choose Export > NodeExport 
> Markers.... 

 

 

Figure 15—5 Markers Export dialog box 

 

You can make the following settings: 

• The Add >> and << Remove buttons allow you to specify which of the available 
markers (in the Available Markers list box) are to be exported (i.e. included in 
the Selected Markers list box). 

• In the ASCII Line Delimiters group box, you can specify the format of line 
delimiters for all exported ASCII files in order to further process the data under 
different operating systems. The three commonly used formats for the majority of 
PC operating systems (PC Format radio button), Unix (Unix Format radio button) 
and Apple Mac (Mac Format radio button) are available for you to select. 

• The Export File Name text box allows you to enter the name of the export file, for 
which you can also use placeholders. The name you create in this way appears in 
the Resulting File Name text box. 

Summary 

Procedure 
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15.1.4 Generic Data Export 
 
 

The Generic Data Export component allows you to export data – including complex data – in 
the time and frequency domains in ASCII or binary format. 

 

To display the dialog box for the Generic Data Export component, you choose Export > 
NodeExport > Generic Data Export.... 

 

 

Figure 15—6 Generic Data Export dialog, first page 

 

On the first page of the dialog, you can make the following settings: 

• If you select the Export Selected Block check box, only the selected block is 
exported. This check box is only accessible if you have selected a block. 

• If you select the Write Header File check box, a header file is created. You can 
also generate an ASCII header file containing information on channels, the 
sampling rate, data set type, etc. This header file is in the INI file format 
commonly used under Windows®. 

• If you select the Write Marker File check box, a marker file is created. The marker 
file, which is also in INI format, lists all the existing markers together with their 
positions, types, descriptions, etc. 

• In the Data File Format group box, you specify the format of the files to be 
exported. You can specify whether the data is to be exported in ASCII format (by 
selecting the ASCII radio button) or binary format (by selecting the Binary radio 
button). In the case of the ASCII export, the values are written directly in μV or 
μV2.  

Summary 

Procedure 



 
Generic Data Export 15.1.4 
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• In the Data Orientation group box, you specify the data orientation by selecting 
either the Vectorized or Multiplexed radio button. 

This applies to the channels. Vectorized in this context means that all the data 
points of the first channel are written to the export file first, followed by those of 
the second channel, and so on. In an ASCII export, each channel to be exported is 
written to a separate line. Multiplexed means that the data of the first sampling 
time point is written first, followed by the data of the second sampling time point, 
and so on. In an ASCII export, the data of each sampling time point is written to a 
separate line. If you export complex data, the real part is written first, followed by 
the imaginary part. 

• In the ASCII Line Delimiters group box, you can specify the format of line 
delimiters for all exported ASCII files in order to further process the data under 
different operating systems. The three commonly used formats for the majority of 
PC operating systems (PC Format radio button), Unix (Unix Format radio button) 
and Apple Mac (Mac Format radio button) are available for you to select. 

• The Export File Name text box is for entering the name of the export file, for 
which you can also use placeholders. In the Base Name text box, you specify the 
base name of the file, and in the Extension text box its file name extension. The 
names you select for the export file, header file and marker file appear in the 
Resulting Data File Name, Resulting Header File Name and Resulting Marker 
File Name text boxes. 

 

To proceed to the next page of the dialog, you click the Next > button. 

 

 

Figure 15—7 Generic Data Export dialog, second page  



 
Generic Data Export 15.1.4 
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The second page of the dialog allows you to set ASCII or binary parameters. Depending on 
whether you have selected an ASCII or binary export, either the ASCII Data File Settings group 
box (on the left) or the Binary Data File Settings group box (on the right) is accessible. 

 

In the ASCII Data File Settings group box, you can make the following settings: 

• If you select the Add Channel Names to the Data File check box, the channel 
names are added to the file. In the case of multiplexed data, the channel names 
appear in the first line. Otherwise, they appear in the first column. 

• If you select the Overwrite Default Decimal Symbol (,) check box, you overwrite 
your computer’s default decimal symbol (point or comma) with the characters 
entered in the Decimal Symbol text box. Your computer’s decimal symbol 
depends on its country settings. 

 

In the Binary Data File Settings group box, you can make the following settings: 

You select either the IEEE 32-Bit Floating Point Format or 16-Bit Signed Integer Format radio 
button. If you select the former, as in the case of the ASCII export the values are written directly 
in μV or μV2. 

 
The settings below the radio buttons are only applicable if you select the 16-Bit Signed 
Integer Format radio button: 

• If you select the Set Resolution Manually check box, you set the resolution at 
which the data is written manually. In the Resolution [μV] text box, you enter the 
resolution of the values, and in the Range +/- [ms] text box the range of the data 
to be exported. If you make an entry in one of these two text boxes, the value in 
the other text box is adjusted accordingly. 

This resolution, – again in μV or μV2 – specifies the minimum difference between 
two values to be stored. Since the 16-bit format is restricted to a maximum of 216 
values, too high a resolution can result in data peaks being truncated. The range 
in mV that is achieved at the specified resolution is shown in the dialog. You can 
also enter this range instead of the resolution. 

Alternatively, you can have the program calculate and set the optimum 
resolution. In this case, however, you should always export a header file as well, 
since this is the only place you will find the resolution that has been used. 

• If you select the Individual Optimized Resolution for Each Channel check box, 
you can optimize the resolution for each channel in cases where you have the 
resolution calculated automatically. If you do not select the check box, a common 
resolution is selected for all channels. 

• If you select the Convert to Big-Endian Order check box, the exported data is 
converted to big-endian order. If you want to work with exported integer data on a 
system such as a Mac or a SUN workstation, the least and most significant bytes 
of each value have to be stored the other way round in big-endian order. 

To proceed to the final page of the dialog, you click the Next button.   

ASCII group box 

Binary group box 
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Figure 15—8 Generic Data Export dialog, third page 

 

On the last page of the dialog, you specify that all channels are to be exported by selecting the 
Export all Channels check box. 

If you do not select the check box, you can use the Select >> and << Remove buttons to select 
which of the available channels (in the Available Channels list box) are to be included in the 
export (i.e. in the Selected Channels list box). 

You click the Finish button to conclude your entries. 
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15.2 Complex export components 
 
 

15.2.1 Area Information Export 
 
 

You can use the Area Information Export component to export the area dimensions (μV • ms or 
μV • Hz) of an interval, the average activity (μV) or the total activity in an interval to an ASCII 
table. 

 

To display the dialog box for the Area Information Export component, you choose Export > 
Multiple Export > Area Information Export.... 

 

Figure 15—9 Area Information Export dialog box  

Summary 

Procedure 



 
Area Information Export 15.2.1 
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In the Input group box, you can make the following settings: 

• You specify whether the data to be exported is in the time domain (by selecting 
the Time Domain radio button) or the frequency domain (by selecting the 
Frequency Domain radio button). 

• In the Area Interval Relative to Time 0 Start [ms] and End [ms] text boxes, you 
specify the interval to be exported. 

• In the Name(s) of the Involved Data Sets (History Nodes) text box, you specify 
the names of the data sets (history nodes) involved, separated by commas. 

• If you select the Primary History Files Only check box, you limit the Use Whole 
Workspace and Select Individual History Files radio buttons to primary history 
files. 

• In the Selection Filter text box, you specify the selection filter. This filters 
selectable files on the basis of name criteria. An asterisk (*) stands for one or 
more characters, and a period (.) stands for a single character. If the workspace 
contains the files “Test1H2”, “Test2G” and “Hest5”, for example, the string 
“Test*” filters out the files “Test1H” and “Test2G” (i.e. makes them available). 
The filter “.est*” accepts all three files. Once you have set the filter, you click the 
Refresh button to refresh the selection of available files. 

• All the available files are listed in the Available Files text box. 

• The Selected Files text box contains all the selected files. 

• To select one or more files or remove them from the list of selected files, you 
select them and then click the Add or Remove button. The Add All and Remove 
All buttons do the same for all files. 

 

In the Options group box, you can make the following settings: 

• If you select the Overwrite Default Decimal Symbol (,) check box, you overwrite 
your computer’s default decimal symbol (point or comma) with the characters 
entered in the Decimal Symbol text box. Your computer’s decimal symbol 
depends on its country settings. 

• In the Rectification group box, you can specify whether the data is to be included 
in the calculation without preceding signs by selecting the Use Activity 
(Unsigned Values, Rectified) radio button or with preceding signs by selecting 
the Use Voltage (Signed Values) radio button. In the former case, the signal is 
rectified and the area or activity is then calculated. 

This option is only available for data in the time domain. In the case of complex 
data, all calculations are automatically based on the absolute values.  

Input group box 

Options group box 
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• In the Export Type group box, you specify the type of calculation to be carried out 
for the data to be exported. 

If you select the Area option, the area is exported. If you select the Mean Activity 
radio button, the average activity is exported. The Area as Raw Sum of Activity 
Values radio button is only available for frequency data. If you select it, the sum 
of the spectral line values of the defined range are exported without reference to 
the spectral line width. 

 

The Output group box contains the storage location of the export file. In the Output File text 
box, you can specify the name and file name extension of the export file. 

 

Output group box 
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15.2.2 Peak Information Export 
 
 

The Peak Information Export component exports data on the position and voltage of peak 
markers that have been set in selected history files or nodes to an ASCII table. 

 

The markers to be exported are usually set when the Peak Detection transform is used. 

 

To display the dialog box for the Peak Information Export component, you choose Export > 
Multiple Export > Peak Information Export.... 

 

Figure 15—10 Peak Information Export dialog box 

 

In the Input group box, you can make the following settings: 

• In the Peak Name text box, you enter the name you gave the peak during peak 
detection. 

• In the Name(s) of the Involved Data Sets (History Nodes) text box, you specify 
the names of the data sets (history nodes) involved, separated by commas.  

Summary 

Prerequisite for use 

Procedure 

Input group box 
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• If you select the Primary History Files Only check box, you limit the Use Whole 
Workspace and Select Individual History Files radio buttons to primary history 
files. 

• In the Selection Filter text box, you specify the selection filter. This filters 
selectable files on the basis of name criteria. An asterisk (*) stands for one or 
more characters, and a period (.) stands for a single character. If the workspace 
contains the files “Test1H2”, “Test2G” and “Hest5”, for example, the string 
“Test*” filters out the files “Test1H” and “Test2G” (i.e. makes them available). 
The filter “.est*” accepts all three files. Once you have set the filter, you click the 
Refresh button to refresh the selection of available files. 

• All the available files are listed in the Available Files text box. 

• The Selected Files text box contains all the selected files. 

• To select one or more files or remove them from the list of selected files, you 
select them and then click the Add or Remove button. The Add All and Remove 
All buttons do the same for all files. 

 

In the Options group box, you can make the following settings: 

• If you select the Overwrite Default Decimal Symbol (,) check box, you overwrite 
your computer’s default decimal symbol (point or comma) with the characters 
entered in the Decimal Symbol text box. Your computer’s decimal symbol 
depends on its country settings. 

• If you select the Export Mean Value Around Peak check box, the average value 
for the data around the peak is exported. In the +/- [Points] text box, you specify 
the width of this interval in points. 

You can also obtain an average value around the peak and export it. To do this, 
you enter a value in the +/- [Points] text box indicating how many points before 
and after the point are to be included in averaging. A value of 2 means that 5 
points are included in averaging (2 before, 2 after, and the peak position itself). 

• If you select the Export Individual Latencies for Each Channel check box, 
individual latencies are exported for each channel. 

If you used individual latencies for each channel in peak detection, you can also 
export these. If not, the latency of the first marker found in a data set is exported. 

 

The Output group box contains the storage location of the export file. In the Output File text 
box, you can specify the name and file name extension of the export file. 

 

Options group box 

Output group box 
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15.3 Additional export components: LORETA 
 
 

The LORETA export component allows you to export Analyzer data to a format that can be read 
by LORETA. The data is exported in two files: an .xyz file, which contains the coordinates of the 
electrodes, and a .dat file, which contains the actual EEG data. 

 

You display the required dialog box by choosing Export > Others > Loreta Export. 

 

 

Figure 15—11 LORETA Export dialog box 

 

In the File Name Template text box, you specify the name of the export file. The placeholders 
$h (for the name of the history file) and $n (for the name of the current data set) are available 
to you. 

 

Summary 

Procedure 
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16 Importing data, positions and markers 
 
 

16.1 Importing data 
 
 

In addition to the standard readers for many commercially used file formats, the Analyzer also 
allows user-defined formats to be imported. 

For simple ASCII formats you may be able to use the Besa format. For more complex formats 
you should use the Generic Data Reader, which gives you an abundance of configuration 
options for describing your raw data. 
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16.1.1 Besa format 
 
 

ASCII files can be imported in Besa format. This format has the following structure: 

 
First line: general information 

NPTS=<number of data points> TSB=<point in time 0 in ms> DI=<sampling interval 
in ms> SB=<scaling of data points in 1/μV> SC=<display scaling (is ignored)> 
NCHAN=<number of channels> 

Example: 

NPTS=1024 TSB=100 DI=3.90625 SB=1 SC=1 NCHAN=32 

This is a data set with 1024 data points and a prestimulus interval of 100 ms. The digitization 
interval is 3.90625 ms, which corresponds to a sampling rate of 256 Hz. The scaling value for 
data points is 1, which means the values are specified directly in microvolts. The display 
scaling (SC) is ignored. The data set has 32 channels. 

 
Second line: channel names 

The channel names are listed in the second line, separated by spaces. Example: 

Fp1 Fp2 F3 F4 etc. 

 
Third and subsequent lines: data 

The data values are entered as of the third line in the form of floating point numbers. The 
decimal symbol used is always a decimal point. Each line contains the data of one channel. 
The individual data values are separated by spaces. 

If you store the data in a raw data folder, the Analyzer reads it in like a normal raw EEG. 

You can create a sample file by exporting part of an EEG as a Besa file, as described in chapter 
15, “Export components”. 
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16.1.2 Generic Data Reader 
 
 

The Generic Data Reader (GDR) is used to read in EEG files of various formats for which there is 
no specific reader (e.g. proprietary laboratory formats). The reader uses a header file that 
describes a single EEG. This file is an ASCII file with the extension “.vhdr”. It normally gets the 
same base name as the raw data EEG described in it. The header file is stored in the raw data 
folder of the workspace.  

The format of the header file is based on the Windows® INI format. It consists of various 
named sections containing keywords/values. Here is an extract from a header file: 

Brain Vision Data Exchange Header File Version 1.0 
; Data created from history path:  
; P300b/Raw Data/Filters/Segmentation/BaselineCorrection/Average 
 
[Common Infos] 
DataFile=P300b_Average.dat 
MarkerFile=P300b_Average.vmrk 
DataFormat=ASCII 
; Data orientation: VECTORIZED=ch1,pt1, ch1,pt2..., MULTIPLEXED=ch1,pt1, 
ch2,pt1 ... 
DataOrientation=VECTORIZED 
DataType=TIMEDOMAIN 
NumberOfChannels=32 
 

The first line identifies the header file and is mandatory. 

A semicolon at the beginning of a line identifies a comment. Comments are ignored by the 
reader. Blank lines are also ignored. A section is identified by a line with a heading enclosed in 
square brackets. The header extract above, for example, contains the Common Infos section. A 
header file can contain an unlimited number of sections. 

The lines that follow contain some of the keywords in this section together with the values 
assigned to them. A keyword can only occur once in a section. Its meaning depends on the 
section in which it occurs. There must not be a space before or after the equals sign. Most 
predefined keywords have a predefined value. This is used by the reader if a keyword is not 
found. 

If you want to create a header file, it is best to export an EEG using the Generic Data Export 
component. This creates a header that is compatible with the GDR. Set the parameters in such 
a way that the format of the exported file is as close as possible to that of the one to be 
imported. You can then adapt the header to meet your specific requirements. 

The various predefined sections are listed below with their keywords, meaning and default 
values.  
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Common Infos 
This section contains general information on the EEG file. 

Keyword Meaning Default value 
DataFile Name of the EEG file. If the name does not 

contain a path, it is assumed that the EEG 
file is in the same folder as the header file. 
The placeholder $b can be used in the file 
name. It is replaced by the base name of 
the header file when the file is read in. 
Example: If the name of the header file is 
Test.vhdr, the entry DataFile=$b-EEG.dat 
is interpreted as DataFile=Test-EEG.dat. 

None, a value must 
be specified. 

MarkerFile Optional marker file. The marker file 
contains a list of markers assigned to the 
EEG. If no path is specified explicitly, the 
marker file is searched for in the folder 
containing the header file. The format of 
the marker file is explained below. The 
placeholder $b can be used in the file 
name. 

- 

DataFormat Data format. Possible values:  
ASCII, BINARY 

ASCII 

DataOrientation Data orientation. Possible values:  
VECTORIZED 
The file begins with all the data points of 
the first channel, followed by all the data 
points of the second channel, and so on. 
MULTIPLEXED 
All the channels come one after the other 
for every data point. In other words, the 
data structure is multiplexed. 

MULTIPLEXED 

  

Common Infos 



 
Generic Data Reader 16.1.2 

  
 
 

 
BrainVision Analyzer  16.1.2—- 3 - 

Keyword Meaning Default value 
DataType Data type. Possible values: 

TIMEDOMAIN 
The data is in the time domain. 
FREQUENCYDOMAIN 
The data is in the frequency domain. 
FREQUENCYDOMAIN_COMPLEX 
The data takes the form of complex 
frequency values. Each real value is 
followed by an imaginary value. 
TIMEFREQUENCYDOMAIN 
The data exists in several layers, as in the 
case of the continuous wavelet transform, 
for example. Each channel is represented 
by a vector of data at a point in time. 
TIMEFREQUENCYDOMAIN_COMPLEX 
This type corresponds to 
TIMEFRQUENCYDOMAIN, except that here 
each value takes the form of a complex 
number. 

TIMEDOMAIN 

NumberOfChannels Number of channels in the EEG file. None, a value must 
be specified. 

SamplingInterval Sampling interval. The interval is specified 
in μs in the time domain and in hertz in the 
frequency domain. 

None, a value must 
be specified. 

Averaged This indicates whether the data set to be 
read in has been averaged. It is 
particularly relevant to the enabling and  
disabling of transforms on the 
Transformations menu. 
Possible values: 
YES – Yes, the data set represents data 
that has been averaged. 
NO – No, the data set represents data that 
has not been averaged. 

NO 

AveragedSegments Number of segments included in 
averaging. This value is only evaluated 
when “Averaged=YES” is set.  

0 

SegmentDataPoints If the data is segmented evenly, the 
number of data points per segment can be 
specified at this point. 

0 

  

Common Infos 

(continued) 
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Keyword Meaning Default value 
SegmentationType Segmentation type. Like Averaged, this 

variable is relevant to the enabling and 
disabling of transforms on the Analyzer’s 
Transformations menu. 
Possible values: 
NOTSEGMENTED 
The data set has not been segmented. 
MARKERBASED 
The data set has been segmented on the 
basis of one or more marker positions. All 
segments have the same length. 
FIXTIME 
Segmentation was based on fixed times. 
All segments have the same length. 

NOTSEGMENTED 

DataPoints Number of data points in the EEG file. If no 
predefined value has been specified, the 
data is read in up to the end of the file. In 
the case of binary data, the TrailerSize 
parameter in the [Binary Infos] section can 
be set as an alternative. 

0 

Layers Number of layers in a multilayer EEG of the 
type TIMEFREQUENCYDOMAIN(_COMPLEX) 

1 

LayerLowerLimit Lower limit in multilayer data. In the case 
of the type 
TIMEFREQUENCYDOMAIN(_COMPLEX), the 
unit is hertz. 

0 

LayerUpperLimit Upper limit in multilayer data 0 
LayerFunction Function that describes the intervals 

between the layers of multilayer data. 
Possible values: 
LINEAR 
Linear function 
LOGARITHMIC 
Logarithmic function 

LINEAR 

  

Common Infos 

(continued) 
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ASCII Infos 
This section is only relevant if ASCII is set for DataFormat in the Common Infos section. 

Keyword Meaning Default value 
DecimalSymbol Decimal symbol used in the EEG file. This 

symbol can be either a point or a comma. 
In the header file, the decimal symbol is 
always a point. 

Point (.) 

SkipLines Number of header lines to be skipped 0 
SkipColumns Number of columns to be skipped at the 

beginning of a line 
0 

 

Channel Infos 
Channel information. This section lists the individual channels and their properties. 

Keyword Meaning Default value 
Ch<x>. x stands for 
the channel 
number. In other 
words, the keyword 
for the first channel 
is Ch1, for the 
second channel 
Ch2, etc. 

Individual properties for the channel are 
specified separated by commas:  
<channel name>,<reference channel name>,
<resolution in “unit”>,[<unit>] 
Example: 
Ch1=Fp1,,1 
The first channel has the channel name 
Fp1. The common reference channel is 
taken as the reference channel because no 
entry has been made. The resolution is 
1 μV. The resolution is the value by which 
the value of the data point is multiplied to 
convert it to μV.   

<channel 
number>,,1,μV. For 
channel 1, for 
example: Ch1=1,,1 

  

ASCII Infos 

Channel Infos 
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Binary Infos 
This section is only relevant if BINARY is set for DataFormat in the Common Infos 
section. 
Keyword Meaning Default value 
BinaryFormat Binary format. Possible values: 

IEEE_FLOAT_32 
IEEE floating-point format, single 
precision, 4 bytes per value 
INT_16 
16-bit signed integer 
UINT_16 
16-bit unsigned integer 

INT_16 

ChannelOffset Channel offset at which the data starts. 
The offset is only relevant to vectorized 
data. ChannelOffset and DataOffset can be 
used simultaneously. 

0 

DataOffset Size of the offset in the file at which the 
actual data starts 

0 

SegmentHeaderSize If the data is segmented evenly, the size of 
the segment header can be entered here 
in bytes. 

0 

TrailerSize Size of the trailer of the EEG file in bytes. 
This parameter can be specified as an 
alternative to DataPoints in Common Infos 
in order to stop reading in the data before 
the end of the EEG file is reached. 

0 

UseBigEndianOrder This only applies to integer formats. It 
specifies whether big endian order is 
used, i.e. whether the most significant 
byte is stored first (Macintosh, Sun).  
Possible values: 
YES 
Yes, big endian order is used. 
NO 
No, little endian order is used 
(corresponds to the Intel specification). 

NO 

  

Binary Infos 
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Coordinates 
Coordinates are listed here. 

Keyword Meaning Default value 
Ch<x> 
“x” stands for the 
channel number. In 
other words, the 
keyword for the first 
channel is Ch1, for 
the second channel 
Ch2, etc. 

Coordinates of an individual channel in 
the form: 
<radius>,<theta>,<ohi> 
Example: 
Ch1=1,-92,-72 
The coordinate system of the Analyzer is 
described in Appendix B. 

If the value is not 
listed here, the 
Analyzer uses the 
electrode name of 
the channel, 
searches for the 
coordinates in the 
10/10 system and 
uses them. If the 
channel name is 
unknown, the 
coordinates are set 
internally to 0,0,0. 

 

GDR-compatible marker file 

The marker file has a similar structure to the header file with sections and keywords. It should 
have the file name extension “.vmrk” and the same base name as the associated EEG file. 

The first line identifies the marker file, as follows: 

Brain Vision Data Exchange Marker File Version 1.0 

The various predefined sections are listed below together with their keywords, meaning and 
default values. 

 

Common Infos 
This section contains general information on the marker file. 

Keyword Meaning Default value 
DataFile Name of the EEG file. If the name does not 

contain a path, it is assumed that the EEG 
file is in the same folder as the marker file. 
This information is not evaluated by the 
GDR. 

- 

  

Coordinates 

Marker: Common 

Infos 
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Marker Infos 
Marker information. The individual markers and their properties are listed in this 
section. 
Keyword Meaning Default value 
Mk<x>. “x” stands 
for the marker 
number. In other 
words, the 
keyword for the 
first marker is 
Mk1, for the 
second marker 
Mk2, etc. 

Individual properties for the marker are 
specified separated by commas: 
<type>,<description>,<position>, <points>,<channel 
number>,<date> 
Example:  
Mk1=Time 0,,26,1,0 
The first marker in this example has the type 
“Time 0”, no description, its position  is at data 
point 26, its length is 1 data point, and the 
channel number is 0, which means that this 
marker applies to all channels.  
The date is optional. It is only evaluated if the 
marker type is New Segment. The date has the 
following format: 
4 digits = year 
2 digits = month 
2 digits = day 
2 digits = hour (24-hour system) 
2 digits = minute 
2 digits = second 
6 digits = microsecond 
The result is a time resolution of a microsecond.
Example:  
19990311140312000000  
means 11 March 1999, 14:03:12.003012 

- 

 

Marker Infos 
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16.2 Importing markers and channel positions 
 
 

To read in additional data along with the raw data (output files from your stimulator, for 
example), you can create a Basic macro that creates a new history node. This node inherits the 
data from the raw EEG. You can, however, delete markers and generate them anew. You can 
also change the names and positions of channels. You can use the Basic macro to open and 
read out ASCII files. 

You will find examples of macros for reading in channel positions and markers in the 
BrainVision Analyzer Macro Cookbook. 
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17 Printout 
 
 

File > Print > Print allows you to print the currently displayed section of the EEG. The usual 
Windows® dialog box for selecting the printer appears. 

File > Print > Print Preview gives you a print preview. However, the actual output on the printer 
may differ from what you see in the preview. This depends on the quality of the printer driver 
you are using and is something over which we unfortunately have no influence. 

If you print from the Ribbon, the active main view and its transient views are printed. If you 
want to print only the main view or only a transient view, you choose the Print command from 
the context menu of the relevant view. 

To set headers, footers and margins, you choose the File > Configuration > Preferences menu 
command and then select the Graphics Export/Output tab. 

 

 

Figure 17—1 Printer settings 

 

On this tab, you can specify whether the default orientation is portrait or landscape (by 
selecting the Portrait or Landscape radio button. Under Margins (cm), you can specify the left 
(Left text box), right (Right), top (Top) and bottom (Bottom) margins of the printout in 
centimeters. 

When printed, the view has the same proportions as the print area. It is easiest to check the 
positioning of view tools etc. in the printout if you adjust the size of the view window 
beforehand so that it has approximately the same proportions as the print area.  

 

Tip 
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The Header / Footer button displays a dialog box in which you can configure headers and 
footers. 

 

Figure 17—2 Dialog box for defining headers and footers 

 

In this dialog box, you can define up to five headers and footers that are to appear in the 
printout. The dialog box contains two sections: Header and Footer. You specify the following: 

• Number of Lines: Number of headers and footers 

For each header and footer:  

• Text: Here, you enter the text that you want to appear in the header/footer. You 
can also use placeholders, which are replaced with current values during printing 
or for the print preview. An example of a placeholder is $n. If this placeholder is 
used anywhere in the text, the program replaces it during printing with the name 
of the data set to be printed. You will find a list of all the available placeholders 
below.  

• Alignment: Here, you can specify whether the text is to be left-aligned (Left), 
centered (Center) or right-aligned (Right).  

• Font: This button displays the Windows® font dialog box, where you can choose 
the font to be used for the text.  
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Placeholder Meaning 
$ct Comment: The comment you can enter for each data set is placed here. To 

enter a comment for a data set, move the mouse pointer to the data set in 
the History Explorer and right-click it. A context menu appears. Choose 
the “Comment” command and enter the comment. 

$d Current date 
$h Name of the history file 
$n Name of the current data set 
$nd Date of the data set at the beginning of the section being printed.  

Note that not all EEG formats contain date information. 
$nt Time of the data set at the beginning of the section being printed. 

Note that not all EEG formats contain time information. In this case, it is 
assumed that recording begins at 0:00 hours. This means you see the 
time offset of the section being printed. 

$p Full history path containing all the intermediate steps from the raw EEG to 
the current data set. 

$t Current time 
$u Computer user who is currently logged in 

Figure 17—3 Placeholders and their meaning 

 

If the printing facilities offered by the Analyzer do not meet your requirements, you can export 
graphics to programs such as MS Word, MS PowerPoint and Corel Draw for further processing, 
as described in chapter 18, “Graphical Export”. 
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18 Graphical export 
 
 

You can export the currently displayed EEG to the clipboard as a vector graphic and process it 
further in other programs such as Word, PowerPoint or Corel Draw. 

You can also export the currently displayed EEG to an image file. The graphics formats EMF, 
BMP, PNG and JPEG are available to you. 

The functions described here allow you to export the active main view and its transient views. If 
you want to export only the main view or only a transient view, you choose the Save as File 
command from the context menu of the relevant view. 

 

To export the EEG to the clipboard, you click the Copy  button on the toolbar.  

Open the destination application (Microsoft Word, for example), and then choose Edit > Paste. 
The graphic appears in the current window of the destination application. 

Alternatively, you can use the standard Windows® keys for this operation: <Ctrl-C> to copy the 
graphic from the Analyzer and <Ctrl-V> to paste it into most destination applications. 

The Enhanced Metafile (EMF) format is used for the export. Most Windows® graphics programs 
support this format. You can change the graphic’s default size of 16 x 12 cm by choosing File > 
Configuration > Preferences and then selecting the Graphics Export/Output tab. In the 
Width (cm) and Height (cm) text boxes, you then specify the width and height of the graphic. 

In the Resolution group box, you can specify whether you want to use the screen resolution 
(by selecting the Screen Resolution radio button) or the generally higher printer resolution (by 
selecting the Printer Resolution radio button). Note that some programs have problems 
processing EMF data in printer resolution.  

Exporting to the 

clipboard 
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Figure 18—1 Preferences dialog box for exporting via the clipboard 

 

 

File > Print > Print to Graphics exports the current view to a file. A file selection dialog box 
appears. You choose the format of the file to be exported from the Save as type drop-down list 
in the lower part of the dialog box. 

As when exporting to the clipboard, you specify the size and resolution of the graphics file by 
choosing File > Configuration > Preferences and then selecting the Graphics Export/Output 
tab. 

 

Exporting to a file 
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19 Appending multiple raw data sets 
 
 

You can append multiple raw EEGs in order to process them as a single data set. This may be 
necessary if you interrupt data acquisition and want to resume it subsequently with a new 
output file. 

The raw EEGs are not actually appended. Instead, they are merely assigned to a single history 
file (i.e. they are linked “virtually”). 

The prerequisite for appending one raw EEG to another is that the main properties of the two 
data sets – channel name, sampling rate, etc. – must be identical. 

 

To append a raw EEG, you first select the initial file in the History Explorer. To do this, you right-
click the corresponding book icon and then choose Append File… from the context menu that 
appears. 

 

 

Figure 19—1 Context menu of a book icon 

 

A warning is issued to the effect that any transforms you have run with this history file will be 
lost. 

 

 

Figure 19—2 Warning  
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Click the Yes button. A dialog box appears, in which you can select the raw data EEG to be 
appended. 

 

 

Figure 19—3 Append Files dialog box for selecting a raw data EEG 

 

Click the OK button. The first history file is modified and the second one removed. The icon 
changes from a book into a stack of books. 

 

 

Figure 19—4 Icon for appended raw EEGs 

 

You can also append other raw EEGs to this history file. 

To find out which raw EEGs have been appended to the history file, you can right-click the 
corresponding book icon to display the context menu again. This now also contains the List 
Appended File(s) command. When you choose this, a dialog box appears. This contains 
information on the initial data set and the appended data sets.   
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Figure 19—5 Dialog box containing appended data sets 

 

To cancel the appending of the data sets, you have to terminate the program and delete the 
associated history file (xxx.ehst) and history information file (xxx.hfinf) in the history file folder. 
The next time you start the Analyzer up, these files are automatically generated anew, and the 
EEGs are thus separated. 
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20 Solutions 
 
 

The Analyzer offers many different options for data analysis and manipulation and program 
control. 

Data is analyzed and manipulated primarily by means of transforms, which contain all the 
basic steps for calculating evoked potentials, as well as many other standard methods used in 
neurophysiological research. 

It is also possible to create user-defined macros for manipulating, importing and exporting 
data and controlling the Analyzer. The advantage of using macros is that individual solutions 
can be implemented with relatively little effort. 

In order to create macros, however, you need a certain amount of programming knowledge. It is 
also essential to document macros in order to be able to follow what has been done. If the 
documentation is not stored together with the macros, there is a risk that the required 
documents will be lost or that or that they will apply to the wrong version of the macro. Finally, 
macros can be easily changed because they are easy to read, although this can also have 
undesirable side effects. 

Solutions are used to counteract the disadvantages of macros. These are lightweight programs 
for dealing with a wide variety of problems and tasks. A solution is an individual file containing 
the executable code and the associated documentation. 

The solutions are made available to you by Brain Products GmbH. You can install or delete 
solutions subsequently without any problems. 

In contrast to macros, the source text of solutions cannot be modified. Consequently, the 
solution is always used unchanged. 

You will find a collection of solutions in the \Solutions subfolder on the BrainVision CD. To 
install the solutions, you use the InstallSolutions.exe installation file, which is also located in 
the \Solutions subfolder. There are solutions, for example, for ECG and EMG processing, 
marker importing and ASCII exporting. You will find more solutions on the Brain Products 
website. 

 

To access the base folder of the solutions, you choose File > Configuration > Administration. 
In the Solutions Path text box, you specify a folder, or you can use the Browse button to 
select one. 

If you are working in a network with several colleagues, we recommend using a shared base 
folder for the solutions.   

Introduction 

Creating a folder 
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Figure 20—1 Selecting the base folder for the solutions in the Analyzer Administration 

dialog box 

 

If you use the standard installation program, the solutions are automatically installed in 
thematically arranged subfolders. You can also install the solutions manually with separate 
categorization if you set up user-defined subfolders. 

You can use Windows® Explorer to delete individual solutions and subfolders. 

It is also possible to copy user-defined Analyzer macros to the solutions folder or a subfolder. 
These will then also appear on the Solutions tab. 

 

The solutions appear on the Solutions tab on the Ribbon. The structure of the tab corresponds 
to the structure of the base folder and its subfolders. Consequently, each subfolder of the base 
folder is represented as a group. The solutions contained in the subfolders appear as buttons 
in the groups. 

Solutions files have the file name extension “.vaso” (which is an abbreviation of Vision 
Analyzer Solutions). 

In our example the base folder is C: \Vision\Analyzer2\Solutions. It contains the subfolders 
EKG and EMG. 

The solution for the EKG subfolder is called EKG Markers.vaso. This folder also contains an 
image for the button (EKG Markers.png). 

The solution for the EMG subfolder is called EMG Onset Search.vaso. This folder also 
contains an image for the button (EMG Onset Search.png).  

Installation 

Display on the 

Ribbon 
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Figure 20—2 Contents of the EKG Markers subfolder 

 

 

Figure 20—3 Contents of the EMG Onset subfolder 

 

The Solutions tab for our example thus has the following structure: 

 

 

Figure 20—4 Solutions tab 

 

Proceed as follows to assign an icon to the button for a solution: In the subfolder of the 
solution base folder, add the image for the solution button as a bitmap or PNG image. It has 
the same name as the associated VASO file. 

The Refresh Solutions button updates the Ribbon when you have made changes to the 
Solutions folder. 

  



 
Solutions 20 

 
 
 

 
BrainVision Analyzer  20—- 4 - 

To display the documentation for the solutions, you choose Solutions > Help. The Solutions 
Help Explorer appears. The Solutions Help Explorer contains all the solutions and macros 
contained in the solutions folder. 

If you click an item in the Explorer, a brief description appears in the Description text box. A 
double-click displays the associated documentation in full in a separate window. Alternatively, 
you can right-click the item and choose Show Documentation from the context menu. 

If you double-click a macro, its source code is displayed. 

 

 

Figure 20—5 Solutions Help Explorer  

Help 
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To apply a solution, you open a history file and click the solution on the Solutions tab. 
Alternatively, you can open the Solutions Help Explorer, right-click the solution in the Explorer 
and then choose Execute Solution from the context menu that appears. 

 

 

Figure 20—6 Applying the EMG Onset solution 

 

Please contact Brain Products GmbH directly if you are interested in other solutions. 

 

Applying a solution 
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21 Analyzer help 
 
 

You will find a list of the installed components and information on the software in the Help 
group on the Help tab. 

You can also choose Help > Documentation to get the Analyzer’s manuals. 

 

Abb. 21—1 List of installed components on the Help tab 

 

In the Installed Components dialog box, you can reset the default values of the parameters of 
the component by clicking Delete Defaults in the Parameters column. This is only possible for 
those component types that use parameters. 
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Appendix A: Raw data on removable media 
 
 

Removable media are drives whose media are interchangeable – CD-ROM, ZIP and MO drives, 
for example. 

If you use the same drive as a raw data source for different workspaces, a raw EEG may appear 
in several workspaces. This is because the Analyzer usually analyzes all raw EEGs in the raw 
data folder when the workspace is changed or the program is started up and creates history 
files where necessary. 

The following rule applies to all removable media in order to simplify handling: 

• (1) If there is at least one history file in the current workspace for which there is 
no equivalent in the form of a raw data set on the removable medium, and 

• (2) if there are EEGs on the removable medium that have not already been read 
into the current workspace, 

you are asked whether you want to add the raw data to the current workspace. 

 

Note that the program can only detect removable media on the current PC, not on the network. 
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Appendix B: Electrode coordinate system 
 
 

The electrode coordinate system used in the Analyzer is explained below. This coordinate 
system is used wherever electrode positions are needed, such as for mapping and for 
positioning electrodes in the head view. 

You can change the electrode positions using the Edit Channels transform. 

The axis system is defined in such a way that the z-axis runs through the vertex. The x-axis 
points to the right, and the y-axis to the front. 

Spherical coordinates are used to specify the position of a point on the head. A set of 
coordinates consists of the three variables r, θ, and ϕ (radius, theta and phi). 

The radius (r) specifies how far the point is away from the center of the coordinate system. It is 
specified in millimeters. The only exceptions are r = 0 and r = 1. r = 0 signifies an invalid 
position, for instance when the position of an electrode is not known, and r = 1 means that a 
standard diameter has been chosen for the radius. This can be used when the surface of the 
head is approximated by the surface of a sphere. 

ϕ specifies the angle between the x-axis and the projection of the line connecting the point and 
the coordinate origin on the xy plane. ϕ > 0 applies to the front right and rear left quarter of the 
sphere. ϕ < 0 is for the front left and rear right. 

θ is the angle between the z-axis and the line connecting the point and coordinate origin. In the 
left hemisphere, θ is < 0. In the right hemisphere, θ > 0. 

 

y

x 
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Figure B—1 Coordinate system 
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Appendix C: Markers (time markers) 
 
 

All the markers used by the Analyzer are time markers. Time markers mark a point in time or a 
period of time in the EEG. 

A marker can be an item of stimulus information that is used to ascertain evoked potential, but 
it can also mark a new segment or indicate that a DC correction was carried out at a certain 
time. Markers are an aid to orientation for segmentation and other transforms. 

All markers in the Analyzer have the following five properties: 

• Type: The type specifies the marker class, such as “Stimulus” or “New Segment”. 
There are different predefined types for specific tasks (see figure C—1). The color 
of the marker in the view depends on the type. Since the types are just ordinary 
texts, you can create new types by means of a macro, for example, or by setting 
markers manually. 

• Description: This is the description given to a marker. It can also be regarded as a 
subclass. When you select markers (during segmentation, for example), in most 
cases you can make a selection by type and description. The description is also 
saved as text, and there are therefore no restrictions on its contents. The Analyzer 
or its reader components construct some texts (for EEG formats, for example) that 
store stimuli as numeric values. If an EEG contains a stimulus with the value 1, 
the reader component converts this value to the text “S 1”. The description is 
generally shown when the markers are displayed. 

• Position: The position defines the data point at which the marker occurs in the 
EEG. 

• Points: These are the data points over which a marker extends. In most cases, 
markers have a length of one point. There is only one type of predefined marker 
that extends across more than one point: the Bad Interval marker. This marker is 
set when you use the Data Inspector or Artifact Rejection transforms. 

• Channel Number: A marker can be assigned to one or all channels (channel 
number 0). 

The New Segment marker also has the Date Time property, which means that the date and time 
of its occurrence is stored in every marker of this type, provided this information can be 
extracted from the raw EEG.  



 
Appendix C: Markers (time markers) 

 
 
 

 
BrainVision Analyzer  Appendix C—- 2 - 

Type Function Color in view 
Bad Interval This indicates a bad interval owing to 

artifacts. 
Pink or gray 

Comment This is used for a comment. Black 
DC Correction A DC correction occurs with EEGs recorded 

using a DC acquisition system. There is 
usually a jump in the voltage levels of the 
data at this time. 

Yellow 

New Segment This is used to mark discontinuities in the 
EEG. These include interruptions in the 
recording but also segmentation. 

Green 

Peak This marker is set by peak detection 
routines. 

Black 

Response This is the response of the subject. Blue 
This indicates a 
stimulus. 

This indicates a stimulus. Red 

Threshold This is set by the Level Trigger transform. 
Because of its proximity to the stimulus 
marker, it is the same color in the view. 

Red 

Time 0 Time zero marker. This marker only comes 
into play after averaging. It marks the 
boundary between the prestimulus and 
poststimulus. 

Long, black, dashed 
line 

Voltage This marker causes most views  to show 
the voltage and time on the relevant 
channel. 

Black 

Figure C—1 Table of predefined marker types 
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Appendix D: Keyboard shortcuts 
 
 

The following table shows the functions of keys and key combinations in the Analyzer. 

Whether and which shortcuts are active depends on which control element the focus is on. If 
these control elements support keyboard input (e.g. the right arrow key for the primary history 
data in the History Explorer), this keyboard input is ignored in the view. 

If the focus is on a view, the following shortcuts are active: 

  Right arrow Moves the selection/highlighting (if present) to 
the right 

  

  Left arrow Moves the selection/highlighting (if present) to 
the left 

  

  Page Up  Displays the previous channel group    

  Page Down Displays the next channel group   

Ctrl + Right arrow Next interval   
Ctrl + Left arrow Previous interval   

Ctrl + Up arrow Increases the scaling   

Ctrl + Down arrow Decreases the scaling   

Ctrl + + Zooms in Numeric 
keypad 

Ctrl + - Zooms out Numeric 
keypad 

Ctrl + + Zooms in Keyboard 
Ctrl + - Zooms out Keyboard 
Ctrl + Shift Right arrow Next interval in the transient view   

Ctrl + Shift Left arrow Previous interval in the transient view   

Ctrl + Shift Up arrow Increases the scaling in the transient view   

Ctrl + Shift Down arrow Decreases the scaling in the transient view   
Ctrl + Shift + Zooms into the transient view Numeric 

keypad 

Ctrl + Shift - Zooms out of the transient view Numeric 
keypad 

Ctrl + Shift + Zooms into the transient view Keyboard 
Ctrl + Shift - Zooms out of the transient view Keyboard 

Ctrl + C Copies the view to the clipboard   

Ctrl + S Saves the active history template   
Ctrl +  Tab Switches to the next view tab   
Ctrl + Shift Tab Switches to the previous view tab   
 Del In the History Explorer, in the history template: 

deletes a data set or secondary history file 
 

 F2 In the History Explorer, in the history template: 
renames a data set or a secondary history file 
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Appendix E: Installing a network license (USB) 
 
 

The BrainVision Analyzer Professional Edition network license (referred to in the following as 
Analyzer) is protected software. 

In order to be able to use this license, you need to install the HASP HL Net key (referred to in 
the following as the USB dongle) and the network license server. This can be done on any 
computer in the network. 

 

BrainVision Analyzer Version 1.05.0003 or higher and Windows® XP Service Pack 2 or 
Windows® Vista. 

 

Make sure your computer is connected to the network before proceeding with installation. 

• 1. Install the HASP HL device driver. 

The installation program for the HASP HL device driver is in the DongleNetwork 
folder on the BrainVision CD. In this folder, double-click the HASPUserSetup.exe 
installation file and follow the instructions of the installation program. You get to 
the folder by choosing Browse the CD in the CD’s welcome screen. 

• 2. Connect the USB dongle. 

When the LED on the USB dongle lights up, you know that the installation has 
been successful. 

• 3. Install the HASP License Manager. 

The HASP License Manager is in the DongleNetwork folder on the BrainVision 
CD. In this folder, double-click the lmsetup.exe file and follow the instructions of 
the installation program. Select Service as the installation type and automatic 
port enabling for the firewall. 

• 4. Enable the port for the firewall. 

If you are using a firewall other than the one supplied by the Windows® 
operating system, enable port 475 for TCP and UDP. 

The BrainVision Analyzer network licenses are now available to you. 

 

Note that the licenses are only available to you if the computer has been started, the dongle is 
inserted and a network connection is active. 

In addition, make sure that no other Vision Analyzer network license (either a USB dongle or 
LPT dongle) is active on the network. 

You can install the drivers and programs on several computers. Consequently, you can attach 
the USB dongle to another computer in the event of a server failure. 

 

Requirements 

Installation steps 
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Appendix F: Command-line parameters 
 
 

The Analyzer supports a number of command-line parameters. To enter these, select the MS-
DOS prompt. A prompt appears. Change to the Vision folder by entering the command cd 
<folder>. 
 
Example: 
 C:\>cd c:\Vision 

 
You can call the Analyzer with additional parameters. 
Example: 
 C:\Vision>Analyzer -new -pPrinter 
 
Alternatively, create a copy of the Analyzer shortcut placed on the desktop during installation. 
Then right-click the icon of the copy and choose Properties from the context menu that 
appears. A dialog box appears. On the Shortcut tab, append the parameters in the Target text 
box to the existing text. 
 
Example: 
 C:\Vision\Analyzer.exe 
Change to: 
 C:\Vision\Analyzer.exe -new –pPrinter 
 
In this way, you can create several shortcuts on the desktop for different parameters. 
 
Now we come to the parameters. 
 
“-m<Macro>” calls the specified macro at program startup. 
Example: 
 C:\Vision\Analyzer.exe "-mCompress All" 
 
This calls the macro Compress All after program startup. Quotation marks are only needed if 
the macro name contains a blank. Note that the macro name must come immediately after the 
-m with no intervening blank. 
 
The -new parameter forces a new program instance of the Analyzer. When the Analyzer is called 
more than once, the existing program instance is used. This parameter suppresses this 
behavior. 
Example: 
 C:\Vision\Analyzer.exe -new 
 
The -p<Profile-File> parameter uses the described user profile file during the session. 
Example: 
 C:\Vision\Analyzer.exe –pPrinter 
 
You could, for example, save all the settings for optimum printing in the profile file named 
Printer. 
It is possible to combine different parameter types. Note that -p is always executed before -m. 
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Appendix G: Shortcuts to raw data 
 
 

In Windows® it is possible to create what are known as shortcuts. You can create a shortcut, 
for example, by using the mouse to drag a file from one folder to another in Windows® 
Explorer while holding down the <Ctrl> and <Shift> keys. This creates a small file that points to 
the actual file. 

The Analyzer can work with shortcuts to raw EEG files. These are treated in exactly the same 
way as if the original file was in the folder. This enables you to set up a workspace containing 
raw EEGs from various folders by creating shortcuts to the various raw EEGs in the raw data 
folder of this workspace. A raw EEG file can therefore also be analyzed in different workspaces 
without having to be copied to these workspaces. 
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Appendix H: BrainVision Electrode Files 
 
 

These XML files contain a list of electrode coordinates. 

Any number of <Electrode> tags can be enclosed between <Electrodes> tags. The <Electrode> tags 
each contain the name and spherical coordinates (as described in Appendix B) of a single 
electrode. 

Please specify the spherical coordinates as floating-point numbers with a decimal point (.) as 
the decimal separator. The following example shows how the file is structured: 

 

<Electrodes defaults="true"> 
  <Electrode> 
    <Name>Fp1x</Name> 
    <Radius>1</Radius> 
    <Theta>-90.5</Theta> 
    <Phi>-72</Phi> 
  </Electrode> 
  <Electrode> 
    <Name>Fp2x</Name> 
    <Radius>1</Radius> 
    <Theta>90.5</Theta> 
    <Phi>72</Phi> 
  </Electrode> 
</Electrodes> 
 

The “defaults” attribute of the <Electrodes> tag can be used to control whether the electrodes 
list is to be interpreted as a complete list (when the value “false” is set) or if the list is to be 
added to an underlying list of standard Analyzer coordinates (when the value “true” is set). If 
no value is set, “false” is assumed. 
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